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Preface

The iCare application is a Windows-based, client-server graphical user interface
(GUI) to the Indian Health Service (IHS) Resource and Patient Management System
(RPMS). The iCare application retrieves key patient information from various
components of the RPMS database and brings it together under a single, user-friendly
interface. iCare is intended to help providers manage the care of their patients. The
ability to create multiple panels of patients with common characteristics (e.g., age,
diagnosis, community) allows users to personalize the way they view patient data.
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1.0 Introduction
The purpose of this manual is to provide you with the needed information to use the
latest enhancements to the Patient Record window in the iCare (BQI) population
management application.

This manual contains reference information about iCare views, examples of its
processes, and step-by-step procedures to show you how to perform activities related
to the Patient Record window in the latest version of the iCare application.
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2.0 System Navigation

The patient record window has several tabs and other information that shows patient
data information stored in the RPMS database. This window provides a wide range of
clinical data, with a focus on providing quick access to needed data.

QI RPMS iCare - DEMO,PATIENT ONE - O X
)

Allergies: No Allergy Aszeszme = B3

File Edit Tocls Window Help Quick Patient Search:

Name: DEMO._PATIENT ONE

wrns: (D Commurity:  ALBUQUERQUE
Address:
ssv: (D rrone
Sex: F Work Ph.:
Age: SR, Alt. Phone: Barriers to Leaming:
DOB: Email: 4
DPCP: 2
Additional Demographics Add a Note View Imm Profile

CMET rD){Tags rFamin HX r BP Prompts ]/ Natl Measures

Summ{Supp ]/ Suicide Form ]

Cover Sheet ]/ Snapshot ]/Flags ]/ Reminders ]/ Prablem List

Orders r Notes ]/ Referrals ]/ Consults PCC [ CareMgmt ]

—| Recent Visits —| Insurance "~
Tmonth ] S S
Date % | Provider Narrative Clinic Insurance Coverage AT | Effective. ¥
—| Scheduled Appointments - Panels
1 month - = Ey Add to Panel S By
Appointment Date/Ti. | Clinic Panel Name A | Owner
Dema anly
[ DEMO Patients
- Providers - Registers
— as — w

Figure 2-1: Sample Patient Record window

e The patient record window can be accessed either by opening a patient record on
a panel or by a direct search for a patient name.

e The Suicide Form tab might not display. This tab displays for those with special
keys.

e The Quick Patient Search field allows you to search for a particular patient
(even one that is not on any of your panels). After a successful search, the data for
the indicated patient will display on the Patient Record window.

e Asarule, when you double-click any date that is underlined (in the Date column),
the Visit File dialog will display.
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2.1 User Preferences

2.1.1  Specifying the Default Tab

You can set which tabs display as well as select the starting tab for the Patient
Record window by defining it on the Patient View tab of the User Preferences
window (select Tools | User Preferences). This configuration means that when you
access the Patient Record window, only the tabs you select will be display and the
string tab will be on top. Section 4.1 provides information about User Preferences.

Patient Record User Manual System Navigation
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3.0 Package Management

This section describes the steps to be followed to use the Patient Record.

3.1 Patient Demographic Group Box

The top group box shows the patient demographic information. This information
remains visible from any tab on the Patient Record window.

&1 RPMS iCare - DEMO,PATIENT BARBARA - O x
File Edit Tools Window Help Quick Patient Search: (5]
Name: DEMO_PATIENT BARBARA Allergies: (] & 53
HRNs: Community: SEIIS) ASPIRIN RELATED MEDICATIONS a

Address: 123 East Main CODEINE

i Acme MICHIGAN 43686 PEANUT BUTTER

ss: [ Frone  [7
Sex- g Work Ph.- PENICILLIN j
Age: 52 YRS Alt. Phone: Barriers to Leaming:

DPCP: 2 DEMO.DOCTOR
Additional Demographics Add a Note ‘iew Imm Profile

Figure 3-1: Sample Patient demographics group box

3.1.1 Community Field

The Community field shows any alerts about the community in which the patient
resides. If the community alert icon ( F&) is displayed, click it to display the
Community Alerts for dialog.

=] Community Alerts for LAKE HAVSU C from Mar 10, 2016 to Apr 08, 2016 =HIEN. X
File Edit Tools
VHEID G
Type T+ Diagnosis T+ Mumberof Cases inthe Past 30 Days ¥+ Numberof Cases inthe Past 24 Hours v+ Most Recent Occurrence 7
p CDCHNND Measles 3 1] Mar 24, 2016
CDCNND  Rocky Mountain Spotted Fever 1 0 Mar 28, 2016

Figure 3-2: Sample Community Alerts for Community dialog

3.1.1.1  Community Alerts Layout
The following provides information about the data columns:

e Type: The following describes the alert types: (1) CDC Nationally Notifiable
Infections Diseases (NND) and (2) Suicidal Behavior: Ideation, Attempt and
Completion. For this version, the logic will only display each alert for 30 days
from the visit occurrence date.

e Diagnosis: The diagnosis category for the alert.

e Number of Cases Past 30 Days: The number of cases in the past 30 days.

Patient Record User Manual Package Management
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3.1.1.2

3.1.13

3.1.2

3.1.3

e Number of Cases in the Past 24 Hours: The number of cases in the past 24
hours.

e Most Recent Occurrence: The date for the most recent occurrence.

Menus on Community Alerts for Community Dialog
The File menu contains the following options:

e Page Setup: This option allows you to set Margin, Paper, Layout characteristics
(such as landscape or portrait orientation), and the Printer to use.

e Print Preview: This option displays the print preview dialog. See Section 4.12 for
more information about this dialog.

e Print: This option sends the page to the printer using the settings in Page Setup.
e Close: The option closes the dialog.
The Edit menu contains the Select All and Deselect options. The Select All option

will select all the records in the grid.

The Tools menu contains the Reset View, Search, Export to Excel, and Copy Rows
to Clipboard options that work like the buttons on the right side of the window.
Section 4.2 provides information about these buttons.

Buttons on Community Alerts for Community Dialog

Section 4.2 provides information about the buttons on the right side of the toolbar.

Allergies Field

The Allergies field pulls data (about the patient) directly from the Adverse Reaction
Tracking application. Each reaction shows a tooltip (Causative Agent, Reaction, Date
of Onset, Historical, or Observed). You can do the following with the selected rows
in the grid: Export to Excel, Print, or Copy; Section 4.2 provides information about
these buttons.

The allergies message in the iCare Patient view will read, No Known Allergies, if No
Known Allergies is listed in the Electronic Health Record (EHR) for the patient. The
allergies message in the view will read as No Allergy Assessment if none have been
found in the Adverse Reaction Tracking application.

Section 4.2 provides information about the buttons on the right side of the toolbar of
the Allergies.

Barriers to Learning Field

The Barriers to Learning field lists the current values for any health factor
categorized as Barriers to Learning, e.g., Blind, Deaf, etc.

Patient Record User Manual Package Management
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3.1.4

3.1.5

3.1.6

Phone Fields

The user with appropriate iCare Editor access can edit any of the available phone
number fields (Home Alternate, Work) on the Demographic header area.

Click the pencil () button next to the phone number to display the Edit Patient
Demographic Fields dialog. Section 4.3 provides information about this dialog.

Email Field

You can edit the Email field by clicking the pencil ( # ) button next to the Email field
to display the Edit Patient Demographic Fields dialog. Section 4.3 provides
information about this dialog.

DPCP Field

This field displays the Designated Primary Care Provider (DPCP) assigned for the
patient. If there is no name in this field, that means that the DPCP has not been
assigned; however, other specialty providers might have been assigned. These
specialty provider names display in the Providers group box on the Cover Sheet tab
of the patient record.

You can edit the DPCP field by clicking the pencil (#) button to access the Edit
Providers dialog (for the current patient).

file Tools Help
SddIEdit

Provider Category™ DESIGNATED PRIMARY PROVIDER Provider Name: DEM 00CTOR [7]

Apply Changes
Specialty Provider List
#HES

Provider Name: Last Modified Date Last Medified By
DEMO,DOCTOR Jul 11,2017

CAN

CASE MANAGER
CHEMICAL DEPENDENCY
DIABETES

HIV CASE MANAGER

HIV PROVIDER

HOME CARE

IMMUNIZATION CASE MANAGER
MENTAL HEALTH

OB CARE

OFFICE CONTACT

PCT PURPLE

PUBLIC HEALTH NURSE

RENAL DISEASE

SECONDARY PROVIDER

SOCIAL SERVICES

WOMEN'S HEALTH CASE MANAGER

Figure 3-3: Sample Edit Providers dialog

Use the Edit Providers dialog to add, edit, or remove specialty provider names for
the various provider categories. Section 4.7 provides information about this dialog.
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3.1.7  Additional Demographics Button

You can view more information about the patient’s demographics by clicking the
Additional Demographics button to access the Additional Demographics dialog.

nf RPMS iCare - DEMO,AMENDMENT TWO - Additional Demographics [éj
{Demographic Detaill | Household
Marital Status: MARRIED
Race: AMERICAN INDIAN OR. ALASKA NATIVE
Ethnicity: NOT HISPANIC OR LATING
Classificaion/Benehciary: INDISNALASKA NATIVE
Tribe
Membership: COLORADO RIVER INDIANS, AZ AND CA
Enrollment Number: TN - 4718
Quantum: 12
Indian Blood Quantum: 12
I| Other Tribe:
Place of Birth (City/State): LAKE HAVASU AZ
Preferred Language: ENGLISH
Communication Preference: PHONE
Location of Home:
OK

Figure 3-4: Sample Additional Demographics dialog
Click OK to dismiss this dialog.

e Demographic Detail tab: Change the Race, Ethnicity, Preferred Language,
and/or Communication Preferences ficlds by clicking the pencil ( ) button
next to the field. This action displays the Edit Patient Demographic Fields
dialog. Section 4.3 provides information about the dialog.

e Household tab: You can view additional household information by selecting the
Household tab. These data values are from the RPMS Patient Registration
application (and are view only).

Patient Record User Manual Package Management
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3.1.8

8] RPMS iCare - DEMO,AMENDMENT TWO - Additional Demographics ==

Demographic Detail}iHousehoklj]

Number in Household: IZI 6

Emergency

Contact Name: |
Relationship:
Phone:

Nextof Kin
Primary Name: |
Relationship:

Phone:

Mother's Maiden Name: |

Mother's Birthplace: GREENVILLE OH
N Father's Name:
Father's Birthplace: PARKER AZ

0K

Figure 3-5: Sample Information on Household tab

Change the Number in Household by clicking the pencil ( ) button to access the
Edit Patient Demographic Fields dialog. Section 4.3 provides information about the
dialog.

Add a Note

Use the Add a Note button to add a TIU note for the current patient. This involves a
two-step process:

1. Click the Add a Note button to access the Add a Note dialog and then complete
the fields on this dialog. Section 4.4 provides information about the dialog.

2. Click the Create button on the Add a Note dialog to access the Add TIU Note
dialog. Section 4.5 provides more information about the dialog.

After clicking the Add a Note button, and if no default clinics are defined in user
preferences, the application displays the following message: You must select default
clinics in user preferences before being able to enter notes.

Click OK to dismiss the message. Select Tools | User Preferences to access the
RPMS iCare — User Preferences dialog. Go to the Patient View tab to enter the
clinic codes. Section 4.1 provides information about user preferences.

Patient Record User Manual Package Management
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3.1.9  View IMM Profile

Use the View IMM Profile button to view the Immunization Profile dialog (Figure

3-6).

=] RPMS iCare - DEMO,PATIENT BEARBARA - Immunization Profile - m] 8
File
@ A B = 3
Find Font Copy Print Preview.. Print.
fatient: DEMO, PATIENT BEARBARR DOBE: 01-Jan-1968 (52 yra) ~

HLN ICE Forecaster v1.26.2 for: 12/22/2020 (rum: 1272272020 @ 10:01)

—— IMM HISTCRY EVALUATION

Date VX Vaccine (combo) Status - Reason
12/12/72014 20 DTaP (PEDIARIX) VALID
12/12/2014 10 1IPV (PEDIARIX) VALID

INVALID: This vaccine contained
insufficient antigen for the
patient's age.

12/12/2014 08 HEF B PED (PEDIARTX)

08/09/2019 43 HEP B ARDLT VALID
08/09/2019 168 FLU-IIV3ad VALID

o8/1a/2018 33 PHEUMO-P3 ACCEPTED: The vaccine is
administered below the recommended

age for this series.

—- FORECAST
DUE:
| Vaccine Status Earliest Recommended Overdue
|
| Td-ADULT Due now 01/09/2015 01/09/2015 01/09/2015
| HEFP B,NOS Due now 09/06/2019 09/06/2019 09/06/2019
| MMR * Series assumed completed.
| FLU,NOS Due now 07/01/2020 07/01/2020 HC DATE
| ZO05-3hgrx Due now 08/06/20189 09/06/2019 HC DATE
FUIURE:
| Vacecine Status Earliest Recommended Cverdue
|
| ENEUMO-PS Due in future 01/01/2033 01/01/2033 HO DATE
CCOMPLETE :
| Vaccine Status
| ———mmmmmmmm e
| None
HIGH RISK:
| Vacecine Status

Figure 3-6: Sample Immunization Profile dialog

This dialog provides information about the patient’s immunization history.
Section 4.6 provides information about using the controls on the dialog.

3.2 Cover Sheet Tab

The Cover Sheet tab includes several categories of data, such as Providers, Recent

Visits, etc.
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(&1 RPMS iCare - DEMO,BARABARA - o x
File Edit Tools Window Help Quick Patient Search: (5]

Name: DEMO.BARABARA Allergies: No Allergy Assessment
HRns: (D Community:  ALBUGUERQUE

ssn: GENEEND Fhoe S
Sex: F -
Age: 5YRS Alt. Phone: Barriers to Leaming:

DOB: QP Emei 7

DPCP: # TWELVETRAIN

Additional Demegraphics Add a Note View Imm Profile
Cover sheet | _snapshot | Flags | Remindes |  roblemust |” ordes | notes | Referras | consuts | pec | caremmt | et | oxTags | Famiyrix | epprompts | watlMeaswes | summysupp | suiadeForm
~| Recent Visits = Insurance
imorth v & ER=E]
Date ¥/ Provider Narrative Clinie Insurance Coverage AT/ Effctive. ¥
=] Scheduled Appointments -] Panels
Tmerth = S Add to Panel 3@
Appointment Date/Ti_ | Clinic Panel Name | Owne

.
Demo only _
[§ DEMO Patients

| Providers | Registers
Edit YN FEEY
Provider Category Provider Name Last Visit D.. | NextVisi_. & Title Al smts A Creator
[§ DESIGNATED PRIMARY PROVIDER TWELVE TRAIN

Figure 3-7: Sample Cover Sheet tab

The icon next to each group box name is the expand-collapse symbol. These symbols
work the same as with any Windows application:

e Click the expand (EI) symbol to expand the group box.
e Click the collapse ( symbol to collapse the group box.

Section 4.2 provides information about the buttons on the right side of each group
box.

You can sort/filter the columns and perform other functions on the columns in the
various group boxes.

3.2.1 Recent Visits Group Box

The Recent Visits group box displays the visits in order of most recent visit first,
within the selected timeframe. You can determine the time range for the visit display
by selecting an option from the list (the default is 1 month).

Hover your mouse over a record to view key visit information (such as diagnosis,
provider, etc.) about the visit.
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/Coverﬁheet I/ Snapshot I/Flags l/ Reminders I/ Problem List l/ Orders l/ Motes l/ Referrals l/ Consult
— Recent Visits

Ever - = JEF)

Date % | Prowvider Marrative Clinic 2
: EMERGENCY MEDICIME 30
Aug 01, 2019 | NARRATIVE EMERGENCY MEDICIME 30
Jul 24 2015 EMERGENCY MEDICINE 30

Jul 24, 2019 EMERGENCY MEDICINE 30 v

Figure 3-8: Sample Recent Visits group box

Double-click any row of the Recent Visits group box to display the Visit Detail
dialog. Section 4.6 provides information about how to use the controls on the dialog.

3.2.2  Scheduled Appointments Group Box
The Scheduled Appointments group box displays the patient’s scheduled
appointments in order of closest upcoming appointment first, within the selected
timeframe. Select an option from the list to determine the time interval for the
appointments displayed (the default is 1 month).
— | Scheduled Appointments
1 morth - = JEE
Appointment Date/Ti.. | Clinic
% Dec 28, 2020 02:00 AM BLUE CLINIC
Figure 3-9: Sample Scheduled Appointments group box
3.2.3  Providers Group Box
The Providers group box displays the list of specialty providers for the patient. This
data comes from the RPMS.
= Providers
Edit 5 B3
Provider Category |F'r0'.'ider MName I Last Visit DL | NextVisi_. A
[ DESIGNATED PRIMARY PROVIDER EDEMO.DOCTOR r 25 2018
Figure 3-10: Sample Providers group box
Patient Record User Manual Package Management
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The Last Visit date is linked to the RPMS visit record. Double-click any record to
view the Visit Detail dialog. Section 4.6 provides information about using the

3.2.3.1 Link to Last Visit Date
controls on the dialog.
3.2.3.2 Edit Button

Use the Edit button to add and edit specialty provider names. This feature requires
either the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR)
security key. Choices for new entries will be limited to the existing BDP Category
Name list. The user will not be able to enter a new BDP Category Name; this function
will continue to be performed by an assigned manager within the BDP interface. All
additions and changes, including the username and date the record is edited via the
iCare interface will be recorded in BDP (Designated Specialty Provider).

Click the Edit button to display the Edit Providers window (Figure 3-10: Sample

Edit Providers window).

DESIGNATED PRIMARY PROVIDER
CANCER

CASE MANAGER

CHEMICAL DEPENDENCY
DIABETES

HIV CASE MANAGER

HIV PROVIDER

HOME CARE

MENTAL HEALTH

OB CARE

PUBLIC HEALTH NURSE

REMAL DISEASE

SOCIAL SERVICES

WOMEN'S HEALTH CASE MANAGER

4 mn

r -
ol Edit Providers - DEMO,BARABARA (459-DB) = | B eS|
File Tools Help
Add/Edit

Provider Category™ DESIGNATED PRIMARY PROVIDER Provider Name: TWELVE, TRAIN E]
Apply Changes
Specizlty Provider List
o .
Save & Close i S ha
Provider Category Provider Name

Last Modified Date

Last Modified By

Figure 3-10: Sample Edit Providers window

Use this window to add, edit, or remove specialty provider names. Dismiss the Edit
Providers window by selecting File | Close. Section 4.7 provides information about

this window.
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3.2.4

3.2.5

3.2.5.1

3.2.5.2

Insurance Group Box

The Insurance group box displays all insurances defined as active in Patient
Registration and the effective date. There can be multiple active insurances.

Insurance Coverage < Effective. 7

% MEDICARE A Jul 01, 1935

Figure 3-11: Sample Insurance group box

Panels Group Box

The Panels group box displays the names of all iCare panels available to the user of
which the patient is a member.

(=] Panels

B3

Panel Name " Owner
Blood Pressure -
Testing Definition

Figure 3-12: Sample Panels group box

m

Tooltip for Panel Description

Hover your mouse over a record to display a description of the panel.

Add to Panel Button

To add the patient to another panel, click the Add to Panel button to display the
Add/Remove Panels dialog.

5

Avadablo Panck Cursent Panels

|Pmde V| Descrption 7| Owres '?l IPMHm '?i Descrpton '?I Owrer 7
L] »

Add>»

¢ Remove

x| cce |

Figure 3-13: Sample Add/Remove Panels dialog

The Available Panels group box contains the panels of which the patient is not a
member. The Current Panels group box contains the panels of which the patient is a
member.
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Please note that if you select a panel in the Current Panels group box and click
Remove, and if the selected panel is open, the application displays the message that
this panel is currently opened in this session and to please try again after you have
finished editing the panel or removing the patient from the Panel View. (Click OK to
dismiss the message.)

Click OK to add the patient listed in the Current Panel group box to the Panels
group box on the Cover Sheet tab. In addition, the patient’s name will be added to
the “other” panels (on the Panel View window). (Otherwise, click Cancel.)

3.2.6  Registers Group Box
The Registers group box displays the Register names of which the patient is a
member. Register names, in which the user does not have security access to, will be
inactive. The data shows the patient’s register status (in the Status column).
. ~|Registers
. . S
™ i 7| Stats | et
ACM: IHS DIABETES  ACTIVE
[ | ACM: TLM-DIAB ACTIVE
BKM: HIV Management  ACTIVE
| » Sy:len‘l
Status: ACTIVE
Status Date: May 24, 2010
Category: HIV
Figure 3-14: Sample Registers group box
Hover your mouse over a record to display a tooltip about the status (Status, Status
Date, Category).
3.2.7  Cover Sheet Tab Menus
3.2.7.1 File Menu
The options on the File menu for the Cover Sheet tab are as follows:
e New: This option displays the Panel Definition dialog where you create a new
panel definition. This is the same as pressing Ctrl-N.
e Page Setup: This option is active when you select one or more rows in the grid.
This option allows you to set Margin, Paper, and Layout characteristics (like
landscape or portrait orientation) for printing. You can select a different printer.
e Print Preview: This option is active when you select one or more rows in a grid.
This option displays the Print Preview dialog. Section 4.12 provides information
about this dialog.
Patient Record User Manual Package Management
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Print: This option is active when you select one or more rows in a grid. It uses the
most recently selected rows (because there is more than one grid on the tab). This
option displays the Print Preview dialog for the selected rows in the grid. This is
the same as pressing Ctrl-P. Select File | Print on the dialog to output the data in
the rows.

Background Jobs: This option displays a dialog showing background jobs
information. Section 4.11 provides information about the dialog.

Close: This option dismisses the current open patient record window.

3.2.7.2 Tools Menu

The options on the Tools menu for the Cover Sheet tab are as follows:

Quick Patient Search: This option executes a patient search.

Export to Excel, Print, and Copy Rows to Clipboard: These options work like
the buttons on the right side of the window (See Section 4.2). These options will
display only if the focus is on one table in the Cover Sheet.

User Preferences: This option opens the User Preferences window where you
can change your user preferences.

Web Links: This option shows several categories (such as Asthma) that have
Web links. When you select a Web link, the Internet browser for the category
opens.

View iCare Log: This option is primarily a tool for troubleshooting that displays
the list of RPCs (remote procedure calls) that contacts the server and returns data
for display.

3.3 Snapshot Tab

The Snapsheot tab shows several types of data with a more clinical focus that are
useful for case management review. The intention is to highlight more urgent
information on this screen when considering various patient conditions.

Patient Record User Manual Package Management
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Cover Sheet,” Snapshot | Flags | Reminders |~ ProblemList |~ Orders | Notes | Referras | consuis | pec | caremgmt | cMeT | DxTags | FamilyHx | BPPrompts | NatlMeasues | summ/Supp | SuiddeForm |

Lactation Status

- Active Diagnostic Tags — Measurements (Last Visit)
Details P 8 &
Tag Name: A | Status Date Factor Measurement Qualifiers Value Date Perfor... | BMI ®?
WEIGHT ] 244 Jun 30, 2011 3925
BLOOD PRESSURE 118178 Jun 30, 2011
B BEDATRITI E 4nn T a0 011 &
- Family History — Last Routine Events
Details & G R
Relative Diagnosis Marrative Age at Onset Status Clinical Group A Event A Date ~
[ NATURAL MOTHER Family history of viral hepatit. LIVING [ EEHAVIORAL HEALTH Alcohol Use Screen Jun 30, 2011
COUSIN (FEMALE) Family history of hereditary.. LIVING BEHAVIORAL HEALTH Depression Screening Jun 30, 2011
BEHAVIORAL HEALTH DVIIPY Screen Jun 20, 2011
CANCFER-RFIATFNY Pan Smaar MNane Faund &
- Reproductive Factors —| Open CMETs
Edit & Ea Details & By
Description Value Last Modifi.. | Documenting Provider @ Category A| Event Date Al 1-Event V|2-Fi |3-F- |4-F

[§ Lost Mensirual Period
Current Pregnancy Status YES

Current Contraceptive Method v

Figure 3-15: Sample Snapshot tab

3.3.1

3.3.11

The underlined visit date listed within any of the sections of the Snapshot view will
be a link to the underlying RPMS visit record (double-click the underlined date).

You can sort/filter the columns and perform other functions on the columns.

Section 4.2 provides information about the buttons on the right side of the group
boxes.

Active Diagnostic Tags Group Box

The Active Diagnostic Tags group box displays a list of Predefined Diagnosis
definitions (“tags”) that iCare has proposed for this patient, based on the tagging
function.

—| Active Diagnastic Tags

Details ===
Tag Name & | Status Date Factor
D BGP ASTHMA DXS
Diabetes ACCEPTED ‘Awc 11,2018  SURVEILLANCE DIABETES
End Stage Renal Disease PROPOSED Awg 11,2018 < BQI ESRD DXS
Hypertension PROPOSED Mar 03 2017  BGP HYPERTENWSION DXS

Figure 3-16: Sample Active Diagnostic Tags group box

The Diagnostic Tag could have been identified by a visit or by a problem.

Details Button

Select a record and then click the Details button to move to the DX Tags tab (on the
Patient Record window) for the tag. Here you view the status, date, item, value, and
factor about the selected tag.
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3.3.1.2

3.3.2

Tooltip for Active Diagnostic Tags Tab
Hover your mouse over a value in the Tag Name column to display the definition of
the tag.

Hover your mouse over a value in the Status column to display status information
(Last Updated, Updated By, Status Change Reason, Status Comment).

Hover your mouse over a value in the Factor column to display factor information
(Compliance Value, Last Updated).

iCare Taxonomy View/Edit

Double-click any Factor cell in the Active Diagnostic Tags group box to display the
iCare Taxonomy View/Edit dialog.

o iCare Taxonomy View/Edit ———em—y l == &J
NOTE: Site populated taxonones can only be edited by users with appropriale access.
Load Taxcnomy I l Hide Category I l Clear Filter(s) ] @A
Edit ¥ ltems ¥ Category T Subcategory T Name v "
Diagnoses SURVEILLANCE ADV EVENTS LIVE
SURVEILLANCE ANGIOEDEMA
CPT Procedures SURVEILLANCE CPT FLU
SURVEILLANCE CPT HIN1

Diagnoses DIABETES ' SURVEILLANCE DIABETES

SURVEILLANCE ENCEPHALOPATHY
SURVEILLANCE EPILEPSY

I SURVEILLANCE FEBRILE SEIZURE
Other SURVEILLANCE FLU CWX CODES Lo
Diagnoses SURVEILLANCE HTN1 ADV EV DXS -
Currently Viewing: SURVEILLANCE DIABETES * The selected taxonomy is not site editable
HES

Coding System Code Description il
|3 ICD-9-CM 5250,01 DMI WO CMP NT ST UNCNTRL —

ICD-9-CM 25011  DMI KETQO NT ST UNCNTRLD

ICD-9-CM 250.21 DMI HPRSM NT ST UNCNTRLD

ICD-9-CM 250.31 DMI O CM NT ST UNCNTRLD

ICD-9-CM 250.41 DMI RENL NT ST UNCNTRLD

ICD-9-CM 250,517 DMI OPHTH NT ST UNCNTRLD

ICD-9-CM 250.61 DMI NEURO NT ST UNCNTRLD

ICD-9-CM 250.71 DMI CIRC NT ST UNCNTRLD

ICD-9-CM 250.81 DMI OTH NT ST UNCNTRLD

ICD-9-CM 250,91 DMI UNSPF NT ST UNCNTRLD

ICD-9-CM 250.00 DMII WO CMP NT ST UNCNTR

ICD-9-CM 25010 DMIIKETO NT ST UNCNTRLD

ICD-9-CM 250.20 DMII HPRSM NT ST UNCNTRL =
| View Report of All Taxonomies ‘ OK l { Cancel

Figure 3-17: Sample iCare Taxonomy View/Edit dialog

If you do not have access rights to edit taxonomies, this dialog will display that
information.

If you have edit privileges (iCare Taxonomy Editor with security key BQIZTXED),
you can add/remove values. Section 4.8 provides information about the iCare
Taxonomy Editor Function.
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Click OK to save any changed data (otherwise, click Cancel).

Click the View Report of All Taxonomies button to access the RPMS iCare -
Taxonomy Report dialog. Information about each taxonomy category displays on
this dialog. For example, you can view the high and low values for each taxonomy

category.
g RPMS iCare - Taxonomy Report =HiEy X
File
@& A G = =]
Find Font Copy Print Preview.. Print..
-
**% jCare Taxonomy Report *%* =
Report Run: Zpr 08, 2016 10:56 RM
Where Run: 2013 DEMO HOSPITRL
Generated by:
Taxonomy Category: COMMUNITIES
Name: ACC CHEME VALLEY 2009 Created: Mar 10, 2009
Desc: Modified:
Coding System Code Description
CHEMEHUEVI VALLEY
NELSON I
Name: ACC PARKER MARCH 2009 Created: Mar 10, 2009
Desc: Modified:
Coding System Code Description
BIG RIVER
BLYTHE
BOUSE
ERRP
EHRENBERG
LAKE HAVSU C
PRRKER
PRARKER DAM I
POSTCN
QUARTZSITE
SRLOME -

Figure 3-18: Sample Taxonomy Report dialog

Section 4.6 provides information about using the controls on the dialog.

3.3.3  Family History Group Box

The Family History group box displays the family history information that is
relevant to case management. This data is pulled directly from the THS
Dictionaries/Patient: Family History file (9000014).
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(=] Family History

Relative
NATURAL FATHER John

NATURAL MOTHER familyhi...

Diagnosis Narrative Age at Onset Status i

DECEASED

FH: Asthma | f ‘ ‘

Family history of cancer |

Version 2.9

3.3.4

3.3.41

NATURAL BROTHER Jack FH: Diabetes mellitus | LIVING
NATURAL BROTHER JOE DECEASED
NATLIRAI NALIGHTER .lane  FH- Hvnertensinn | I IVING T

Figure 3-19: Sample Family History group box

1. The default display will be sorted by Sort Order, then by Relationship.

2. Hover your mouse over any record to view a tooltip (Diagnosis Code, Date
Noted).

3. Click the Details button to move to the Family HX tab of the Patient Record
window.

Reproductive Factors Group Box

The Reproductive Factors group box displays the current patient’s reproductive
history (from the AUPN IHS Dictionaries/Patient Reproductive Factors file). This
applies to female patients only.

—| Reproductive Factors
Edit ® &G
Description Value Last Modifi.. | Documenting Provider
Last Menstrual Period E E

Current Pregnancy Status

Lactation Status MOT LACTATING Aug 19, 2014
Current Contraceptive Method

Contraception Begun

Definitive EDD OCT 10, 2018 Mar 29, 2018
EDD (LMF) OCT 10, 2018 Mar 29, 2018
EDD (Ultrasound) OCT 21. 2018 Mar 29, 2012
EDD (Clinical Parameters) OCT 21,2018 Mar 29, 2018
EDD (Method Unknown) OCT 21, 2018 Mar 29, 2018
Total Number of Fregnancies ] Aug 19, 2014
Full Term Births o Aug 19, 2014
Premature Births ] Aug 19, 2014
Abortions, Spontaneous (1] Aug 19, 2014
Abortions, Induced ] Aug 19, 2014
Ectopic Pregnancies ] Aug 19, 2014
Living Children o Aug 19,2014
Multiple Births (1] Aug 19, 2014

Age at First Menses
Age at First Intercourse
Age at Menopause
DES Daughter Status

Figure 3-20: Sample Reproductive Factors group box

Fields on Reproductive Factors Group Box

The fields show the latest values of the current patient’s reproductive factors. New
reproductive factors can be entered by using the Edit button.
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3.3.4.2 Edit Reproductive Factors
Click Edit to access the Edit Reproductive Factors dialog (where you can add new
data).
File Help
Aadd/Edit
Last Menstrual Peniod: 11/ 085/ 2016 w Current Pregnancy Stalus: |yES j
Lactation Status: [NOT LACTATING |
Contracepiive Methods:
[} Add (F2) X Delete (Del)
Contraception Method Date Contraception Method | Date Contraception Method | Reason Discontinued Comment
Definitive EDD: 10M10/2018 - Documenting Provider:
EDD (LMF): 10102018 v Documenting Provider:
EDD (Ultrasound): 10/21/2018 w Decumenting Provider:
EDD (Clinical Parameters): | 10/21/2012 - Documenting Provider:
EDD (Method Unknown): 10/21/2018 ~ Documenting Provider:
e o Full Term Births: 0
Premature Births: |D Abortions, Spontaneous: ||]-
Abortions, Induced: ||} Ectopic Pregnancies: |[}-
Living Children: |D Multiple Births: ||}
Age at First Menses: | Age at First Intercourse: |
Age at Menopause: | DES Daughter Status: | j
oK Cancel
Figure 3-21: Sample Edit Reproductive Factors dialog
Section 4.9 provides information about completing this dialog.
3.3.5 Measurements (Last Visit) Group Box
The Measurements (Last Visit) group box displays two sets of data:
e The patient’s most recent height and weight data.
e All measurement data documented at the patient’s last visit.
This will include a calculated BMI only if the height and weight measurements meet
the standard Clinical Reporting System (CRS) definition. This information comes
from PCC, the V Measurement file.
Patient Record User Manual Package Management
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— Measurements (Last Visit)

&%

Measurement Quslifiers Value Date Perfor. | EMI
N HEIGHT 72 ‘Dec 07. 2020

WEIGHT : 180 ‘Dec 07, 2020 - 25.77

ELOOD 177 Dec 07, 2020

PRESSURE

EODY MASS 258 Dec 07, 2020

INDEX (BMI)

02 SATURATION 98 Dec 07, 2020

FULSE 7 Dec 07, 2020

RESPIRATIONS 9 Diec 07, 2020

TEMPERATURE 986 Dec 07, 2020

Figure 3-22: Sample Last Measurements group box

There will always be height and weight values. After height and weight, the
measurements display in alphabetical order by Measurement name.

The Qualifiers field displays any qualifier for the measurement. Qualifiers describe
how patient vital signs and measurements were taken. For example, a qualifier for
Temperature could be Oral.

Double-click any record in this group box (with a date) to display the Visit Detail
dialog. Section 4.6 provides information about using the controls on the dialog.

3.3.6  Last Routine Events Group Box
The Last Routine Events group box displays a list of the most recent routine
screenings, based on Health Summary Reminders logic, that are tailored to the
specific patient based on age, sex, etc. This information comes from PCC.
—| Last Routine Events
e
Clinical Group A | Event 4| Date
BEHAVIORAL HEALTH ENCDhD| Use Screen Se 25,2020
BEHAVIORAL HEALTH Depression Screening Sep 25,2020
BEHAVIORAL HEALTH CWIIPY Screen Sep 25, 2020
CANCER-RELATED Pap Smear Mone Found
CANCER-RELATED Taobacco Use Screening MNone Found
GEMERAL Physical Exam Jul 10, 2004
Figure 3-23: Sample Last Routine Events group box
Double-click any record in this group box (with a date) to display the Visit Detail
dialog. Section 4.6 provides information about using the controls on the dialog.
3.3.7 Open CMETs Group Box
The Open CMETS group box shows the latest Tracked, Open CMET data for the
patient.
Patient Record User Manual Package Management
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3.3.71

3.4

—| Open CMETs
Details 5 B
Category A Event Date A 1- Event % | 2 - Findin 3- Follow-_ | 4 - Patient.

CERVICAL Jul 12, 2017 PAP SMEAR
STI Jul 12, 2017 CHLAMYDIA SCREEN

EREAST Mar 05, 2018 MAMMOGRAM DX UNILATERAL 9 .
*
*

Figure 3-24: Sample Open CMETs group box

Select a record and then click the Details button to move to the event on the Tracked
Events sub-tab on the CMET tab of the Patient Record window.

Double-click any underlined event date to display the Visit Detail dialog. Section 4.6
provides information about using the controls on the dialog.

There are the following icons in the 2 - Finding(s), 3 - Follow-up(s), and 4 - Patient
Notification(s) cells:

e A check mark 9 icon indicates that the step is complete.

— In the Finding(s) cell, the hover help shows the Finding Date and Finding
Value.

— In the Follow-up(s) cell, the hover help shows the Follow-up Date and
Follow-up Value.

— In the Notifications cell, the hover help shows the Notification Date and the
type of Notification.

e A tickler * icon indicates that the element is overdue. The element Due Date is
prior to Today’s date (shown in hover help).

e The cell is blank if it is not completed but is not overdue.

If there are multiple elements for any of the steps (for example, 2 Follow-up(s)), there
will be a check mark if all the multiples are completed.

Snapshot Tab Menus
The options on the File menu of the Snapshot tab are the same as those on the File
menu for the Cover Sheet tab.

The options on the Tools menu of the Snapshot tab are the same as those on the
Tools menu for the Cover Sheet tab.

Flags Tab

The Flags tab displays a list of the patient’s “flags” identified by the iCare
application.
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/ Flags |
x ™. YT — !
e Show: [Actve Flay 5 mMENAES D

Flag data cunment as ol Feb 26, 2009 01.00 AM
MSM Lab: 6 months, ER-6 months, ER Return® monthe, Hosp. Admet & monihs

! " FisgDate 7 FlsgType 7 Flag Descrp. 7 Desgnated PCP

Jan 05, 2009

Figure 3-25: Sample Flags tab

3.4.1 Flags Tab Layout

The default display has the flag listed alphabetically by flag date (most recent first),
by Flag Type, then by flag description. No duplicate values are displayed in the first
column. This means if a particular date has more than one flag, the date will be
displayed only on the first row.

The iCare application will display an initial list of flags at first login only for the
timeframe that is defined in the User Preferences. Likewise, you can change the flag
view to display modified flag types and/or timeframes if you change the User
Preferences. After changing the flag settings in User Preferences, refresh the flag
view.

3.4.2 Flag List Columns

Table 3-1 provides information about the columns.

Table 3-1: Flag list columns and descriptions

Column Meaning

Flag Date The date the flag became active, e.g., the date of the hospital
admission.

Flag Type This can be Abnormal Lab Values, ER Visit, Unanticipated ER

Return Visit, Hospital Visit. Section 3.4.3 provides information
about the flag types.

Flag Description A brief description of the event that caused the trigger.

Designated PCP Designated Primary Care Provider, if any. Not all facilities use
this field to empanel patients.

You can sort, filter, and perform other functions on the columns.
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3.4.3 Flag Types

The Flag Type column contains various flag types, as defined in Table 3-2:

Table 3-2: Flag types and meanings

Flag Type

Meaning

Abnormal Lab Values Alert

This flag type informs the user when a patient has
abnormal lab values within a user-defined timeframe,
based on the Kernel Alerts component. The Abnormal
Lab Values alerts, generated from the RPMS Laboratory
application, reside in the Kernel Alerts component. If the
Abnormal Lab Values (ALV) alert is closed by the
provider in Kernel Alerts, it will no longer display in iCare,
regardless of the Flag Display Timeframe selected by the
user in the User Preferences.

ER Visit

This flag type informs the user when a patient has an
emergency room visit within a user-defined timeframe.
This flag is generated directly by iCare. ER visits (clinic
code 30) is the trigger for this flag.

Unanticipated ER Return Visit

This flag type informs the user when a patient has an
emergency room visit designated as “unanticipated”
within a user-defined timeframe. This flag is generated
directly by iCare. ER visits (clinic code 30) with Visit Type
“Unscheduled Reuvisit” is the trigger for this flag.

Hospital Admission

This flag type informs the user when a patient has a
hospital visit within a user-defined timeframe. This flag is
generated directly by iCare. Any visit with service
category H where the discharge date is not the same day
as the admission date is the trigger for this flag.

3.4.4 Flags Tab Toolbar

The text above the grid shows the flag set-up information and how current the data is.

3.4.5 Show Field

What flags are displayed on this window is determined by the option selected on the

Show field. Your choices are:

e Active Flags: Active is defined as a flag that has not expired and has not been

hidden by the users.

e Hidden Flags: Those flags that you specified to be hidden, using the Hide button.

e All Flags: All flags, hidden as well as active.
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3.4.51

3.4.5.2

3.4.6

3.4.7

3.4.8

Hide

You can hide a highlighted row in the Flag List grid by doing any of the following:
e Click the Hide () button

e Select File | Flags | Hide

e Select the Hide option on the context menu

e Press F3 on your keyboard

You can view the hidden flags by selecting the Hidden Flags option on the Show
field.

Show

If you need to cause a hidden flag to re-appear in the current view, select it from the
list on the Hidden Flags option (from the Show field) and do any of the following:

e Click the Show () button
e Select File | Flags | Show
e Select the Show option on the context menu

e Press F4 on your keyboard

Status of Background Jobs
To check on the status of the background jobs, do one of the following:

e Click the Background Jobs («-_‘«;f') button
e Select File | Background Jobs

The application displays the RPMS iCare - Background Jobs window. Section 4.11
provides information about this window.

Flags Tab Menus

The options on the File menu are the same as the options on the File menu for the
Cover Sheet tab.

Tools Menu
The options on the Tools menu are as follows:

¢ Quick Patient Search: This option executes a patient search.
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3.4.9

3.5

e Reset View, Refresh, Search, Export to Excel, Print, Copy Row to Clipboard:
These options operate like those for the buttons on the right side of the window.
Section 4.2 provides information about these buttons.

e User Preferences: This option takes you to the User Preferences window where
you can change your user preferences.

e Web Links: This option shows several categories (such as Asthma) that have
Web links. When you select a Web link, the Internet browser for the category
opens.

Flags Menu
The options on the Flags menu for the Flags tab are:

e Refresh: This updates any RPMS field values on this view with new data from
the server.

e Hide: This hides a highlighted row in the Flag List grid.

e Show: This causes a hidden flag to re-appear in the current view.

Reminders Tab

The Reminders tab lists the national reminders that are pulled from the same data as
the Health Summary report reminders in RPMS (such as lab test, immunization, etc.).

Cover Sheet r Snapshot Flags) Remmdersr Problem List r Orders r Notes r Referrals r Consults PCC | CareMgmt rCMEI' r DX Tag

e CMET A
R:;k | ShOW: | ELIR Clinical Reminders v | &
Patient Reminders data cumrent as of: Dec 23, 2020 10:41 AM

Source A | Category AT | Reminder Name AT Due Date AW Next Due T LlastDate P. v | F7 Dateo. 7

EHR Clinical Reminders Local Hepatitis C Screening DONE Dec 28, 2018 A&

National Activity Screen 1 Dec 23,2020 DUE NOW A

Alcohel Screen v Dec 23, 2020 DUE NOW A&

Blood Pressure 1 Dec 23, 2020 DUE NOW NiA

Colon Cancer 1 Dec 23,2020 DUE NOW A

Dental Visit 1+ Dec 23, 2020 DUE NOW NiA

Depression Screen v Dec 23, 2020 DUE NOW NiA

DM Screening v Dec 23, 2020 DUE NOW NiA

» Lipid Prefile Male 1 Dec 23,2020 DUE NOW ik

Ne Allergy Assessment v Dec 23, 2020 DUE NOW A&

Senior Height 1 Dec 23,2020 DUE NOW ik

Tobacco Screen v Dec 23, 2020 DUE NOW A&

Figure 3-26: Sample Reminders tab

You can control what displays on this tab by selecting any one or more of the options
in the Show field. After selecting (or de-selecting) any option in the Show field, the
display will automatically update.
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If you select an option that has no reminders for the patient, the application displays a
warning message. For example, if the patient does not have any CMET Reminders,
after trying to select the CMET option, a message will display that reads: There are
no CMET Reminders for this patient. Click OK to dismiss the warning.

The default sort order is by due date, with the most overdue first, then sorted by
Category, Clinical Group, and Reminder Name.

3.5.1 Reminders Tab Layout
The following is an overview of the columns:

e Source: The source of the reminder logic. Examples are Health Summary (i.e.,
Health Maintenance Reminders), HMS (HIV Management System), [Z
Forecaster, EHR Clinical Reminders, CMET, etc. When the Source is Care
Management and HIV, the denominator for the HMS reminders will be any
patient with a proposed or accepted tag for HIV. Note: The register status is not
considered for the denominator definition.

e Category: The name of the clinical performance group, for example, Breast.

¢ Reminder Name: The name of the clinical procedure that needs to be completed.
View a tooltip by hovering your mouse over any Reminder Name cell.

¢ Due Date: The date the reminder procedure is due. This column will display the
warning indicator ( ! ) if any of the patient’s reminders are overdue. This date is
derived from the Health Summary Reminders Next Due test.

e Next Due: The actual text from the Reminders Next Due display on the Health
Summary.

e Last Date Performed: The date that the reminder procedure was most recently
completed.

e Preceding CMET Event: This is populated with the tracked Event that initiated
this follow-up. If the displayed reminder is not a CMET Reminder, this cell will
contain N/A.

e Date of Preceding CMET Event: The date of the preceding CMET Event.
You can sort/filter the columns and perform other functions on the columns.
You can view the descriptions of the logic behind each national health summary

reminder by accessing the Reminders glossary. Select Help | Reminders Glossary
(or click the Glossary button on the toolbar) for more information.

352 Reminders Tab Toolbar

The Patient Reminders data is current as of the date shown on the toolbar. The
reminders are calculated on the fly.
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Section 4.2 provides information about using the buttons on the right side of the
toolbar.

3.5.2.1 Recalc
4 ]
Click the Recalc (1®=#* ) button (or select Reminders | Recalc) to get the latest data
from the server and to run the algorithm.
3.5.2.2 Background Jobs
Click the Background Jobs («-_'J;f') button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this
dialog.
3.5.3 Reminders Tab Menus
The following reviews the Reminders, File, and Tools menus.
3.5.3.1 Reminders Menu
The Reminder menu has the Recalc option; these perform like the button on the
toolbar.
3.5.3.2 File Menu
The options on the File menu for the Reminders tab are the same as those on the File
menu for the Cover Sheet tab.
3.5.3.3 Tools Menu
The options on the Tools menu are:
¢ Quick Patient Search: This option executes a patient search.
e Glossary: This option accesses the glossary information for this tab.
e Reset View, Refresh, Search, Export to Excel, Print, Copy Row to Clipboard:
These options operate like those for the buttons on the right side of the window.
Section 4.2 provides information about these buttons.
e User Preferences: This option takes you to the User Preferences window where
you can change your user preferences.
e Web Links: This option shows several categories (such as Asthma) that have
Web links. When you select a Web link, the Internet browser for the category
opens.
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3.6 BP Prompts Tab

The Best Practice (BP) Prompts tab displays a list of suggested treatments based on
pre-determined prompt logic (including CVD and Asthma reminders). CVD
Treatment prompts are callable by the Health Summary or other RPMS applications.
The best practice prompts can be turned off via the PCC Health Summary functions.

Cover Sheet r Snapshot Flags Reminders r Problem List rOrdas Notes Referrals ]/ Consulis PCC Care Mgmt CMET DX Tags rFamin H)(/)/ BP Prompts:
1

3

2 | 1®

Recalc
Pahent Best Practice Prompis data current as of: Dec 23, 2020 10:55 AM
Clinical Group & W | Prompt Name T | Guidance Vi

{ ASTHMA: ADD/INCREASE INHALED STEROIDS  : [f this patient has asthma, consider adding or increasing this patient's

{ inhaled corticosteroids.
ASTHMA: SEVERITY CLASSIFICATION If this patient has asthma, consider classifying the severity of this patient's

asthma in the Problem List Classification field

ASTHMA: ACTION PLAN The asthma guidelines recommend providing the patient with 2n asthma

action plan because they have Asthma Diagnostic Tag: Proposed as of Feb
26, 2010. The asthma action plan provides information on daily
management and early recognition of and actions for handling
exacerbations. It should contain a list of medications for controlling asthma
and actions to take when asthma worsens. Document asthma action plan in

patient education with (ASM-SMP Self Management Plan).

ASTHMA: FLU SHOT Itis recommended that all asthma patients receive a flu shot. [f this patient
has asthma (as documented on Now 07, 2014) consider giving this patient a
flu shot per protocol during the season

ASTHMA: CONTROL CLASSIFICATION Lsthma control should be zssessed st each patient visit. This patient has
not been assessed for asthma control in the past year. Please consider
classifying the contral of this patient’s asthma. Classifications are either (1)
well controlled, (2) not well controlled, and (3) very poorly controlled.

Fum Do ATEN FY v ACEUM Dinle This natiznt dnas net haye 2n ASCUN il =ocassment dnsmentad

Figure 3-27: Sample BP Prompts tab

3.6.1 BP Prompts Tab Layout
The data columns on the Best Practice Prompts tab are:
¢ Clinical Group: The name of the clinical group.
e Prompt Name: The name of the best practice prompt.
e Guidance: The text that defines the diagnosis.

A tooltip displays by hovering your mouse over the Prompt Name cell. The text is
pulled from the Tooltip field in the Treatment Prompt file.

3.6.2 BP Prompts Tab Toolbar
The field with the list determines what data within each clinical group will display
either the TOP 5 or ALL. The default is TOP 5.
The time and date of the last data update displays in the toolbar.

Section 4.2 provides information about the buttons on the right side of the toolbar.

3.6.2.1 Recalc

4

Click the Recalc (| Recok ) button (or select Best Practice Prompts | Recalc) to get the
latest data from the server and to run the algorithm.
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3.6.2.2

3.6.3

3.7

Background Jobs

Click the Background Jobs («_‘9:+') button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this
dialog.

BP Prompts Tab Menus

The options on the File menu of the Best Practice Prompts tab are the same as those
on the File Menu for the Cover Sheet tab.

The options on the Tools Menu on the Best Practice Prompts tab are as those of the
Tools Menu for the Reminders tab.

The Best Practice Prompts menu has one option: Recale. This performs like the
button on the toolbar.

Natl Measures Tab

The Natl Measures tab displays the patient’s Government Performance and Results
Act (GPRA) performance status (based on the CRS national summary report).

Patient National Performance Measures data from CRS 2016 current as of: Apr 02, 2016 04:21 AM
Performance

Category ¥ Clinical Group ¥ Measure Name il & i ¥ Adherence Value i
Developmental Immunizations Adult 1Z: 1:1:1 YES TDAP: 12/28/11 Imm 115 (ever);
TDAP/TD: 12/28/11 Imm 115 (past
10 yrs); ZOSTER: Imm 121 (ever)
Cancer-Related Comprehensive Cancer Screening YES CRCS: 01/09/13 CPT GO105
(Dev)
National GPRA Colorectal Cancer Screen 50-75  YES COLO: 01/09/13 CPT GO105
Colorectal Cancer Screen 50-75: MO COLO: 01/09/13 CPT G0O105
FOBT/FIT
Dental Topical Fluoride Pts 0 0O topical fluoride
Dental Access NO
Other National Immunizations Influenza |1Z 50-64 NO
» : Developmental Behavioral Health Alcohaol Screen: 12-75 (Dev) NO

Alcohol Screen: Positive: 12-75 MNIA
(Dev)

Depression Screening, Diagnosis = N
or Suicide Ideation: 12-18 (Dev)

Depression Screening, Diagnosis = MO
or Suicide Ideation: 18+ (Dev)

SBIRT NO

A

Figure 3-28: Sample National Measures tab

This detailed list shows all national CRS measures broken down by clinical group
along with the current patient’s status with respect to the measure.

If the patient has not had a visit in 3 or more years, no national measure data will be
available.
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CoverSheet | Snapshot | Flags | Remindes | ProblemList | Orders | Notes | Referds | Consuts | Pcc | careMgmt | cMET | DxTags | FamilyHx | BPPrompis  NatiMeasures | si

%-'j‘g

Recalc

Category | Clinical Group 7 | Measure Name W | Performance Status 7 | Adherence Value | Population T

x
Opening Patient National Performance Measures Data

Patient's Natl Measures not available Please wait

Figure 3-29: Sample No National Measures found

3.7.1  Natl Measures Tab Layout

e Category: The name of the category: Developmental, National GPRA, Non-
National, Other, or Other National.

¢ Clinical Group: The name of the clinical performance group.

e Measure Name: The measure title derived from the Summary Report. A
description of the performance logic (tooltip) will display when you hover the
mouse over the name.

e Performance Status: Displays the current status (as of the date listed on the
toolbar) of this patient’s performance to the specific measure.

The National Measures tab on the Patient Record is based on CRS logic and the data

for each measure is primarily Yes, No, or N/A.

e The font is green if the value is Yes and the measure is traditional in the sense that
meeting the measure is positive or if the value is No and the measure is such that
not meeting the measure is positive.

e The font is red if the value is No and the measure is traditional in the sense that
not meeting the measure is negative or if the value is Yes and the measure is such
that meeting the measure is negative.

Adherence Value: Displays the visit date and clinical procedure that meets the

performance numerator definition.

You can view a dialog that defines the detailed logic for each of the national

performance measures defined in the Clinical Reporting System by selecting Help |

Natl Measures Glossary.

You can sort/filter the columns and perform other functions on the columns.
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3.7.2  Natl Measures Tab Toolbar
The toolbar on this tab displays the date that iCare most recently processed the
National Measures logic on your facility’s RPMS database. The default setting for the
National Measures logic run is weekly (your Site Manager can select a different time
frame).
Section 4.2 provides information about using the buttons on the right side of the
toolbar.

3.7.21 Recalc
Click the Recale (1#=# ) button to get the latest data from the server and to run the
algorithm.

3.7.2.2 Background Jobs
Click the Background Jobs («-_'J;f') button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this
dialog.

3.7.3  Natl Measures Tab Menus
The options on the File menu of the Natl Measures tab are the same as those on the
File menu for the Cover Sheet tab.
The options on Tools menu for the Natl Measures tab are the same as those of the
Tools Menu for the Reminders tab.

3.8 CMET Tab
The iCare Management Event Tracking (CMET) tab displays the CMET data
associated with the current patient. The CMET tool is designed to assist users in the
electronic tracking and management of their patients’ care. CMET is reminiscent of
an old fashioned “tickler file.”
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Coversheet | Snapshot | Flags | Reminders | Problemuist | Ordes | Notes | Referras | Consuls | poc | caretgmt * cMET | DxTags | Familytx | 8pPrompts | NatiMessues | | sucderorm
Events | TrackedEvents | Follow-upEvenis | PastEvents |

| Tips
Oecurrences of pre-defined events are identified routinely and placed in @ “Pending” CMET status on the Events fab. Events for this patient are listed on this tab. You can decide whether fo track, nof frack, or leave the event in pending status.

Track Don'tTrack Pend Add Manual Event (5 @IEIREIGS R

Events list current as of Dec 23, 2020 11-09 AM
Category A ¥R Event Name ¥+ EventDate ¥ V- Expanded Event W+ Finding W | Finding Comment T+ Result W | Expanded Result T+ Status ¥ | Status Comment V| Last Modified Date T+ Last Modified By T+
C : : : : PENDING Sep 18. 2017 11:22 AM Nightly job

COLONOSCOPY : : : :
INFECT DIS covio Dec 08, 2020 Event obtained from: Dec 09, 2020 Current Status: PENDING Dec 10. 2020 1003 AM Hightly job
VLAB-_COVID-19 RESULTED
(Abbott 1D NOW) Result: COVID-19
POSITIVE
COVID19A: COVID-18
POSITIVE
PROCCONT: Yalid
PROSTATE Prostate Screen Jul 22,2014 Event obtained from: Jul 22,2014 Current Satus: PENDING Sep 19, 2017 08:01 PM Hightly job
VLAB- PSA RESULTED
EQUIMOLAR (R} Result: 030

Interpretative data is
available online ot

wwuaet rmionline cominterp
Enter Test

Humber 2012225

Test performed at RML
Tulsa

Figure 3-30: Sample CMET tab

The CMET tab on the patient record window has the information displayed in four
sub-tabs: Events, Tracked Events, Follow-up Events, and Past Events.

3.8.1 Events Sub-Tab

The patient’s events display on the Events sub-tab. Events are procedures, screenings
and/or exams that have been pre-defined and categorized into Breast, Cervical, Colon,
and Skeletal.

| evemts | TrackedEvens | FollowupEvets | Pastevens | E
(=] Tipm
o of pre-defined events ane identifiad rovtinely and placed in 8 "Pending” CMET status on the Events (b, Events for this patient are listed on this 13b. You can decide whether o tack. nof irsck. or leave the everd in pending status.
| Track DomtTrack Pend Add Manual Event (5 W 9 EldE G
Events st current as of Apr 21, 2017 1140 AM
Cotegery * W8 EventMame ¥4 EventDste © V8 ExpandedEvent ¥ Findng ¥4 FirdingComment ¥4 Resut 48 ExpandedResult 74 Sistus T8 Status Comment W8 LastModfiedDate T Last Modified By =
[ FINE NEEDLE Bor 10, 2017 [Event cbtained ir TRACKED Aer 10, 2017 1217 PM
» ASPIRATION |

BREAST Ape 1 PENDING Apr 12. 2017 07:28 AM Mightly job
RECONSTRUCTIO
NWOUT
IMFLANTS
SIEA Flap. Open

Figure 3-31: Sample Events sub-tab

The Events sub-tab is divided into three general areas: Tips information, Events
toolbar, and Events data.

The Tips information provides an overview of the Events sub-tab. You can collapse
this area to have more room to view the Events data.

3.8.1.1  Events Sub-Tab Layout

The default sort of the columns is: Category, Date of Event (newest listed first),
Patient Name (alphabetical):

e Category: The category of the event.

e Event Name: The name of the event. Events are procedures, exams, or tests that
have been documented in RPMS. Events are predefined. See the CMET Glossary
for a list of events by selecting Help | CMET Glossary.
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3.8.1.2

3.8.1.3

e Event Date: The date the event was performed. Double click any underlined date
to view the Visit Detail dialog. Section 4.6 provides information about using the
controls on the dialog.

e Expanded Event: The source of the event such as V CPT, V Lab with value.
¢ Finding: The Finding value associated with the result.
¢ Finding Comment: The comment entered associated with the finding.

e Result: The date of the result. Double-click the underlined date to access a
particular detail dialog, for example, Women’s Health Detail. This cell also has
hover help, such as V Radiology.

e Expanded Result: The expanded data associated with the result.

e Status: The status of the event which can be not tracked, pending, tracked.
e Status Comment: Any comments about the status.

e Last Modified Date: The date the record was last modified.

e Last Modified By: The person who last modified the record. The Initial job name
means that this was an initial event.

Events Sub-Tab Toolbar

Section 4.2 provides information about to use the buttons on the right side of the
toolbar.

Click the Background Jobs («-_':;f') button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this
dialog.

You can decide whether to track, not track, or leave the event in pending status.

Track

The Track function requires the iCare Editor (BQIZCMED) security key. Select one
or more events with a status of Not Tracked or Pending and then click the Track
button (or select CMET | Events | Track).

Once an event has been Tracked, it cannot be changed to Not Tracked. If the event
was changed to Tracked and that is not correct, you need to go to the Tracked tab, and
then access the CMET worksheet for the event you tracked in error.

If you select events that are not eligible for the Tracked function, the application
displays the message: Events having a status of Tracked can’t be changed to
Tracked. Click OK to dismiss the message.
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If you select only one eligible event, the application displays the RPMS iCare -
Track - Findings Due Date dialog.

o-! RPMS iCare -Track - Findings Due Date l == |ﬁj

Findings Due Date: | Tuesday , February 21, 2017 ﬂ

Reason comment (optional):

l—_- T —— — —— =

Figure 3-32: Sample RPMS iCare - Track - Findings Due Date dialog

If you selected more than one eligible event, the application displays the RPMS
iCare - Track - Findings Due Date dialog (for multiple events).

Findings Due Date: | Tuesday , February 21, 2017 ﬂ

Reason comment (optional):

Figure 3-33: Sample RPMS iCare - Track - Findings Due Date dialog for multiple events

In either case, do the following:

e Make sure that the correct date is in the Findings Due Date field (required).
Change the date by clicking the list to access a calendar (where you can select
another date). The date cannot be earlier than the current date.

e Type the text of the reason for changing the status to TRACKED in the Free Text
Reason comment field (not required).

e Click Save to save the information and to change the status of the events to
Tracked. These events will display on the Tracked Events sub-tab of the Patient
Record window. (Otherwise, click Cancel.)
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3.8.1.4

3.8.1.5

If you use the Save and Enter Findings button for a single event, the application
displays the CMET Worksheet (where you can add Findings to the event, for
example). Section 4.10 provides for information about the worksheet. After saving
the worksheet, the focus returns to the Events sub-tab.

Don’t Track

Use the Don’t Track function to change the status of a Pending event to Not Tracked.
Select the events and click Don’t Track (or select CMET | Events | Don’t Track).

If you select Tracked events and they are not eligible for the Not Tracked function,
the application displays the message: Once an event has been Tracked, it cannot be
changed to Not Tracked. See the User Manual guidance on how to manage an event
that was tracked. Click OK to dismiss the message. If the selected Tracked event was
erroneously tracked in error, Section 4.15 provides information about how to handle
this error.

If you selected eligible events, the application displays the RPMS iCare — Don’t
Track Event dialog.

a- RPMS iCare - Don't Track s e S

Reason comment (optional):

Figure 3-34: Sample RPMS iCare — Don’t Track Event dialog

Type a reason for the change in the Free Text Reason comment field (not required).
Click OK to save and to change the Status of the events to Don’t Track. (Otherwise,
click Cancel.)

Pend

Use the Pend function to change the status of one or more selected Not Tracked event
to Pending. Select the events and then click the Pend button (or select CMET |
Events | Pend).

If you select events that are not eligible for the Pend function, the application displays
the message: Only events with status of Not Tracked can change to Pending.
Click OK to dismiss the message.
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If you selected eligible events, the application displays the RPMS iCare — Pend
Event dialog.

a-l RPMS iCare - Pend Event o B |

Reason comment (optional):

b

Figure 3-35: Sample RPMS iCare — Pend Event dialog

Type a reason for the change in the Free Text Reason comment field (not required).
Click OK to change the Status of the selected events to Pending. (Otherwise, click

Cancel.)

3.8.1.6 Add Manual Event

Use the Add Manual Event function to add a new manual event. Select the events and
then click the Add Manual Event button (or select CMET | Events | Add Manual

Event).
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r - | -
Add Manual Event =™

Patient Name: DEMO
Date™: 06/26/2019 =]

Event™ I _ﬂ

PCCFile™ [ |

Default Value™ ‘

L L

Finding: \

Location:

& IHS/ Tribal Facility
2016 DEMO HOSPITAL B

Hospital Location™: | =]

" Other

Outside Location: |

Outside Provider: |

Findings comment (optional):

| Save || SaveandTrack || Save. Track and Open\worksheet ||  Exit

L

Figure 3-36: Sample RPMS iCare — Add Manual Event dialog

The required fields are marked with an asterisk (*) following the name.
e Date: Select a date for the event.

e Event: Select the event.

e PCC File: Select the PCC File.

e Default Value: Select a default value for the event.

¢ Finding: Select a finding, if desired for the event.

e Location:

— IHS/Tribal Facility: Select a one of the following:

e Hospital Location: Select a Hospital Location from the list. Required for
IHS/Tribal Facility.

e Other: Enter an Outside Location and if desired, an Outside Provider.

¢ Finding comment: Enter a finding comment for the event, as needed.

Patient Record User Manual Package Management
March 2021

38



iCare Population Management GUI (BQl) Version 2.9

e Do one of the following:

— Click Save to save a new manual event.

— Click Save and Track to save a new manual event and track. This functions
the same as the Track button (Section 3.8.1.3).

— Click Save, Track and Open Worksheet to save a new manual event, track,
and open a CMET worksheet. This has the same function as the Open CMET
Worksheet button (Section 3.8.1.12) on the Tracked Events tab.

3.8.1.7 Tracked Events Sub-Tab

The patient’s tracked Events display on the Tracked Events sub-tab. All events on
this view have a CMET status of Tracked and are now considered a CMET.

Events/}’ TrackedEventsEr Follow-up Events r Past Events I

[=) Tips
CMET Events that have a sigius of "Tracked” can be wiewed and processed from ffus fsh. Acivily relafed io Findings. Follow-ups, and Fatient Nokifications can be enfered using the CMET Workshesi The checkmark icons indicale
sfeps that have been completed and feather icons indicate steps that are overdue.

Reopen Close Open CMET Worksheet S 9 Y ] & =

Category * W+ 1- Event ¥ EventDate ¥ V4 Result W4 2- Finding(s) ¥+ Findings Summary ¥+ Finding Date 4 Interpretation W45 3 - Follow-up(s) 78 Follow-Up Date 7+ 4 - Patient Notification(s) V4

CERVICAL PAP SMEAR  Sep 15, 2014 @ Finding: AIS Aug 03, 2016 Abnormal 3 Aug 05, 2016 3
Finding Date: AUG 3,
2016

Finding Entered By:
Finding Entered
Date/Time: AUG 3,
2016 09:30:30
STl CHLAMYDIA  Jan 18, 2017 L8
SCREEN

Figure 3-37: Sample Tracked Events sub-tab

The Tracked Events sub-tab is divided into three general areas: Tips information,
Tracked Events toolbar, and Tracked Events data.

The Tips information provides an overview of the Tracked Events sub-tab. You can
collapse this area to have more room to view the Tracked Events data.

3.8.1.8 Tracked Events Sub-Tab Layout

Table 3-3 provides information about the columns on the Tracked Events sub-tab.

Table 3-3: Tracked Events column names and meanings

Column Name Meaning

Category The name of the category for the tracked event: Breast, Cervical, Colon,
Skeletal, STI.

1 - Event The name of the event. Events are procedures, exams, or tests that
have been documented in RPMS. Events are predefined.

Event Date The date the event was performed.

Result The date the result was entered. Hover help will describe where the

result came from (V-RADIOLOGY, V-LAB).

Patient Record User Manual Package Management
March 2021

39



iCare Population Management GUI (BQl)

Version 2.9

Column Name

Meaning

2 - Finding(s)

Icon that indicates if the event has any Findings.

Findings Summary

Summary of the findings

Findings Date

The date of the findings.

Interpretation

The interpretation of the selection in the Result field. There is hover help
for this field, e.g., CMET that refers to where the interpretation was
obtained.

3 - Follow-up(s)

Icon that indicates if the event has any follow-up data.

Follow-up Date

The date of the follow-up.

4 - Patient Notification(s)

Icon that indicates if the event has any patient notification data.

Patient Notification(s) Date

The notification date of the tracked event.

State

The state of the tracked event (open or closed).

Last Modified Date

The date the record as last modified.

Last Modified By

The name of the person who last modified the record.

Double-click any record to access the CMET Worksheet. Section 4.10 provides
information about the worksheet.

3.8.1.9

Tracked Events Sub-Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.

Click the Background Jobs () button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this

dialog.

3.8.1.10 Reopen

Use the Reopen function to change a Closed event to Open. Select only one event
with a State of Closed, then click the Reopen button (or select CMET | Tracked
Events | Reopen) to access the RPMS iCare — Reopen Tracked Event dialog.

@~ RPMS iCare - Reopen Tracked E'u'ent‘
I

Please provide a reason for changing state back to OPEN:

=

Figure 3-38: RPMS iCare — Reopen Tracked Event dialog
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Type the reason for changing the state back to Open in the Free Text field (not
required). When the dialog is complete, click OK to change the State of the tracked
event to Open. (Otherwise, click Cancel.)

If you select more than one event and use the Reopen function, the application
displays a warning message: Please reselect as only one event can be reopened at
one time. Click OK to close the warning message and select only one event.

3.8.1.11 Close

Use the Close function to change an Open event to Closed. Select the events with a
State of Open, then click the Close button (or select CMET | Tracked Events |
Close) to access the RPMS iCare — Reason for Closing dialog.

| 5=/ RPMS iCare - Reason for Closi ‘ , [-:-l-:- g

Cne or more of the selected events are not completed.
Please provide reason for closing event:

* Reason: -

Comment: p

0K || Cancel

Figure 3-39: RPMS iCare — Reason for Closing dialog
Required fields are marked with an asterisk (*) following the name.

Reason: Select an option from the list: Event Complete, Patient Moved, Lost to
Follow-up, or Other (this option requires a comment).

Comment: This Free Text field is required when the Reason is Other. Type the text
of the reason.

When the dialog is complete, click OK to change the State for the selected tracked
events to Close. (Otherwise, click Cancel.)
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3.8.1.12 Open CMET Worksheet

Select an event and then click the Open CMET Worksheet button (or select CMET
| Tracked Events | Open CMET Worksheet) to access the CMET Worksheet (for
the event). Here you can enter Finding(s), Follow-up(s), and Patient Notification(s)
for the patient. Section 4.10 provides for more information about the worksheet.
Note: This function can be applied to only one event.

3.8.2  Follow-up Events Sub-Tab

The Follow-up Events sub-tab displays the patient’s follow-up events. Follow-up
events are generated by the third CMET step. This view lists all those events that
have been recommended as follow-up.

Events r Tracked Events / Follow-up Eventsir Past Events ]
EJ Tips
Folfow-up Evenfs are generafed by the recommendsfion(s) made for the follow-up of 8 CMET event A CMET Rem is also by the same (5). Group Order may be disabled by your Sifte Man)
sife may nof sunport Mammagram Screenings.

Open CMET Worksheet 57 @ Y 2] &

Category W+ Follow-up Event Name 7+ Follow-up Event Date ¥ 74 Ordered W+ Preceding Event T8
: {Sep 15, 2014

Figure 3-40: Sample Follow-up Events sub-tab

The Follow-up Events sub-tab is divided into three general areas: Tips information,
Follow-up Events toolbar, and Follow-up Events data.

The Tips information provides an overview of the Follow-up Events sub-tab. You
can collapse this area to have more room to view the Follow-up Events data.

Category: The category of the follow-up event.

Follow-up Event Name: The name of the follow-up event.

Follow-up Event Date: The date of the follow-up event.

Ordered: Indicates whether the follow-up has been ordered (Yes or No).

Preceding Event: The date of the preceding event. There is hover help when you
move your mouse over the date (for example, PAP SMEAR).

Double-click any record to access the CMET Worksheet. Section 4.10 provides
information about the worksheet.

3.8.2.1 Follow-up Events Sub-Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.
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3.8.3

Select a record in the grid and click the Open CMET Worksheet button (or select
CMET | Follow-up Events | Open CMET Worksheet) to access the CMET
Worksheet. Section 4.10 provides information about the worksheet.

Click the Background Jobs (5‘) button (or select File | Background Jobs) to
display the Background Jobs dialog. Section 4.11 provides information about this
dialog.

Past Events Sub-Tab

The Past Events sub-tab displays the patient’s past CMET events. Past events come
from data mining.

Events I/ Tracked Events r Follow-up E\Im/ PastEwntj;l -

[=] Tips

=

Occurrences of pre-defined events that have accurred in the past are identified routinely and display on the Fast Events fab of the Fatient’s record. This allows you fo see the patient’s fistory.

QY [E] 2 E S5

Evenis list current as of: Apr 21, 2017 11:42 AM
Category © 7R EventName W+ EventDate ¥ ¥R Expanded Event 7-R Result W Expanded Result -0 Interpretation ¥R

{FINENEEDLE  :Apr 10, 2017 Event obtained from:
(ASPIRATION ¢ W CPT - 10021 FNA

H WO IMAGE
REAST Apr 10, 2017 Event obtained from:
RECONSTRUCT W PROCEDURE -

10N W/OUT OHRTO78

IMPLANTS Replacement of Right
Breast using SIEA
Flap, Open Approach

Figure 3-41: Sample Past Events sub-tab

3.8.3.1

The Past Events sub-tab is divided into three general areas: Tips information, Past
Events toolbar, and Past Events data.

The Tips information provides an overview of the Past Events sub-tab. You can
collapse this area to have more to view the Past Events data.

Past Events Sub-Tab Layout

Category: The name of the category for the past event.

Event Name: The name of the past event.

Event Date: The date of the past event.

Expanded Event: More detailed information about the past event.

Result: The date of the result of the past event. Double-click a record with an
underlined date to access a particular detail dialog, for example, Women’s Health
Detail.

Expanded Result: More detailed information about the result of the past event.

Interpretation: The interpretation of the selection in the Result field. There is hover
help for this field, e.g., CMET, that refers to where the interpretation was obtained.
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3.8.3.2 Past Events Sub-Tab Toolbar
Section 4.2 provides information about the buttons on the right side of the toolbar.
To check on the status of the background jobs, do one of the following:
e Click the Background Jobs («5’) button
e Select File | Background Jobs
This displays the RPMS iCare - Background Jobs dialog. Section 4.11 provides
information about this dialog.
3.8.4 CMET Tab Menus
The options on the File menu are the same as those on the File menu for the Cover
Sheet.
The options on the Tools menu are the same as those on the Tools menu for the Flags
tab.
The CMET menu varies, according to the sub-tab. Most of the CMET menus reflect
the buttons on the toolbar for that sub-tab.
3.9 Summ/Supp Tab
The Summ/Supp tab displays a selected type of report (shown in the Type field):
Asthma Action Plan, Face Sheet, Health Summary, Patient Wellness Summary,
Supplement. These reports are from RPMS.
When you first access this tab, it will be blank. You must select an option from the
list for the Type field.
You can display and print existing condition-specific (i.e., register specific)
supplements.
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CMET ]/D)CTags ]/'Family HX r BP Prompts r Natheasures/Summ!Suppr Suicide Form ]

Cover Sheet r Snapshot ]/Flags r Reminders ]/ Problem List ]/Drders r MNaotes ]/ Referrals ]/ Consults PCC Care Mgmt
= E & 5] =)
Type: |IEEEYARRAN - ||ADULT REGULAR =~ Refresh Find  Print Preview | Print

Prin

~~~~~~~ CONFIDENTIAL PATIENT INFORMATION —- 12/23/2020 12:00 BM [MW] *#**xxxx
~~~~~~~~~~~ DEM:_#lzs (LDULT REGULAR SUMMARY) pg 1 ##*ssssssxx

DEMOGRAPHIC DATA -----—-————

DEHO_ DOB: 5 YES FEMALE no blood type
APRCHE TRIBE, CK S5M: XXX-

morrEr's MATDEN NaME: (P
<no phone numbers recorded:>

ALBUQUERQUE

LAST UPDATED: JUL &, 2019 ELIGIBILITY: CHS & DIRECT

Figure 3-42: Sample Summ/Supp tab

When you use the Asthma Patient Care Summary (from the Supplement option), you
can review the Asthma Supplement Logic (Section V) in the Asthma Glossary. This
section of the glossary gives the structure of the report and the definitions of the
fields. (Select Help | Care Mgmt Glossaries | Asthma Glossary for more
information.)

3.9.1 Summ/Supp Tab Toolbar
The Type field determines which summary/supplement report to display:
e Asthma Action Plan
e Fact Sheet
e Health Summary (HS) — has a secondary selection; Adult Regular is the default
e Patient Wellness Handout — has a secondary selection
e Supplement — has a secondary selection
e Women’s Health Profile — Brief

Refresh button: It is not always intuitive to users that when they select a second HS
type and return to the initial HS, they have to click Refresh to display updated data,
for example, after entering PCC data.

Find button: Searches for a specific text string within the report text. This is
especially useful for finding information within long reports.

Print Preview button: Displays a preview of the page layout prior to printing the
report on a printer. Section 4.12 provides information about the Print Preview
dialog.
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Print button: Outputs the report. The application displays the Print dialog where you
select the printer, page range, and number of copies.

3.9.2 Summ/Supp Tab Menus

3.9.3 Tools Menu
The options on the Tools menu for the Summ/Supp tab are as follows:

¢ Quick Patient Search: This option executes a patient search. This action is the
same as pressing F8 on your keyboard.

e Refresh: Use this option when you select a second HS type, then return to the
initial HS to refresh and display the updated data, for example, after entering PCC
data. This action is the same as pressing F5 on your keyboard or clicking the
Refresh button.

e Find: This option finds data in the current window. The application displays the
Search dialog. This action is the same as clicking the Find button.

e User Preferences: This option takes you to the User Preferences window where
you can change your user preferences.

e Web Links: This option shows several categories (such as Asthma) that have
Web links. When you select a Web link, the Internet browser for the category
opens.

394 File Menu

The options on the File menu of the Summ/Supp tab are the same as those the File
menu for the Cover Sheet.

3.10 PCCTab

The PCC tab displays various types of PPC data associated with the patient. This data
comes the V Lab file from PCC.

Coversheet | Snapshot | Flags | Reminders | ProblemList | ordes | Notes | Referras | consuts* Pcc | careMgmt | CMET | DxTags | FamilyHx | BPPrompts | NatiMeaswes | SummjSupp | Suicide Form
—| Tips
Events added manuzly through this PCC tab are considered “historical ata" and may o may not be included in MU, IFC. or other quslity messures aqgregation for providers or facilfies.
3 =
ndd Event g onioe | TPe |EED Last: |1 year Related To: | | .0 0 9 288 M S G
Date W Y| Parent Fan. A Y| Panel AT Test L 7| Result V| NormaliAbnormal W | Range V| Ordering Physician T Units 7
Nov 13, 2020 —COVID-T8(Abboft 1D COVID- &
o 19
FOSITIV
E
5 _PROCEDURAL CONTROL Valid oy

Figure 3-43: Sample PCC tab

The PCC data that displays is determined by the selection in the Type field on the
toolbar. The time interval is controlled by the selections in the Last list.
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3.10.1

The PCC tab is divided into two general areas: Tips information and PCC data.

The Tips information provides an overview of the PCC tab. You can collapse this
area to have more room to view the PCC data.

PCC Tab Layout

No duplicate values display. For example, if a patient has multiple immunizations on
the same day, the date should display only on the first line.

The display can show any of the following PCC data types (shown in the Type field):

The CPT data has these data elements: Date, CPT Code, Modifier 1, Modifier 2,
Quantity.

The Elder Care data has these data elements: Date, Toileting, Bathing, Dressing,
Transfers, Feeding, Continence, Finances, Cooking, Shopping, Housework/Chores,
Medications, Transportation, Functional Status Change, and Is Patient a Caregiver?.

The Exams data comes from PCC V Exam files Data Elements: Date, Exam, Result,
Encounter Provider, Comments.

The Health Factors data comes from PCC V Health Factor files. Data Elements:
Date, Health Factor Category, Health Factor, Level/Severity, Quantity, Provider,
Comments.

The Immunizations data comes from PCC V IMM files. Data Elements: Date (visit),
Immunization, Series, Reaction, Encounter Provider.

The Lab data comes from the PCC V Lab file. Data Elements: Date, Parent Panel,
Panel, Test, Result, Normal/Abnormal, Range, Ordering Physician, Units. When
entering historical data, you are limited to lab tests only (you are not allowed entry of
lab panels because panels have no result since they are comprised of multiple
individual tests with associated results). You can filter Lab data by Related to
(currently HIV register-related).

The Measurement data comes from PCC V Measurements files. Data Elements:
Date, Measurement, Value, Qualifiers, Percentile. Qualifiers describe how patient
vital signs and measurements were taken (not all measurements have qualifiers).

The Medication data comes from PCC V Medications file. Data Elements: Date,
Medication (name), Instructions, Quantity, Days, Ordering Physician.

The Patient Education data comes from PCC V Patient Ed files. Data Elements:
Date, Disease/Topic, Level of Understanding, Time Spent, Provider, Goal Status,
Comments.
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3.10.2

3.10.2.1

The POV data comes from PCC V POV files. Data Elements: Date, POV Code, POV
Description, Provider Narrative, Primary/Secondary, First/Revisit, Encounter
Provider.

The Procedures data comes from PCC V Procedures files. Data Elements: Date,
Operation/Procedure, Provider Narrative.

The Radiology data comes from PCC V Radiology file. Data Elements: Date,
Procedure, Impression, Result.

The Skin Test data comes from PCC V Skin Test files. Data Elements: Date, Skin
Test, Results, Reading.

PCC Tab Toolbar

The default date range for all data is one year; you can select different predefined date
ranges (3 months, 6 months, 1 year, 2 years, or ever). The default display is in reverse
order of date with most recent first.

The Relate To field displays for Lab (from the Type field). There are other register
data that you can select for other data types.

When the Type is Measurement, the Graph It! button (see Section 3.10.5) displays
on the toolbar.

Section 4.2 provides information about using the buttons on the right side of the
window.

Add Event

Use the Add Event feature to record historical PCC data for the current patient. This
feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager
(BQIZMGR) security key.

The Add Event feature is available for each option in the Type field, except
Medications.

In PCC, this data is categorized with a Service Category of Historical Event and
does not enter the normal facility visit billing cycle. Historical data might need to be
entered to complete the patient record in the following circumstances:

e The facility uses an off-site reference lab and is not using the RPMS Reference
Lab application to send and receive lab data electronically directly into RPMS.

e A test or procedure was documented in the patient’s chart but was not entered into
RPMS.
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The patient was traveling and received care at another facility that should be
documented in their home facility.

The patient received an immunization or similar public health procedure at an off-
site community event.

o

Click the Add Event (EmE_fm__) button (or select PCC | Add Event) to display the Add
PCC Event dialog.

- — .
1 o AddPCCEvent - — == X
o 4
File Tools Help
4 | Add/Edit Event Info
§| Pcc Type: [cPT ~]
g | PatientName" DEMO, HAYDEN Location™: 2016 DEMO HOSPITAL D
3| Date: DE/26/2013 12.00 PMIEED) Dutside Location: |
Outside Provider: |
Hosp Locahon: | j
| CPT Code™ {none} B Modifier 1: {none} E]
Modifier 2- {none} G Quantity: |
Ad
Pending Events
= X =]
Add Mew Remove  Saveto PCC 34 = P
Patient Name Location QOutside Locati.. Outside Provi.. Hosp Location  CPT Code M

(L I

A

Figure 3-44: Sample Add PCC Event

Dismiss the Add PCC Event window by selecting File | Close.

When you click an ellipsis button by a field, the Table Lookup dialog displays.
Section 4.14 provides information about how to use this dialog.

The Add PCC Event window has two areas: (1) Add/Edit Event Info contains fields
to adding or editing PCC data and (2) Pending Events displays the records that are
pending events that you can remove, add new ones, and save to PCC.

Any field followed by an asterisk (*) is required.
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3.10.2.2

3.10.2.3

Please note that a Hospital Location is required for standard locations and not Outside
Locations.

Add/Edit Event Info Group Box
The default Patient Name is the name of the patient for the Patient Record.

The default location is the service unit associated with the current user. You can
change this by clicking the ellipsis button to search for a location name. If the
Location field is populated with OTHER, then the Outside Location and Outside
Provider Name fields become active; type the appropriate value in each Free Text
field.

The fields in this group box vary by the PCC Type. Fields followed by an asterisk (*)
are required.

Note: When using the PCC Type is Measurement, there is a field
called Qualifier(s). Not all measurement types have
qualifiers. Qualifiers describe how patient vital signs and
measurements were taken. But for example, temperature
has qualifiers of auxiliary, oral, rectal, core, tympanic, and
skin.

Pending Events Group Box

You can add new records, remove existing records, or save existing records in this
group box to PCC.

Section 4.2 provides information about how to use the buttons on the right side of the
toolbar of the Pending Events area. These same functions can be found on the Tools
menu of the Add PCC Event window.

If you double-click a record in Pending Events group box, the Visit Detail dialog
will display. Section 4.6 provides information about the using the controls on the
dialog.

e Add New: Click the Add New (4#t)) button (or select File | Add New) to clear
the fields in the Add/Edit Event Info group box where you can define a new
PCC type record. You need to populate the appropriate fields for the selected PCC
Type. When all fields are complete, click Add. This action adds a new record to
the Pending Events area.
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¢ [Edit a Record: Double-click a record in the Pending Events area to cause the
existing record data to populate the fields in the Add/Edit Event Info group box.
You can change the fields, as needed. When all fields are complete, click the
Apply Changes button. This changes the record in the Pending Events group
box.

e Remove: You can remove the highlighted records in the Pending Events group

box by clicking the Remove ( Es==) button (or selecting File | Remove). The
Confirm remove window displays, confirming the deletion. Click Yes to remove
the records. (Otherwise, click No.)

e Save to PCC: You need to save your changes/additions to PCC (that are listed in
o

the Pending Events group box). Click the Save to PCC (lz=terec) button (or
select File | Save to PCC) to display the Confirm save to PCC? information
message, confirming that you want to save the PCC data to the patient’s PCC visit
file.

Click Yes to save the information to PCC. (Otherwise, click No.). In either case, the
record is removed from the Pending Events group box.

After you exit the information message, the application updates the PCC tab on the
Patient Record window and displays the Add Chart Review? information message:
Do you wish to add a Chart Review at this time?

Click OK to add a Chart Review record (otherwise, click Cancel). If you click OK,
the application displays the Add a Note dialog. Section 4.4 provides information
about this dialog.

Please note that for each type of added event, you need to save. When you try to enter
a new type, iCare asks if you want to save the existing records to PCC. Do one of the
following:

e Click Yes to save to PCC. This action removes the record from the Pending
Events group box.

e Click No to not save. This action removes the record from the Pending Events
group box.

e Click Cancel to return to the Add PCC Event dialog.

3.10.3 Add a Note
The Add a Note feature is available for each option in the Type field. Use this feature
to add a note for the patient, such as a chart review, follow-up letter, or telephone call.
Note: The Add a Note button is active only if you have your
electronic signature on file.
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|

Click the Add a Note (Md'a nete ) button (or select PCC | Add a Note) to access the
Add a Note dialog. Use this dialog to add a new chart review, follow-up letter, or
telephone call note for the patient. Section 4.4 provides information about this dialog.

3.10.4 Related To

When the Type is Lab, the toolbar changes where you can indicate if you want to

show labs related to HIV/AIDS or Diabetes.

3.10.5 Graph It Button

The Graph It (

(1}
Graph It

) button only appears when the Type is Measurement. This

feature allows you to display, print, and save a graph of measurements data.

When the current patient has measurement data, click the Graph It button (or select
PCC | Graph It). The application displays the Charting window, showing a graph of
the various measurement types.

A Charting - RAINEY ADEM LEDN
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+ | Chast Diptions
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Figure 3-45: Sample Charting window

Section 4.13 provides information about the Charting window.
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3.10.6

3.11

PCC Tab Menus

The options on the File menu of the PCC tab are the same as those on File Menu for
the Cover Sheet tab.

The options on Tools menu on the PCC tab are the same as those on the Tools Menu
for the Flags tab.

The options on the PCC menu operate like the action buttons on the toolbar.
Section 3.10.2 provides information about the toolbar.

Problem List Tab

There are two conditions for this tab: (1) a patient with no problems and (2) a patient
with one or more problems. The toolbar to each condition will be different.

Patient with No Problems: The Problem List tab for a patient with no problems is
shown in Figure 3-46.

" Cover Stwet | Sospshot | Flogs | Reminders | 6P Prompts | ot Hossures | MET | summisup | PocF [Problem List)
W) Z] 4 & S o

Froblsm List Reviewed Mo Active Problems

|F‘lu:nt:lem|[) ?iﬁr&m ‘7|P1m-1-uhaudn'¢ W | Date ol Orest 7| D0 Code ‘i‘lP‘l-:l:iernHutes ?Eliiars:hcd-c-'-

Figure 3-46: Problem List tab for patient with no problems
The No Active Problems button only displays for a patient with no problems.

Patient with Problems: The Problem List tab shows the patient’s current problem
list (Figure 3-47). The Problem List data comes from the PCC Problem List.

CoverShect | Snapshot | Fiags | Reminders, | Problem List]| Ordess | Notes | Referras | Consuts | POC | CareMgmt | CMET | DXTags | Family HX |~ BPPrompts | NatlMeaswes | SummySupp | SuicideForm |
Problem List Reviewed vwEAES
PROBLEM LIST REVIEWED On: Nov 19. 2014 0359 PM
PROBLEM LIST UPDATED On: Nov 19. 2014 03:59

ProblemID ¥ | Status rovi ve ¥|DatecfOnset 7| DXCode 7| Problem Notes V| Classification 7| Date Last Modified 7| User Last Modified 7 | Facility 7/ Class v

HO1 CHRONIC 110, - Essertial Nov 12, 2012 [ ] HOLTON HC
(primary) hypertension
Ho2 CHRONIC Obesity | EBE9: Obesity, Nov 14, 2014 HOLTON HC
Eses- 06 L)
Hoe CHRONIC “VENOUS STASIS 4541-LEG Jan 08, 2003 [ ] HOLTON HC
VARICOSITY W/
INFLAM
DB CHRONIC “S/P QUAD BYPASS VIB1 - HX-MAIOR. Jul 13,2007 - 2016 DEMO
4 CARDIOVASC SURG HOSPITAL
D86 CHRONIC Allergic thintis | 1308 - Alergic. Nov 14, 2014 2016 DEMO
thinit -_— HOSPITAL
[ol:7g CHRONIC Hypothyroidism | E039- Hov 14, 2014 —zms DEMO
Hypoth HOSPITAL
unspec
DEZ CHRONIC Chronic ischemic heart 1259 - Chronic: Nov 14, 2014 [ ] 2016 DEMO
disease | ischemic heart HOSFITAL
disease, unspecified
DB CHRONIC Chroric obstructive lung 1443 - Chroric Nov 14, 2014 2018 DEMO
disease | obstructive pulmonary [ ) HOSPITAL
disease, unspecti
DB CHRONIC Chroric kidney disease N1.30 - Chronic: Hov 16, 2014 G -o-o
stage31 Kidney disease. stage HOSPITAL
3 unspecified
DETS CHRONIC Hyperipidermis | E7B5- Nov 14, 2014 (] 2016 DEMO

Figure 3-47: Sample Problem List tab

The default Problem List display shows the Active Problems first, then the Inactive
ones.
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3.11.1

3.11.2

3.11.3

Problem List Tab Layout
The data columns are:
e Problem ID: The identification label assigned to the problem.

e Status: Status of the problem, Active (showing Chronic, Sub-acute, episodic,
social) or Inactive.

e Provider Narrative: The narrative entered for the International Classification of
Diseases (ICD) code for the problem.

e Date of Onset: The date the symptoms started.
e DX Code: The ICD code for the problem.
e Problem Notes: Any notes entered about the problem.

e C(lassification: This shows any staging associated with the problem (for example,
in Asthma Severity).

e Date Last Modified: The date the problem was last modified.
e User Last Modified: The name of the person who last modified the record.

e Facility: The name facility where the login user (who entered the problem)
resides.

e Class: This will be blank or will contain Personal History.

The default display (sort) order will be by Status (Active first), then by Problem ID.
You can sort/filter the columns and perform other functions on the columns.

Problem List Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.

No Active Problems

Use the No Active Problems button to document that the patient has no active
problems. Click the No Active Problems button to access the No Active Problems
dialog.

=101 %]
Efe Help

Add/E dit

[ abe Proveder d e Provides who documented

NoAclive Problems™ | I = NohctveProblem= ! |

ok | cowe

Figure 3-48: No Active Problems dialog
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Both fields are required.

Date Provider documented “No Active Problems”: Either manually populate this
field with the date or click the list and pick a date from the calendar.

Provider who documented “No Active Problems”: Click the ellipsis button to
access the Table Lookup dialog. Here you search for a name and select one from the
retrieved records to populate the field. Section 4.14 provides information about using
the Table Lookup dialog.

After the dialog is complete, click OK (otherwise, click Cancel).

After clicking OK, the application displays the Confirm save to RPMS information
message: This data will be saved to the RPMS server. Do you want to continue?
Click Yes to save the data to the RPMS server. Click No to not save the data.

After clicking Yes, the Problem List tab will change, displaying a message that there
are no active problems.

caversheet | Snapshot | Flags | Remindes,* Probiem Listi| ordes | Notes | Referras | consuis | pec | caremgmt | eMET | oxTags | FamilyHx | BPromps | NatiMeasures | sumn
Problem List Reviewed | Mo Active Problems 9 74 =
Problem!D ¥ Status 5| Provider Narstive 7| Dateof Onset 7| DX Code V| ProblemNotes V| Classification 7| DsteLastModified ¥ User Last Modified 7| Fac

Figure 3-49: Sample Problem List tab showing message about no active problems

3.11.4 Problem List Reviewed

Use the Problem List Reviewed button to document that the patient’s problem list
was reviewed.

Click the Problem List Reviewed button to access the Problem List Reviewed

dialog.
@ Problem UistReviewsd =101
Bl Help
Add/E dit
[rate Probbem Lt Provides W Fevesed
Feviemod: e . =l Problem List™ e J

119 Cancel

Figure 3-50: Problem List Reviewed dialog
Both fields are required.

Date Problem List Reviewed: Select a date by clicking the list to access a calendar.
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3.11.5

3.12

3.12.1

Provider Who Reviewed Problem List: Click the ellipsis button to access the Table
Lookup dialog where you search for a provider name. This is the provider who
reviewed the problem list. Section 4.14 provides information about using the Table
Lookup dialog.

When the dialog is complete, click OK (otherwise, click Cancel). After clicking OK,
the application displays the Save to RPMS? information message: You have data
changes pending. Do you want to save to RPMS now? Click Yes to save the data
to RPMS. Click No to not save the data to RPMS.

After clicking OK, the application updates the toolbar with information about when
the problem list was reviewed.

Fnbiens List Rervesed “ E 8 E

I PRUOELEH LIST REVIOWED O Age 20 3013 1 2004M by TEST PHYSIAN

Figure 3-51: Toolbar showing when the problem list was reviewed

Problem List Tab Menus

The options on the File menu of the Problem List tab are the same as those on the
File menu for the Cover Sheet tab.

The options on Tools menu on the Problem List tab are the same as those on the
Tools Menu on the Flags tab.

Care Management Tab

The Care Management tab displays any related care management data about the
current patient. You must select an option from the Please Select a Group field to
display data. There are two conditions: (1) if the patient does not have any related
care management data and (2) if the patient does have related care management data.

Patient with No Tag

Asthma, DM Audit, HIV/AIDS

Cover Sheet rSnapshﬂt Flags | Reminders r ProblemList [ Ordes [ Notes | Referrals rcunsmts pcct Care Mgmt [ CMET [ DXTags rFam\IyHX ]/ BP Prompts r Nat| Measures r Summ/Supp ]
)
Please Select a Group: |[ETTEVRNN ~ ‘Falienldoes nothave an associated Asthmatog
Add Tag  Accept
/" Main

@ E = | E]

G\Dssary| Refresh  Find  Print Preview  Print

{No Data Available}

Figure 3-52: Sample Care Management tab for patient with No Tags for Asthma

The Care Management toolbar displays information that the patient does not have an
associated Asthma, DM Audit, or HIV/AIDS tag.

e Section 3.12.1.2 provides information about using the Add Tag button.

Patient Record User Manual Package Management
March 2021

56



iCare Population Management GUI (BQl) Version 2.9

3.12.141

3.12.1.2

e Section 3.12.3.1 provides information about using the Accept button.

HIV/AIDS

| Cover Sheet r Snapshot rFlags r Reminders r Problem List r Orders r MNotes r Referrals r Consults PCC~ CareMgmt | CMET

] ]
= =] = - =
Please Select a Group: (g - | | Patient does not have an associated HV/AIDS tag
p: |CIVZOON ~|| o Add Tag

Main

Accept

Reminders

7] d| <, Y|

Save

Glossary Reports

Figure 3-53: Sample Care Management tab for patient with No Tags for HIV/AIDS
The Care Management toolbar displays information that the patient does not have an

associated HIV/AIDS tag.

Enter Data

Click the Enter Data (| Exter Dt ) button (or select Care Mgmt | Enter Data) to add the
patient to a register.

The fields will display in the Main sub-tab. This feature requires either the iCare
Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.
Section 3.12.5 provides more information about the Main sub-tab.

Add Tag

Use the Add Tag process to add a diagnostic tab. Click the Add Tag (1%472 ) button
(or select Care Mgmt | Add Tag) to access the Add Diagnostic Tag dialog. This
step is a manual add.
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3.12.1.3

[ add Diagnostic Tag =10] x|

Yiew Tag Activity

Add/Update Diagnoshic Tag
Patient Mame; DEMO KATHIE
Diagnostic Tag HINAAIDS
Hew Status:

Status Change A eason ¢ Patieck Dl Supports Accepiancs

T Manusly Designated
" Other

Status Comment:

".l'lewTag.ﬁ.ctwﬂ.yl 0k | Concel |

Figure 3-54: Sample Add Diagnostic Tag dialog

This manual-add process allows a provider to manually assign one or more of the
diagnostic tags to patients that did not meet the tag’s criteria for being proposed
automatically.

the Diagnostic Tag field will be Diabetes.

Note: If you are adding the Asthma diagnostic tag, the Diagnostic
Tag field will be Asthma. If you are adding for DM Audit,

Fields
New Status: the status of the tag being changed.

ACCEPTED: This option allows you to Accept a proposed tag to provide an

affirmation of its validity for a given patient.

NOT ACCEPT: This option allows you to disapprove or Not Accept a diagnostic

tag that has been proposed for a patient.

PROPOSED: This option allows you to change the status of a diagnosis tag back

to Proposed, so that further review can take place.
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Reason: Select the appropriate option button for the reason to change the tag:

o Patient Data Supports Acceptance: Use this when the patient data does not
support the tag.

e Manually Designated: Use this when you manually designate the tag.

e Other: Use this when the other reasons do not fit. You must populate the Status
Comment field to provide the text of the reason.

Status Comment: Type the reason for the change (when the reason is Other) in this
Free Text field. This feature provides a rich audit history for reasons for providers’
decisions to accept or not accept proposed tag assignments.

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to
refresh the screen; the message besides the Care Management Group field will
reflect the change.

3.12.1.4 View Tab Activity Button
Use the View Tag Activity button to view the diagnostic tag activities. Click View
Tag Activity to access the RPMS iCare — Diagnostic Tag Activity dialog.
[ RPMS iCare - Disgnostic Tag Activity - THETAALPHA {1 11159-DH,444447-DIH 33333 7-URA] =168 x]
" mckivity]
tog [T =]  oisplay Factor Detadls [ w9 F1 E S D
F Tag Hame | Stabus Last Updat_ * ."Updaledll,- ”Slaﬂus Change Reason j Stabus Comment J
PN CVD Frien PROFOSED SYSTEM LFDATE
| Diabetes ALLEFTED Oict 20, 2008, SYSTEM UPDATE  On Essating Flegister
HiVAAIDSE HO LOMGER WALID Dct 21, 2008 SYSTEM UPDATE Dt Selection Crtens Modiied
il BLCEFTED Dt 20, A0, FOST INSTALLJOE  OnEsattng Fegrrter Rmgretni ghahut oA
| Hypertanion FROPOSED Oct 20, 2008, SYSTEM UPDATE  Spstem Gerersted
Figure 3-55: Sample Diagnostic Tag Activity dialog
You can view various tags by selecting an option from the list for the Tag field.
If you select the Display Factor Details check box, the following columns will
display: Factor, Date, Item, and Value. This selection allows you to view additional
details about the tags. The default view is unchecked. You can sort/filter the columns
and perform other functions on the columns.
Click the Glossary (/*)) button to display the Diagnostic Tag Glossary. This dialog
provides the detailed logic for each national performance measure defined in the
Clinical Reporting System.
You must dismiss the dialog.
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3.12.2 Accept Button
When the Accept button is active in the toolbar of the Care Management tab, you can
change the status of the tag (displayed in the toolbar). The button will be active, for
example, when the status of the tag is Proposed.
Section 3.12.3.1 provides information about using the Accept button.
3.12.3 Patient with Active Tags
The data will display on the Main sub-tab.
Please Sedect & Group: [HIVAIDS - |Puimduualhmmu*mhﬂl-ﬁfmug M;_'L\:l R N
/m Fosmindens
7 | | | A, .|
idogiary | Save | Reports
. | General =
Rogister Status™  [ACTIVE =] Hmbusffuhz
E:;nmh
uopated <Al [AT RISk EF0SED SOURCE UNFNDW =] 3.,..;"';".2‘.':..
SOURCE
UUHERIN M
Intial VDR Dot [ ] e e |
B A okt
Clonsivosten. | =
HIV Pravider Ireane J HIV CaseManages: {none] J —
Whese Followed  [none! J OutsideLocatioer |
Dutside Provide: | ﬂ
Figure 3-56: Sample Care Management Tab for patient with HIV/AIDS tag
Note: Only the Main sub-tab displays for Asthma and DM Audit.
3.12.3.1 Accept
When the Accept button is active in the toolbar of the Care Management tab, you can
change the status of the tag (displayed in the toolbar). The button will be active, for
example, when the status of the tag is Proposed.
Click the Accept button (or select Care Mgmt | Accept Tag) to display the Update
Diagnosis Tag dialog. This dialog displays the patient name, diagnostic tag, and
current status.
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¥ Update Diagnostic Tag D@@

View Tag Activity
Add/Update Diagnostic Tag

PatientName: TN

Diagnostic Tag COPD
Current Status PROPOSED

New Status INOT ACCEPTED _:_j

" Other
" Patient Data Does Not Support Acceptance

Other:

o) Cowes ]

Figure 3-57: Sample Update Diagnosis Tag dialog

You can view existing tag activity about the patient by clicking the View Tag
Activity button. The Diagnostic Tag Activity dialog displays. Section 3.12.1.4
provides information about this dialog.

You can edit the following fields:
e New Status: The status of the tag being changed.
— ACCEPTED: This option allows you to Accept a proposed tag to provide an
affirmation of its validity for a given patient.

— NOT ACCEPT: This option allows you to disapprove or Not Accept a
diagnostic tag that has been proposed for a patient.

— PROPOSED: This option allows you to change the status of a diagnosis tag
back to Proposed so that further review can take place. In certain cases, this
option might not be available.

e Reason: Click the appropriate option button for the reason to change the tag.

— Patient Data Supports Acceptance: Use this when the patient data does not
support the tag.
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— Manually Designated: Use this when you manually designate the tag.

— Other: Use this when the other reasons do not fit. You must populate the
Other field to provide the text of the reason.

e Other: Type the reason for the change (when using the reason Other) in this Free
Text field. This feature provides a rich audit history for the providers’ decisions to
accept or not accept proposed tag assignments.

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to
refresh the screen; the message besides the Care Management Group field will
reflect the change.

3.12.4 Add Tag
Use the Add Tag process to add a diagnostic tab. Click the Add Tag (\##%.) button
(or select Care Mgmt | Add Tag) to access the Add Diagnostic Tag dialog. This
action is a manual add. Section 3.12.1.2 provides information on using the Add Tag
process.
3.12.5 Main Sub-Tab
Use the Main sub-tab of Care Management window to add/edit patient register
information.
CMET rD)(Tags ]/FaminH)( l/ BP Prompts r Natl Measures SummySupp r Suicide Form l
Cover Sheet ]/ Snapshot I/Flags r Reminders r Problem List Orders l/ Notes r Referrals l/ Consults PCC) Care Mgmt I_
Please Select a Group: |HIV/AIDS - | Patient has an associated HIVIAIDS tag with a status of ACCEFTED (—i )
Add Tag Accept
Main Reminders
@ | = | Q v|
Glossary ! Save | Reports
i General
+| Partner Notification
+| Antiretroviral (ARV) Status
+ State Notification
Figure 3-58: Sample Care Management tab after clicking Enter Data
You need to expand any category (listed below the toolbar buttons) that you want to
change. After completing your changes, click the Save button to save your changes.
Section 3.12.9 provides information about the save process.
Many of the field lists include a blank option to use when the field has no data.
Usually, the blank option is the first available on the list.
Note: Only the Main sub-tab displays for Asthma and DM Audit.
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3.12.6 General
Expand the General category to display the fields on the General group box.

 Main |_Remindess |
o1 | s ]
Gy Save | Reports
. —| General
Register Status™  [ACTIVE =] Em?:m
EHE Disgriosm
prp—
«Piopazed D
RIS EXPOSED 405 = Cinmiiri
SOUACE
UHENDWH
Iritial HIV D Dates [ Da,02013 =] il =l
F&E E ""m - [HET Hetercesmasal cortact =] Eticlogy Comments:
COC Clanical
Classificator | =
HIV Provider frionel J HIV CosaManages: EDEMOARLENE F EI
Whete Followed [ﬁcm:J Dutzide Locatione |
Dutzide Provider |

Figure 3-59: Fields for the General group box
All fields with an asterisk (*) are required.

e Register Status: Select an option from the list that indicates the status of the
patient on this register.

e Register Status Comments: Type comments about the register status selection in
this Free Text field (limited to 50 characters).

e HMS Diagnosis Category: Select a specific HIV-related diagnostic category
from the list.

e Diagnosis Comments: Type comments about the HMS Diagnosis Category
selection in this Free Text field (limited to 50 characters).

e [Initial HIV DX Date: Select the date when this patient was first diagnosed with
HIV from the calendar on the list for this field. You can enter a month and year
only; in this case the entry will be stored in BKM as MM-01-YYY'Y. This field is
active only when you have populated the HMS Diagnosis Category field with
HIV.

Note: A proposed date might display, based on the earliest RPMS
data that meets the HIV/AIDS tag definition. You must
enter the actual date even if you want to accept the
proposed date.
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o Initial AIDS DX Date: Select the date when this patient was first diagnosed with
AIDS from the calendar on the list for this field. You can enter a month and year
only; in this case the entry will be stored in BKM as MM-01-YYY'Y. This field is
active only when you have populated the HMS Diagnosis Category field with
AIDS.

Note: A proposed date might display, based on the AIDS logic
defined previously in the HMS Diagnosis Category field.
You must enter the actual date even if you want to “accept”
the proposed date.

e CDC Cause (Etiology): Select an option from the list that indicates the cause
(etiology) of the patient’s DX. The Centers for Disease Control has categorized
the ways in which an individual is exposed to HIV.

e Etiology Comments: Type comments about the CDC Cause selection in this Free
Text field (limited to 50 characters). (This field is active only when the CDC
Cause (Etiology) field is populated.) A comment should always be entered if you
select OTH - Other in the CDC Cause field.

e CDC Clinical Classification: This field is active when the HMS Diagnosis
Category field contains AIDS or HIV. Select the clinical classification from the
list.

The current CDC classification system combines three categories of the CD4 count
with three symptom categories. The use of both the CD4 cell count and clinical
categories provides shorthand for where the patient stands during the HIV/AIDS
continuum. While there are guidelines in place, assign the classification only after
clinical evaluation. The decision of which category to assign is always made by a
clinical person. The CDC proposed that the clinical classification system be used to
“guide clinical and therapeutic actions in the management of HIV-infected
adolescents and adults.”

The HIV Provider, HIV Case Manager, and Where Followed fields are populated
by using the Table Lookup dialog. Section 4.14 provides more information about
using this dialog.

e HIV Provider: Click the ellipsis button to search for a HIV provider name at
your facility. If this patient is cared for at an outside facility, enter the provider in
the Outside Provider field. This information is pulled from the RPMS
Designated Specialty Provider Management (DSPM) application, if available, and
displayed here.

e HIV Case Manager: Click the ellipsis button to search for a case manager name
at your facility. This information is pulled from the RPMS Designated Specialty
Provider Management (DSPM) application, if available, and displayed here.
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3.12.7

3.12.71

e  Where Followed: Click the ellipsis button to search for name of a facility that
primarily follows the patient’s care related to HIV/AIDS. If this is not your
facility, select OTHER from the list; you can identify the specific facility in the
outside location field and the provider in the Outside Provider field.

e OQutside Location: Manually type the name of the facility or outside physician’s
office where the patient is followed. This is a Free Text field limited to 50
characters.

¢ OQutside Provider: Manually type the name of the patient’s HIV provider at the
outside location. This is a Free Text field limited to 50 characters.

Partner Notification

This notification type is to document the notification of a patient’s partner of a
potential exposure to HIV. The public health recommendation to notify the patient’s
partner is a practice that is encouraged in all I/T/U facilities.

E Partries Maobifpcaton

Partner Motification | 1 Prartnes Motificabon
Slabus: I E Diate:

Figure 3-60: Fields for Partner Notification group box

Expand the Partner Notification category to display the following fields on the
Partner Notification group box:

e Partner Notification Status: Select an option from the list that indicates the
partner notification status.

e Partner Notification Date: This field is active when the Partner Notification
Status contains Yes. Enter a date that the partner was notified; you can select from
a calendar by using the list.

Antiretroviral (ARV) Status

Expand the ARV category to display the fields on the Antiretroviral ARV (Status)
group box.

Use this group box to enter ARV (antiretroviral) medications data for ARV
appropriate, ARV adherence, and ARV Stability. The medications are used to treat
HIV/AIDS patients by reducing the viral load and improving the immunological
function.

Because the ARV status might change over time, HMS maintains a history of ARV
Appropriate and Compliance statuses for the patient. The entire ARV history will be
displayed on this screen with the most recent status listed first; this feature allows the
provider to easily view the continuum of assessment.
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= Anfiretroviral (ARY) Stakus
ARV Appropriate:

Q) AddiF) 9K Delete (Do)

Date Stabus Cormemend Last Edited By Last Ecited Date
Map 21, 2000 |Yes. Appiopdate tezling FELE< LINDGAY May 21, 2000

ARV Adherence

) Add(Fz) X Delete (Del)

Dishe Audhesent Comererts Last Edibed By Last Edited Date

Map 21, 2000 |[Adbenent G LIMDSAY May 21, 2000
Map 14, 2000 Honadhetert Iesting FELDLLINDSAY May 21, 2010
ARY Stability.

() Add(F2) K Delste (Del)

Drate Slakdty AW Regamen Commmearts Last Eched By Last Ecied Date

Figure 3-61: Fields on the ARV group boxes

For ARV Appropriate, click the Add () button to add data. Each of the fields
on the row will have either a list from which to select or a Free Text field where you
enter information. Data can be entered at any time and can be done so retrospectively.

e Date: Enter the date the patient was assessed for suitability for ARV (required).
Click the list to select a date from a calendar.

e Status: Select an option from the list that indicates the status of the ARV
Appropriate record.

e Comment: Type a comment, if appropriate, in this Free Text field, using up to 50
characters.

e Last Edited By: The name of the person who last edited the record (system
populated).

e Last Edited Date: The date the record was last edited (system populated).

After you click Save, iCare confirms that you want to add the record. After clicking
Yes, iCare populates the Last Edited By field (name of user who populated the
record) and today’s date in the Last Edited Date.

For ARV Appropriate, you can delete your own selected records by clicking the

Delete ( button to display the Delete Rows information message. Click Yes
to remove the records. (Otherwise, click No.)
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For ARV Adherent, click the Add (l2_*2") button to add data. Each of the fields in
the row will have either a list from which to select or a Free Text field where you
enter information.

e Date: This date is the date the patient was assessed for adherence to the
prescribed ARV regimen (required). Click the list to select from a calendar.

e Adherent: Select an option from the list that indicates the adherent status of the
record.

e Comment: Type a comment, if appropriate, in this Free Text field, using up to 50
characters.

e Last Edited By: The name of the person who last edited the record (system
populated).

e Last Edited Date: The date the record was last edited (system populated).

After you click Save, iCare confirms that you want to add the record. After clicking
Yes, iCare populates the Last Edited By field (name of user who populated the
record) and today’s date in the Last Edited Date.

For ARV Adherent, you can delete your own selected records by clicking the Delete
([F o= ey button to display the Delete Rows information message. Click Yes to
remove the records. (Otherwise, click No.)

For ARV Stability, click the Add (Il2_2£%]) button to add data. Each of the fields in
the row will have either a list from which to select or a Free Text field to enter
information.

e Date: This date is the date the patient was assessed for ARV Stability. Click the
list to select from a calendar.

e Stability: Select an option from the list that indicates the stability status of the
record.

e ARV Regimen: Click the list and select one of the options: Changed, Unchanged.

e Comments: Add any comments regarding the ARV Stability data in the Free Text
field.

e Last Edited By: The name of the person who last edited the record (system
populated).

e Last Edited Date: The date the record was last edited (system populated).

After you click Save, iCare confirms that you want to add the record. After clicking
Yes, iCare populates the Last Edited By field (name of user who populated the
record) and today’s date in the Last Edited Date field.
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For ARV Stability, you can delete your own selected records by clicking the Delete (

button to display the Delete Rows information message. Click Yes to
remove the records. (Otherwise, click No.)

3.12.8 State Notifications

This notification type involves the requirement to notify the appropriate state Health
Department of new AIDS diagnoses; most states also required notification of HIV
diagnoses as well.

Expand the State Notification category to display the following fields on the State
Notification group box (Figure 3-62).

= State Notification

State HIV Repot Staste HIV Repaort

EId::. | :J Dd: | J
E::UHN E:IHHN

Staluz, [ _] Date: | ;]
Siale AIDS R Siale AIDS R

SIM::: i | ﬂ Du:; s | ﬂ
Siale AIDS Stale AIDS

Sk norwldogmenl - Acknowlodgamenl =
Ststus: ! K Drate: ! =

Figure 3-62: Fields on State Notification group box

If the HMS Diagnosis is HIV or AIDS, then the fields in this group box are active.

o State HIV Report Status: Select the State HIV Report Status from the list: N/A,
No, Remind Me Later, Unknown, or Yes. This answers the question: Has the
state health department been notified about this patient’s HIV status?

e State HIV Report Date: This field is active if the State HIV Report Status field
contains Yes. You can select from a calendar by using the list. This date is the
date the State HIV status report was submitted to the state health department.

o State HIV Acknowledgment Status: Select the State HIV Acknowledgment
status from the list: No, Unknown, or Yes. This answers the question: Has your
facility received an acknowledgement from the state health department?

e State HIV Acknowledgment Date: This field is active if the State HIV
Acknowledgment Status field contains Yes. You can select from a calendar by
using the list. This date is the date the state acknowledged receipt of HIV report,
if any.

o State AIDS Report Status: Select the State AIDS Report Status from the list:
N/A, No, Remind Me Later, Unknown, or Yes. This answers the question: Has
the state health department been notified about this patient’s AIDS status?

e State AIDS Report Date: This field is active if the State AIDS Report Status
field contains Yes. You can select from a calendar by using the list. This date is
the date the AIDS status report was submitted to the state health department.
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3.12.9

3.12.10

e State AIDS Acknowledgment Status: Select the State AIDS Acknowledgment
status from the list: No, Unknown, or Yes. This answers the question: Has your
facility received acknowledgement from the state’s health department? Note:
Most sites report that they do not receive this acknowledgment.

o State AIDS Acknowledgment Date: This field is active if the State AIDS
Acknowledgment Status field contains Yes. You can select from a calendar by
using the list. This date is the date the state acknowledged receipt of AIDS report.

Save Button

Use the Save function to save the care management information (entered or changed)
in RPMS. Click the Save button (or select Care Mgmt | Main | Save) to display the
Confirm save to Care Mgmt information message where you are asked if you want
to save the patient’s care management record in RPMS. Click Yes to save (otherwise,
click No.)

The following is one example of what happens after you click Yes. What displays
after you click Yes depends upon if there is a tag status or not.

After clicking Yes, you will receive a message asking about changing the tag status.

IHS iCare x|

This patient's HIV/AIDS Tag Status is currently PROPOSED,
Do you wank ko change to ACCERPTED?

Mo | Zancel |

Figure 3-63: Message About Changing Status
If you click Yes, you go to the Update Diagnostic Tag dialog.

If you click No, the system displays the message: HMS Register data has been saved
successfully to RPMS. Click OK to dismiss the message.

If you click Cancel, the system asks if you want to cancel the entire Save process. If
you click Yes, you exit the save process. If you click No, the application displays a
message: Are you sure you want to cancel the entire Save process? Click Yes to
cancel the entire Save process. Click No and the application displays the message
HIV Management System data has been saved successfully to RPMS. Click OK to
dismiss the message.

Reports

Click the list for the Reports button (or select Care Mgmt | Main | Reports) to
access any of the following reports (Table 3-4).
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Table 3-4: Report selections and What You View

Report Selection What You View

Asthma Action Plan Asthma Action Plan report.

Fact Sheet Ambulatory Care Record Brief report.

Health Summary You first select a summary type to view. For example, if you select
Lab, you will view the DMS Lab Report Summary.

Patient Wellness Handout You first select the report parameter that determine the Wellness
Handout type. You view the selected patient wellness handout type
report.

Supplement You first select a supplement type to view. For example, if you select

Diabetic Care Summary, you will view the Diabetic Patient Care
Summary.

Women’s Health Profile - Brief | Women’s Health Patient Profile that lists the date, procedure,

results/diagnosis, and status (for female patients only).

State Surveillance Adult HIV/AIDS Confidential Case Report to State (State

Surveillance report in BKM) about the patient.

HMS Patient Care Supplement | HMS Patient Care Supplement report.

State Surveillance (Blank) Adult HIV/AIDS Confidential Case Report to State about the patient.

This option gets as much data from RPMS that is available. This
allows the providers to review this report and manually correct any
incorrect or missing data. Then the report is to be sent to the
appropriate state agency.

3.12.11

3.12.12

Glossary Button

Click the Glossary button to access the HIV/AIDS / Care Management Glossary
dialog. The glossary provides information about (1) creating a panel, (2) the
HIV/AIDS Register specific fields, (3) HMS Patient Care Supplement, (4) Quality of
Care Report, and (5) Definitions.

Section 4.6 provides information about using the controls on the dialog.

Reminders Sub-Tab

ﬁ_-}-ﬂfnﬂrﬂ]

I oM ENES D

Paitient i eminders dota curment as of Mar 01, 2010 000 PM

" Eapmpory 7 CrecalGoop 7| Reminde Mane 7DDt 7| st e =
| Caie Maragemert HIV T4 Tesl 8 e 01, 20000 MAT BE DILE HOW (Wit DUE O A

- HIW Wiral Losd Teat ¢ Mar 0, 2000 MEY BE DLUE NOW (wigs DUE oA Al

Figure 3-64: Sample Reminders sub-tab on Care Management

Note: The Reminders sub-tab does not display for Asthma and
DM Audit.
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e Category: The category of the reminder, for example, Case Management.
¢ Clinical Group: The clinical group of the reminder, for example, HIV.

¢ Reminder Name: The name of the clinical procedure that needs to be done. You
can view a tooltip by hovering your mouse over any Reminder Name cell.

e Due Date: The date the reminder procedure is due. This column will display the
warning indicator ( ! ) if any of the patient’s reminders are overdue. This date is
derived from the Health Summary Reminders Next Due test.

e Next Due: The actual text from the Reminders Next Due displays on the Health
Summary.

e Last Date Performed: The date that the reminder procedure was most recently
completed.

e Preceding CMET Event: This is populated with the tracked Event that initiated
this follow-up. If the displayed reminder is not a CMET Reminder, this cell will
contain N/A.

e Date of Preceding CMET Event: The date of the preceding CMET Event.
You can sort/filter the columns and perform other functions on the columns.

If the patient does not have any HIV reminders, iCare displays the message: No
Reminders Returned. (Click OK to dismiss the message.)

3.12.13 Patient with Asthma Tag

The current definition for the Asthma Tag is patients with at least two POVs ever (not
on the same date) and one instance on the Active Problem List. Asthma defined with
the taxonomy ([BGP ASTHMA DXS]) contains ICD codes 493.00 — 493.92.

CMET ]/D)(Tags I/ Family HX ]/ BP Prompts r Matl Measures ]/ SummySupp l/ Suicide Form l
Cover Sheet r Snapshot rFlags r Reminders r Problem List rOrda's rNotes r Referrals r Consults PCC~ Care Mgmt

. v
Please Select a Group: m - | Patient has an associated Asthma tag with a siaius of PROPOSED J_ J
Add Tag Accept
Main
@ | 2 & = =]
Glossary Refresh  Find  Print Preview  Print
~
******* CCNFIDENTIAL PATIENT INFORMATION -- 12/23/2020 12:32 PM [MW] #=###&&x
ASTHMA PATIENT CARE SUMMARY REeport Date: Dec 23, 2020
=z : (D
H Age: 55 M Asthma Diagnostic Tag: Proposed
DESIGNATED PRIMARY PROVIDER: —
Asthma-Related Problem List: w

Figure 3-65: Sample Patient with Asthma tag
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3.12.14

3.12.15

3.12.16

3.12.17

The Main sub-tab displays the existing Asthma Patient Care Summary (Supplement)
report. Section 4.6 provides information about using the controls on the dialog. The
Asthma Care Management view does not include the Reminders sub-tab because
there are no asthma-specific reminders.

Click Glossary to access the Asthma / Care Management Glossary. This glossary
includes (1) Asthma Diagnostic Tab definition, (2) asthma-specific data/patient
record, (3) asthma panel layout options/panel view, and (4) asthma supplement logic.

Care Management Tab Menus

The options on the File menu of the Care Management tab (both Main and
Reminders sub-tabs) are the same as those for the File menu on the Cover Sheet tab.

Tools Menu for Main Sub-Tab

The options on the Tools menu for the Main sub-tab of Care Management are the
same as those on the Tools menu for the Cover Sheet tab.

Tools Menu for Reminders Sub-Tab

The options on the Tools menu for the Reminders sub-tab are the same as those for
the Tools menu for the Flags tab.

Care Mgmt Menu

The options on the Care Management window (both Main and Reminders sub-tabs)
follow. Both sub-tabs have the following options on the Care Mgmt Menu:

e Add Tag: This option works like the Add Tag button.
e Accept Tag: This option works like the Accept button.

e HIV/AIDS Management Guide: This option displays the iCare Population
Management GUI window for online help.
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3.12.17.1 Main Sub-Tab
Figure 3-66 shows the Main sub-tab for the HIV/AIDS (Group):

Care Mok | Tools Window Help

|
Miainy L] _d Save
€ HIV/AIDS Management Guide QL Reporte »| | Asthens Action Plon
Face Sheat
Heakh Summary
Patiant Welress Handout
Supplement
Women's Health Profile - Brief
State Surveillance
HMS Patient Care Supplement
Stake Surveilance (Blank)

Figure 3-66: Care Mgmt menu options for HIV/AIDS

e Save: This option has the same function as the Save button on the Main sub-tab.
e Reports: This option lists the available report on the Main sub-tab.

e HIV/AIDS Management Guide: This option displays the iCare Population
Management GUI window for online help.

The following option displays if you are on the Main sub-tab for Asthma group:

e Refresh: This option refreshes the Reminders sub-tab by retrieving the most up-
to-date information from the server. This action is the same as pressing F5.

3.12.17.2 Reminders Sub-Tab
The Reminders option for the HIV/AIDS (Group):

Care Mgmt | Tools Window Help
“  Add Tag

&

Reminders bl Recalc

Vil

&) HIVAIDS Management Guide 7] Refresh E5

Figure 3-67: Care Mgmt menu for the Reminders sub-tab

e Add Tag: This option works like on the Action button on the Care Mgmt
window.

The following options display if you are on the Reminders sub-tab:

e Recalc: This option gets the latest data from the server to run the algorithm.
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e Refresh: This option refreshes the Reminders sub-tab by retrieving the most up-
to-date information from the server. This action is the same as pressing F5.

e HIV/AIDS Management Guide: This option displays the iCare Population
Management GUI window for online help.

3.13 Referrals Tab
The Referrals tab displays the referrals for the selected patient in the time range
shown in the Last field. This data comes from the Referral Care Information System
(RCIS).
/ Referrals |
Lasti[Evee 7] W ENAR DD
7 Wi3edDae 7 eend Provider 7 Pupose of Referal 7 OusdeVerde 7 EpectedBegnDate 7 chial Agci Date 7 Rdfen =
e (15, 20X ADENDOSIN ASHEVILLE dgx 20, 2007 CHS
STAGE 4 CxD fge 18, 2007 CHS
Now 13, 2006 Detndement of kel 2nd toe .:;4.‘ Nov 14, 2006 CHS
Figure 3-68: Sample Referrals tab
The default display is in reverse order of date, with the most recent first.
3.13.1 Referrals Tab Layout

The data comes from the RCIS (Referred Care Information System). You can review
the user manual at the following URL:

https://www.ihs.gov/rpms/packagedocs/BMC/bmec_040u.pdf

Select Referred Care Information System from the list. On the next page, select the
User Manual.

You can sort/filter the columns and perform other functions on the columns. Table
3-5 provides information about the fields.

Table 3-5: Referrals tab fields and descriptions

Field Meaning

Initiated Date

The date that the referral was initiated.

Referral Provider

The provider who requested the referral for the patient.

Purpose of Referral

This is a narrative that describes the purpose of the referral.

Outside Vender

This is the name of the Outside vendor, such as outside
providers, clinics, hospitals, labs etc. This information comes from
the RCIS application.

Expected Begin Date

This applies to outpatient visits that is the expected begin date of
service.
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Field Meaning

Actual Appt Date The date that the appointment for the referral was scheduled for
this patient.

RCIS Status The RCIS status of the referral.

Referral Type The type of referral that was made. This can be any of the
following:

IHS: A referral to another IHS facility

CHS: A referral to an outside facility that will be paid for with CHS
funds

In-house: A referral to another clinical area within the facility
Other: Any other type of referral that will be paid with funds other
than CHS (such as Medicaid or private insurance)

Patient Type This is either inpatient or outpatient.

3.13.2 Referrals Tab Toolbar Options

The Last field determines the date range for the data. The default is one year. You
can select a different predefined date range.

Section 4.2 provides information about the buttons on the right side of the toolbar.

3.13.3 Referrals Tab Menus

The options on the File menu of the Referrals tab are the same as those on the File
menu for the Cover Sheet tab.

The options on Tools menu on the Referrals tab are the same as those on the Tools
menu for the Flags tab.

3.14 Consults Tab

The Consults tab displays the consults for the selected patient in the time range
shown in the Timeframe field.

BP Prompts ]/ Natl Measures SummySupp r Suicide Form ]
Cover Sheet r Snapshot rﬁl;s_r Reminders r Problem List r Orders m Referrals/y(onsnlts ]/m Care Mgmt m DX Tags r Family HX ]
Timeframe: - ) ﬁ:] 2 PENER
Consult Date W V| To Service W | From Location W | Sending Provider T | Status | Urgency W | Last Action W | Attention To | Reguest Type T
Sep 05, 2013 CHS CHART REVIEW - COMPLETE ROUTINE EZTOMPLEFE-'UPD Consult
Sep 05, 2013 CHS CHART REVIEW - COMPLETE ROUTINE :C‘_?MPLEFE-'UPD Consult
 May 30,2012 cHs weeeneral (D COMPLETE  ROUTINE ETOMPLEFE-'UPD Consuh
CHS WC GENERAL - COMPLETE ROUTINE chnéwPLErE-'UPD Consult
CHS weeenera (D COMPLETE  ROUTINE ?_i[)éwPLEFE-'UF'D Consul
Jun 24, 2010 CHs TRAMP o CANCELLED ROUTINE CancELLED _ Consult
Jun 08, 2009 CHS GENERAL CLINIC - CANCELLED ROUTINE CANCELLED — Consult
€ >

Figure 3-69: Sample Consults tab
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The default display for the consult date is in reverse order, with the most recent
consult date first.

3.14.1 Consults Tab Layout

You can sort, filter, and perform other functions on the columns. Table 3-6 provides
information about the fields.

Table 3-6: Consults tab fields and description

Field Meaning

Consult Date The date of the consult.

To Service The in-house service the consult is for.

From Location The location creating the consult.

Sending Provider Provider who initiated consult.

Status The status of the consult.

Urgency What the urgency of the consult is.

Last Action The last action taken on the consult. Actions are:

ADDED COMMENT
ADDENDUM ADDED TO
ADMIN. CORRECTION
CANCELLED
COMPLETE/UPDATE

CPRS RELEASED ORDER
DISASSOCIATE RESULT
DISCONTINUED

EDIT BEFORE RELEASE
EDIT/RESUBMITTED
ENTERED IN CPRS
FORWARDED FROM

FWD TO REMOTE SERVICE
INCOMPLETE RPT

INITIAL REMOTE REQUEST
NEW NOTE ADDED
PRINTED TO

RECEIVED

REMOTE REQUEST RECEIVED
SCHEDULED

SERVICE ENTERED

SIG FINDING UPDATE
STATUS CHANGE

UNKNOWN ACTION
Attention To To whom the consult is intended for.
Request Type The type of request. Can be Procedure or Consult.
Patient Type This is either inpatient or outpatient.
Consult Number The unigue number assigned to each consult.
Location The location where consult occurred.
Ordering Facility The facility from whom the consult is being ordered.

Place of Consultation | This is the place where the consultation will take place.

Provisional Diagnosis | This is the Provisional Diagnosis the ordering clinician would
specify on the Consult Form 513.

Associated Results This is the reason for requesting the Consult or Procedure
Request. (Word-processing field).
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3.14.2 Consults Tab Toolbar Options

The Timeframe field determines the date range for the data. The default is one year.
You can select a different predefined date range.

Section 4.2 provides information about the buttons on the right side of the toolbar.

3.14.3 Consults Tab Menus

The options on the File menu of the Consults tab are the same as those on the File
menu for the Cover Sheet tab.

The options on Tools menu on the Consults tab are the same as those on the Tools
menu for the Flags tab.

3.15 Orders Tab

The Orders tab displays the order information for the current patient.

Consuts | PCC | CareMgmt | CMET | DXTags BPPrompts | NotlMeasures | SummjSupp | Suicide Form

CoverSheet | Snapshot | Flags Family HX.

Timeframe: ) vEZIANEI

7| ltem Ordered V|StriDale  V|SiopDate ¥
SIMVASTATIN TAB 7 01
ZZPOCNR

TIOTROPIUM 18MCG CAPINHL
amLODIPine TAB

METOPFROLOL SUCCINATE TAB,SA
CETIRIZINE TAB
LEVOTHYROXINE TAB
SIMVASTATIN TAB

7 [Order Group

GUTPATIENT MEDICATIONS

CHEMISTRY

OUTPATIENT MEDICATIONS
QUTPATIENT QUTPATIENT MEDICATIONS
OUTPATIENT A OUTPATIENT MEDICATIONS
OUTPATIENT ~ COON.LILA OUTPATIENT MEDICATIONS
OUTPATIENT ~ COON.LILA OUTPATIENT MEDICATIONS
DISCONTINUED! Nar 14,2014 QUTPATIENT ~ COON.LILA QUTPATIENT MEDICATIONS

7| Date Enter. ¥ 7 | Entered By 7| Class
4 OUTPATIENT

OUTRATIENT
OUTPATIENT

RIN TAB
RIN TAB
EMIDE TAB
ZZPOC-INR

QUTPATIENT ~ COON.LILA QUTPATIENT MEDICATIONS
OUTPATIENT ~ COOM.LILA OUTPATIENT MEDICATIONS
OUTPATIENT ~ COON.LILA OUTPATIENT MEDICATIONS
OUTPATIENT ~ COON.LILA CHEMISTRY

COMPLETE Oct 17,2014

Figure 3-70: Sample Orders tab

The default display is in reverse date entered, with the most recent first.

3.15.1 Orders Tab Layout

You can sort, filter, and perform other functions on the columns. Table 3-7 provides
information about the fields.

Table 3-7: Orders tab fields and description

Field Meaning
Order Number The order number.
Status This is the status of the order.
Date Entered The date/time when this order was entered.
Entered By The user who entered the information about the order.
Class The patient’s classification for the order; inpatient or outpatient.
Provider The person who is responsible for the order.
Order Group This is the service to which the order is referred.
Order Dialog This is the dialog that created this order.
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Field Meaning
Item Ordered This is the actual item (test, procedure, diet, drug, etc.) being
ordered from the Orderable Items file.
Start Date This is the start date/time of the order.
Stop Date This is the stop date/time of the order.
3.15.2 Orders Tab Toolbar Options
The Timeframe field determines the date range for the data. The default is one year.
You can select a different predefined date range.
Section 4.2 provides information about the buttons on the right side of the toolbar.
3.15.3 Orders Tab Menus
The options on the File menu of the Orders tab are the same as those on the File
menu for the Cover Sheet tab.
The options on Tools menu on the Orders tab are the same as those on the Tools
menu for the Flags tab.
3.16 DX Tags Tab
The DX Tags tab displays the diagnostic tags information for the current patient.
Diagnostic Tags are Predefined Diagnosis definitions (“tags™) that iCare has proposed
for this patient, based on the tagging function. The display includes the relevant
qualifying criteria data.
o corerignt | Referraks F (0% Tags|| Famiy i | tictes | sucdeFom |
*" Coves Sheet | Snapshot | Flags | Reminders | 59 Fromets | hatiteaswes | T | sumeysupe | pcc | problemust |
| @ x } g A | = Ty
Riecak | Booept Mot Accent Ps:-::rsa .ﬂ.ljd_Tj-su | Acthvity | & W9 EHED DL
Patient Diagrostc: T ags data curment as of Apr 19, 2013 07:23AM _
| Toghame « | Stabus 7| Date 7| ttem ?lw-.g 7| Factx v
y | Asihma PROPOSED Mag 19 2000 Wisk POV. 43350 BGP ASTHMA (45
. wn 07,1934 Visi POV: 49350 BEP ASTHMA [XS
| EOFD PROPOSED M2 2000 Vs POV: 435 BGP COPD DxS
ml Apr 2713 Vi POV: 435 RGP COPD DS
| OWD At Fisk ACCEFTED fge T8
Figure 3-71: Sample DX Tags tab
Providers can review tags that were automatically assigned by the system, and then
decide whether to accept the tags as valid for the patient.
This tab displays the Active tags for the patient, i.e., those tags having the Proposed
or Accepted status.
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3.16.1 DX Tags Tab Layout

The data columns are described in Table 3-7.

Table 3-7: DX Tags tab columns and descriptions

Column

Meaning

Tag Name

The diagnostic tab name. You can view the tooltip by hovering your
mouse over this column (shows the definition of the tag).

Status

The status of the tag. You can view the tooltip by hovering your mouse
over this column.

ACCEPTED: This means the patient is a member of specified formal case
management registers with a status of Active, Decease, Transient, Non
IHS, Lost to Follow Up, or Noncompliant.

PROPOSED: This means the patient has Status Un-reviewed or Inactive
in the register.

NO LONGER VALID: This means the RPMS data no longer supports the
tag.

Date

The date associated with the tag.

Item

This is where the tag was found (Visit or Problem).

Value

The value for the tag. The text that precedes the value determines what
that value represent. For example: Problem: 250.00.

Factor

This is defined through the Taxonomy listed or other (like BMI).

Double-click any underlined date to access the Visit Detail dialog.

Double-click any underlined Factor to access the iCare Taxonomy View/Edit
window. Section 4.8 provides information about this window.

3.16.2 DX Tags Tab Toolbar

The patient diagnostic tags are current as of the date shown on the toolbar.

Section 4.2 provides information about the buttons on the right side of the toolbar.

3.16.3 Recalc

P

Click the Recalc (! Rk ) button (or select Diagnostic Tags | Recalc) to update any
values from a logic algorithm by recalculating the logic with new data from the

SCrver.

3.16.4 Change the Tag Status

You can change the tag status by clicking the Accept, Not Accept, or Propose button
(or selecting the options on the Diagnostic Tags menu). This action causes the
Update Diagnostic Tag dialog to display where you can change that tag status, select
the reason for the change, and populate the Other (Free Text) field. Section 3.12.1.2
provides information about this dialog.
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When you are finished with this dialog, click OK to accept the changes. (Otherwise,
click No.). You can view your changes in the grid of records on the DX Tags tab.

3.16.5 Add Tag
Click the Add Tag (L2475 ) button (or select Diagnostic Tag | Add Tag) to add a tag
to the current patient. The Add Diagnostic Tag dialog will display. This step is a
manual add that allows a provider to manually assign one or more of the diagnosis
tags to patients that did not meet the tag’s criteria for being proposed automatically.
Section 3.12.1.2 provides information about this dialog.
3.16.6  Activity
You can view existing tag activity about the patient by doing one of the following:
a
e Click the Activity (L% |) button
e Select Diagnostic Tags | Activity
The RPMS iCare - Diagnostic Tag Activity dialog displays. This window is a view-
only dialog. Multiple people can enter the tags, so this dialog shows all the activity.
Section 3.12.1.4 provides information about this dialog.
3.16.7 Background Jobs
Click the Background Jobs («5') button to display the Background Jobs dialog.
Section 4.11 provides information about this dialog.
3.16.8 DX Tags Tab Menus
The options on the Diagnostic Tags menu operate like the action buttons on the
toolbar.
The options on File menu on the DX Tags tab are the same as those on the File menu
for the Cover Sheet tab.
The options on Tools menu on the DX Tags tab are the same as those on the Tools
menu for the Reminders tab.
3.17 Family HX Tab
The Family HX tab displays any family history information about the patient.
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NATURAL MOTHER ~ familyhistory mother r DECEASED Atage 4049 Sep 15, 2014

NATURAL BROTHER Jack

NATURAL BROTHER JOE

NATURAL Jane
DAUGHTER

GRANDFATHER Bob

of melignan
neoplasm,

unspecified

Z83.3-Family history FH: Diabetes melltus |
of diabetes mellitus

782 49-Family hxof  FH: Hypertension |
ischem heart dis and
oth dis of the circ sys

Z84.0-Family history FH: Eczema |
of diseases of the
skin, subcu

Figure 3-72: Sample Family HX tab

780.9-Family history  Family history of cance
f t |

YES, IDENTICAL
TWIN

LIVING Jan 07, 2014

DECEASED At age 40-49 YES, IDENTICAL
TWIN

LIVING Jan 07, 2014

DECEASED At age 50-59 Emphasema Jan 07, 2014

This information comes from the Family History of the PCC patient record.

3.17.1

Family HX Tab Layout

You can sort, filter, and perform other functions on the columns. Table 3-8 provides a

description of the columns.

Table 3-8: Family HX tab columns and descriptions

Column

Meaning

Relative

This is the family history relationship, such as Brother.

Relative Modifier

This is the relative description, if any.

Diagnosis Code

This is the family history ICD code that best describes the
diagnosis of the relative.

Diagnosis Narrative

This is the provider narrative that the provider entered.

Age of Onset This is the age of onset of the condition. This can be In Infancy,
Before Age 20, a specific age range (such as 30-39), or Age
Unknown.

Status This is the status of the relative: Living, Deceased, Unknown,

Patient Refused To Answer.

Age at Death

If the status is Deceased, this is age of death of the relative.

Cause of Death

If the status is Deceased, this is the cause of death of the
relative.

Multiple Birth

This determines is there was a multiple birth: Yes, No, Unknown.

Provider

This is the provider for this record.

Date Last Modified

This displays the date the record was modified (system
populated).

3.17.2 Family HX Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.
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3.17.3 Family HX Tab Menus

The options on the File menu of the Family HX tab are the same as those on the File

menu for the Cover Sheet tab.

The options on the Tools menu of the Family HX tab are the same as those on the

Tools menu for the Flags tab.

3.18 Notes Tab

The Notes tab displays the existing TIU notes for the current patient.

Family HX r BF Prompts r MNatl Measures r SummySupp r Suicide Form l

Cover Sheet r Snapshot | Flags Reminders r Problem List rOrda‘S/yNotﬁr Referrals r Consults PCC | CareMgmt rCMEI' rDXTags l

View Notes | Print Notes  Time Frame: v

Class W | Title W | Subject

CLINIC_ND  PATIENT_LETTER

» TES
CLINIC_NO  PRENATAL CARE NOTE-BRIEF
TES

CLINIC_NO - CHART_REVIEW

TES

CLINIC_NO  PRENATAL CARE NOTE-BRIEF
TES

Figure 3-73: Sample Notes tab

3.18.1 Notes Tab Layout

Y 516 M 3G

¥ | Date of Note % | Author ¥ | Status \
PHONE CALL novos 20200626 (D COMPLETED
wnzzovosszan (D coveemeo
Mar 06, 2018 09:25 AM _ COMPLETED
Jan 11,2018 02:34 PM G oo

The sort order is only by date, with the most recent date first. Table 3-9 provides

information about the fields.

Table 3-9: Notes tab fields and descriptions

Field Meaning

Class The class of the note.

Title The title of the note.

Subject The subject of the note.

Date of Note The date/time the note was written.
Author The person who wrote the note.
Status The status of the note.

If you double-click a record in the grid, the application displays a dialog showing

information about the note.
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TITLE: OUTSIDE REFERRALS

DATE OF NOTE: DEC 11, 2008 ENTRY DATE: DEC 23, 2008811:02:12
avtHor: I =P COSIGNER:
URGENCY: STATUS: COMPLETED

SANITIZED REPORT TEXT
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Signed: 12/23/2008 15:41

Figure 3-74: Sample note dialog

Section 4.6 provides information about using the controls on the dialog.

3.18.2 Notes Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.

You can determine the time range for the notes by selecting an option from the Time
Frame list (the default is one month).

3.18.3 View Notes

Use the View Notes function view the text of one or more selected notes in the grid.
Click View Note (or selecting Notes | View Notes) to access the View Notes dialog
with TIU headers and footers.

Lol

B

N A LD " 3
Find Font Copy Prink Preview... Print...

TITLE: ER NURSE ASSESSHMENT

DATE OF NOTE: JAN 24, 2010008:38 ENTRY DATE: JAN 24, 2010008:38:24
URGENCY: STATUS: CONPLETED

SANITIZED REPORT TEXT

fes/ [XeX7[\\7e\cife
ie
Signed: 01/24/2010 08:49

Figure 3-75: Sample View Notes dialog

Section 4.6 provides information about using the controls on the dialog.
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3.18.4

3.18.4.1

3.19

Print Notes

Use the Print Notes button to print the selected notes without TIU headers and
footers. Highlight one or more selected notes from the grid and click Print Notes (or
select Notes | Print Notes). The application displays the notes in the Print Preview
dialog. Section 4.12 provides information about this dialog.

Each note (when using more than one note) will start on a new page.
You can print the contents on the Print Preview dialog by selecting File | Print.
The output will contain the date and time it was printed.

Notes Tab Menus

The options on the Notes menu operates like the View Notes and Print Notes
buttons.

The options on the File menu of the Notes tab are the same as those on the File menu
for the Cover Sheet tab.

The options on the Tools menu of the Notes tab are the same as those on the Tools
menu for the Flags tab.

Suicide Form Tab

The Suicide Form tab only displays for users who been assigned specific Behavioral
Health (BH) permission keys. These keys are assigned through BH only, not through
iCare User Access Management.

CMET I/D)(Tags rFamin Hx ]/ BP Prompis r Matl Measures l/ Summ;"Supp/Suicide Form
Cower Sheet r Snapshot rFlags ]/ Reminders r Problem List rOrda‘s rNota r Referrals Consuls | PCC [ CareMgmt I

. DEEY-TEEY
| Date ot Act ¥ 7| SucdslBehavie 7| Method V| UseiCiested 7| DatsCrested 7| UseeLastModhed 7| Date Lay

Mar 12, 2001 ATTD SUICIDE W/ HANGING | IRl I Ape 15, 20
» ATTD HOMICIDE

Figure 3-76: Sample Suicide Form tab

This tab displays the data from the existing Suicide Reporting Forms (SRF) for the
patient.

Double-click any record in the grid to access the Suicide Form Detail.
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RPMS iCare - - Suicide Form Detail =10] x|
Fin

B A G ol

=
Find Font Copy FPrink Preview... Print...

Jzr2zrs2222 CONFIDENTIAL PATIENT INFORMATION [SJT] Apr 28, 2011 ftrszrrses =
Suicide Reporcing Form Dacte Printed: Apr 28, 2011

1. caze #: NG Local Case #:

. provIDER INITIALS: NN 3. PROVIDER DISCIPLINE:

o
4. SEX: FEMALE s. oos: arr [N 6. AGE: 56
7. EMPLOYMENT STATUS: UNKNOWN

8. DATE OF ACT: APR 15, 2011

S. TRIBE: EASTEREN BAND OF CHEROKEE IND, NC

10. COMMUNITY OF RESIDENCE: WOLFTOWN

11, COMMUNITY WHERE ACT OCCURRED: ZIA

=

Figure 3-77: Sample Suicide Form Detail dialog

Besides the patient demographic information, this dialog displays data in the fields on
the SRF. Section 4.6 provides information about using the controls on the dialog.

3.19.1  Suicide Form Tab Layout

You can sort, filter, and perform other functions on the columns.

Date of Act: The date of the suicide act.

Suicidal Behavior: This is the type of suicidal activity for the suicide act.
Method: The method used in the suicide act.

User Created: The name of the provider who created the record.

User Last Modified: The name of the provider who last modified the record.

Date Last Modified: The date the record was last modified.

3.19.2 Suicide Form Tab Toolbar

Section 4.2 provides information about the buttons on the right side of the toolbar.

3.19.3 Suicide Form Tab Menus

The options on the File menu of the Suicide Form tab are the same as those on the
File menu for the Cover Sheet tab.

The options on the Tools menu of the Suicide Form tab are the same as those on the
Tools menu for the Flags tab.
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4.0 iCare Features Used by Patient Record

The following provides information about using the iCare features for the Patient
Record.

4.1 User Preferences

This section focuses on the user preferences that are used by the Patient Record

window.
85 RPMS iCare - User Preferences = =] 3
Define My Patientsr Flag Setup r Comm Alert Setup r/ Startup View r Patient View r Panel View r Layouts rﬁm

Select the definition that best describes your patient assignment. NOTE: Many users do not have patients assigned to them and will choose
"No Provider Selectad”. This will not negatively affect your ability to fully use the iCare application.

[+ NoProvider Selected

Provider Type
[ ~| I~ pece

|~ Specialty Provider  Speciay
Type:

Edit

Min # of Visits in Timeframe
[ Primary Visit Provider

[ Primary/Secondary Visit Provider

OK ] | Cancel

Figure 4-1: Sample User Preferences window

After the User Preferences window is complete, click OK and the user preferences
will be in effect for the operation of the iCare application. (Otherwise, click Cancel.)
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411 Patient View Tab

otl RPMS iCare - User Preferences — O X
Define My Patients r Flag Setup r Comm Alert Setup r Startup V\ew/é Patient \ﬁewér Panel View r Layouts | CMET [ IPC
Select the tabys) you want fo display when opening the iCare Fatient Record Select the defaulf Locations fo be associated with the following
clinic codes. These seffings must be defined in order fo creafe
View Size: ¥ Normal " Maximized TIY documnents and add chart reviews througt iCare.
Tabs
£ | Show/Hide | Starting Tab
Best Practice Prompis ~ ] Followup Letter Clinic Location:
Care Mgmt O [PALETTER ~|
CMET O Telephone Call Clinic Location:
Consults 0 [PA PHONE CALL =
Cover Sheet — =
Diagnostic Tags 0o Chart Review Clinic Location:
Family HX 0 [PA CHART REVIEW ~|
Flags O
Natl Measures O
Notes [
Orders O
PCC O
Problem List O
Referrals O
Reminders O
Snapshot O
Summ/Supp [l
Carce

Figure 4-2: Sample Patient View tab

The selections on the Patient View window determine the following: which tabs
display, the startup tab that displays when you first access the Patient View window,
the view size, and the default location to be associated with various clinic codes.

Tabs: Use the Show/Hide column to determine which tabs display in a panel.
Checking will display the selected tab. The Starting Tab column sets which tab is
initially displayed when a panel is opened. At a minimum, one tab must be checked
as Show and set as the Starting tab.

View Size: Determine the view size and select either the Normal or Maximized
option button (the default is Normal).

Note: The default clinic codes are necessary when you use the
Add a Note button on the Patient Record window.

Follow-up Letter Clinic Location: Select a clinic code from the list for TIU
documents.

Telephone Call Clinic Location: Select a clinic code from the list for telephone
calls.

Chart Review Clinic Location: Select a clinic code from the list for chart reviews.
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4.2 Buttons on the Right Side of Window
The buttons on the right side of any iCare window have the same functionality on any
window.
ENT AL R R
Figure 4-3: Buttons on right side of window
These buttons might not be visible; in that case, click the list (&) button.
The application provides hover help for each button.
Some iCare windows might not have the Mail Merge and Glossary buttons.
421 Reset View
Click the Reset View (|)) button (or select Tools | Reset View) to return the current
view to the default view. You use this feature when you change the view, such as
resize the column width. This is the same as pressing Ctrl-R.
4.2.2 Refresh
Click the Refresh (fl) button (or select Tools | Refresh) to update any RPMS field
values on the current window with new data from the server. This action is the same
as pressing F5.
4.2.3 Search
You can search for data in the current grid by clicking the Search (|ﬁl) button (or by
selecting Tools | Search or pressing Ctrl-F) to display the Search dialog.
=i
FindWhat | H FindNewt |
[ | Show Additional Search Options Clote I
Figure 4-4: Search dialog
If you do not select the Show Additional Search Options check box, the search will
check in all columns for a match.
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If you select the Show Additional Search Options check box, the Search dialog will
display more options for the search.

[C—— Rk
FindWhat | = | FindNent |
¥ Show Addtional Search Opbions Claze

Look I [0 conamee =]
Mach | sryPan0iField =l
Seach |5 | ™ MatchCaze

Figure 4-5: Search dialog with additional search options

Type what you want to search for in the Find What Free Text field. The remaining
fields (Look In, Match, and Search) determine the search criteria.

If you check the Match Case check box, that will cause the search to match the case
of the text in the Find What field.

4.2.3.1 Look In Field

Click the list for the Look In field to view the options for that field. The highlighted
option determines what part of the window to search.

Dvarver
Parel N arme
Parel Descrplion

# of Ptz
DEF_LAST_UPDATED_BY
PAT LIST UPDATED BY =

Figure 4-6: Sample list options for Look In field

The highlighted selection in the upper part of the list determines the options in the
lower part of the list. For example, if the Look In field contains All columns, the list
of the column names will appear in the lower part of the list.

4.2.3.2 Match Field

Click the list for the Match field to view the options for that field. The highlighted
option determines what part of the Find What field will be matched in the search.

bura P ant 0 Fhely
A artliFeeid

Searcht  [wholeField

Figure 4-7: Sample Match field options
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4.2.3.3 Search Field

Click the list for the Search field to view the options for that field. The highlighted

option determines the direction of the search.

Search: IE - |

Diowan
L

Figure 4-8: Sample Search field list options

After all fields are populated with the search criteria, click the Find Next button.

(Otherwise, click Cancel.)

If a match is found, the matching text will be highlighted (in the grid). If you want to

continue the same search, click the Find Next button again; repeat this process as

needed.

If a match is not found, the Datagrid Search Results message displays.

%

Mo other oocurrences of ‘wads' wers Fourd.
ok ]

Figure 4-9: Sample Datagrid Search Results

Click OK to close the message and to return to the Search dialog.
4.2.4  Exportto Excel

You can export the information in the window to Excel by clicking the Export to

Excel (@) button (or by selecting Tools | Export to Excel or pressing Ctrl-E).

The application displays the warning message about the export.

=
Wi are preparing bo export confidential patient data from the RPMS sarver bo a local compuber. Plaass be aware of
g your site’s polickes sbout storing patient data,
Do o watsh ko continue?

Figure 4-10: Warning message about exporting the patient data

Click No to dismiss the warning and exit the export process.

Click Yes to continue the export process and to display the Save As dialog.
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Saveas 2| x|
Savein | x| «e®BsE-

My Documents

”

My Compustar

B saveartpe  [Evcel pUS) Fiks

E1REN

»
Save I
Ji= 151

Figure 4-11: Sample Save As dialog
Make sure the location where you want to save the file displays in the Save in field.

Type the name in the File name field. The system will add XLS extension to the field
name (automatically).

Click Save. (Otherwise, click Cancel.) If you click Save, the Export Panel message
displays: Excel export has been created. Click OK to dismiss the message.

When you view the Excel document, the application provides a Confidential Patient
Information header in the document.

42.5 Print
You can print the selected rows in the grid by clicking the Print ( button (or by
selecting Tools | Print or pressing Ctrl-P) to access the Print Preview dialog.
Section 4.12 provides information about using this dialog.
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4.2.6

4.2.7

5 Print Preview El@@

CONFIDENTIALPATIENT
Panel
¥ 7 Pared Hame T Panel Diescription v #oPy

L 4 s PM pls bor ackhing

P clhabsti: pite ovver 40

¢ G E ¥

Chck and drag bo scroll page cordents Page: 1 of 1

Figure 4-12: Sample Print Preview dialog

If you do not select any rows, the application displays a warning message: You have
not selected any rows to print. Do you want to proceed and print all rows in this
view or cancel this print? Click Yes to print all the rows. Click No to cancel the
print function.

Copy to Clipboard

You can copy the selected rows in the grid to the Windows clipboard by clicking the
Copy to Clipboard (i:'-JJ) button (or by selecting Tools | Copy Rows to Clipboard or
pressing Ctrl-Shift-C). You can paste the contents of the Windows clipboard to any
Windows application.

Mail Merge

The iCare application provides the capability to export patient demographic data in a
format that can be used by word processing mail merge files. This step is a
Demographic Data Export for Letter Generation function. Follow these steps:

1. Select one or more patients that you want to include in the mail-merge process.

2. Click the Mail Merge Export (\=1) button (or select Tools | Mail Merge) to
display the Mail Merge Export dialog.
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ST
Fis [Ede  Took
=3
)
Neme 7| AddessLne1 ¥ | Addessiine2 ¥4l Addesslne3 V4| Gy V| Staie 78| Zpcode 78] Home Phone
ALFHA THETA 451 SPRIMGFIELD WL i T
[ BETATHETA  2AVE SPAINGFIELD N mn 555 555 55
[ ICHITHETA  SavE SPAINGFIELD  HC T S5 555 5
[ GAMMA THETA 14VE SPAINGFIELD  HC 1 SEEER BERE
KT | |

Figure 4-13: Sample Mail Merge Export dialog

Section 4.2 provides information about the buttons on the right side of the toolbar.

|
3. Click the Mail Merge Instructions ( msnees ) button to display the Mail Merge
Instructions dialog. This dialog provides the instructions for completing the mail
merge process.

E RPMS iCare - Mail Merge Instructions

iCare Mail Merge Taxonomy 2

The 1Care Mal Merge feature allows users to export patient names, addresses, and phone numbers to an
Ezecel fle for later use m creatmg letters, labels, envelopes, or emal messages. The Bollowng instructions
pertain to hMicrosoft Office 2003,

Export Patient Mailing Information from iCare

Select the patients on an open 1Care panel

Chck the Mail Merge Export button

In the hal Merge Export window, select the patients and chel the Export to Excel button.
Chek Yes.

In the Save Az window, click the arrow next to the “Save In" field.

Select "Wy Documents” from the drop-down mem.

Double click the “My Data Sources” folder.” "My Data Sources™ folder gets posted to “Idy
Documents” falder automatically when you have previously merged mail in M3 Word.

Type a File Mame.

Chck Save.

L

]

Figure 4-14: Mail Merge Instructions dialog

Note that you can print the contents by clicking the Print button or by selecting File |
Print.

See Section 4.6 for more information about how to use the controls on the dialog.
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4.2.8 Glossary

Click the Glossary (/) button (or select the glossary from the Help) to display the
Glossary dialog. The name of the glossary dialog varies according to the part of iCare
that you are using. For example, if you are on the Reminders tab, the Reminders
Glossary dialog will display.

4.3 Edit Patient Demographics Fields

F Edit patient demographic fields =101 x|
Eie Help
Add/Echt
Home Phomne: 555055976 Work Phone [es5aws1872
Alternate Phone [ Humber in Household |2
Ethnicity: | ﬂ Method of Collection™ I d
Race | ]
Preferenos | .ﬂ Email
Prefened Language: | j
Cancel

Figure 4-15: Sample Edit patient demographic fields dialog

4.3.1 Fields on Edit Patient Demographic Fields Dialog

The field name followed by an asterisk (*) is required. Any field that is inactive on
this dialog cannot be changed.

Phone: Populate the phone fields with the appropriate number, using 4-60 characters.

This applies to the patient’s Home Phone, Work Phone, and Alternate Phone
fields.

Number in Household: Populate with the number of people in the household.

Ethnicity: Use any option on the list to define the patient’s ethnicity. After
populating this field, the Method of Collection field become active.

Method of Collection: Use any option on the list to define the method of collection
for the ethnicity.

Race: Use any option on the list to define the patient’s race.
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Communication Preference: Use any option on the list to define the preferred means
of communication, for example, email.

Email: Populate with the patient’s email address.

Preferred Language: Use any option on the list to define the patient’s preferred
language.

4.3.2 Menus on Edit Patient Demographic Fields Dialog
Use File | Close to dismiss this dialog.
The Help menu has two options.
e iCare Help: Use this option to access the online help for the dialog. This action is
the same as pressing F1 your keyboard.
e About iCare: Use this option to review the iCare version and other information.
4.4 Add a Note Dialog
The following provides information about using the Add a Note dialog.
-0l
Ele Help
Clinic":
Category: CHART REVIEW
Locatior CHART REVIEW
Provider
Narrative: iCae Chart Review
AddNote: Create I
0K | Cconce
Figure 4-16: Sample Add a Note dialog
The application automatically populates the Location field, the Provider field with
the current logged-in user, and the Narrative field.
Clinic: Select an option from the list that defines the clinic for the note. The options
are Chart Review (or record modification), Follow-Up Letter, or Telephone Call.
After populating the Clinic field, the application automatically populates the
Category field.
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Add Note: Click the Create button to access the Add TIU Note dialog. Section 4.5
provides information about this dialog.

The File menu (on the Add a Note dialog) has one option: Clese. This closes the
dialog (the same action as clicking the Cancel button).

The Help menu (on the dialog) has two options: (1) iCare help for this dialog (same
as pressing the F1 key) and (2) About iCare (displays information about the
application, such as the version being used).

4.5 Add TIU Note Dialog

The following information provides information about using the Add TIU Note

dialog.

When you click the Add Note button on the Patient Record window, the application

displays the Add a Note dialog. After clicking the Create button on the Add a Note

dialog, the application displays the Add TIU Note dialog.

=10 X
B
Y S ) X ,.|
Sl ! _ . : : Cose

"Document Tl

/-

lsm

vhom Templates? T

Figure 4-17: Sample Add TIU Note dialog

Both fields are required.

Document Title: Select an option from the list to establish the title of the TIU note.

Subject: Use this Free Text field to enter the subject of the TIU note. This field

becomes active after populating the Document Title field.

At this point, you can do one of the following: not use a template or use a template.
451 Note with No Template

When you do not want to use a template, and, after you populate the Document Title

and Subject fields, you can type the text of the TIU note in Free Text area on the

right side of the dialog.
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45.2

When the text is complete, the following buttons are active: Find, Font, Copy, Save
Note, Sign Note, and Close. Section 4.5.3 provides information about the buttons on

the dialog.

The following is an example of what happens after you click the Save Note button.

Note with Template

After you populate the Document Title and Subject fields, select the Show
Template? check box. This action shows the available templates that you can use.
(You will need to expand the Shared Templates option.) After you find the template
you want to use, double-click its name. The application will display the template.

~loj x|

Last syreploms reported  IEETHRIENN =|

Patient hasrat | been ssymptomatic for 48 hours.

Pabiert b mat I boer irested with 5 day course of antibictics.

Patient __ 12570 | concleted antkiotios reste than 4@ houes ago.

Ariibiobc stated  07/07/2010 »| and completed  07/07/2010 x|
e = i ..

|IT SXT DS - Take one tablet po BID for 5§ days

I Pedbatric: ST (40mg/200mg/Smi) Susp - Give [Smg/25mg/kg/dose] po BID for 5 days
I Levaqun S00mg po daly for 5 days

[ ZPack S0dg po day 1. then 250mg po dall for 4 dags

I Pedistic Ztheoman [100mgSml or 200mg/Smi] Susp - Give 12mg/%g po day 1. then
| Emgkg po dady for 4 days

|\I™ DOther:

Frewsw

0K

Coeel |

Figure 4-18: Sample Template

You can complete the template by using the buttons and check boxes on the template.

What you use on the template determines the text of the TIU note.

Click the Preview button (on the Template window) to preview the note in its current

state.
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4.5.3

B TemplatePreview (= E
Ele
i) Ad -3 J = )
Find Fonk Copy FPrint Preview... Print..
Last symptoms reported for pacient [N
Fatient has not been asymptomatic for 45 hours.
Patient has been treated with S5 day course of antibiotics.
Pacieant has not compléeted antibiotics greacer than 48 hours ago.
Antibiotic scarted and compleced

Pediatric SXT (40mg/Z00mg/Sml) Susp = Give ([(Swy/ZSmy/kg/do=e) po BID for S5 days

Figure 4-19: Sample Template Preview window with TIU note

What displays on the Template Preview dialog determines what will be in the text of
the TIU note. Section 4.6 for more information about using the controls on the dialog.
After you close (File | Close) the dialog, you return to the Template window.

After you have completed the Template window, click OK (otherwise, click Cancel).
The OK option returns you to the Add TIU dialog.

Buttons on Add TIU Note Dialog
Please note the following about the text of the TIU note:

e Line lengths should be less than (<) 80 columns (characters), otherwise, the line
spacing on the finished TIU note will not format correctly.

e The Find, Font, Copy, Print Preview, and Print buttons on this dialog work like
those on the dialog.

e You should adjust the font size before saving the TIU note, if needed.

Delete Note: Use this button to delete the current unsigned note. (This button does
not apply to signed notes.) Click the Delete Note button (or select File | Delete Note)
to access the Delete Note Confirmation: Do you want to delete the unsigned note?
Click OK to delete (otherwise, click Cancel). After clicking OK, the application
displays the message: Note Deleted successfully. Click OK to dismiss the message.

Save Note: Use this button to save the current note. After clicking this button, the
note is saved, and the Delete Note and Edit Note buttons become active.

Sign Note: Use this button to electronically sign the selected unsigned TIU note.
After clicking the Sign Note button (or selecting File | Sign Note), the application
displays the Enter Electronic Signature dialog.
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[ Enter Electronic Signature

Figure 4-20: Enter Electronic Signature dialog

Enter your electronic signature in the Free Text field and then click OK (otherwise,
click Cancel). After clicking OK, you return to the Add TIU Note dialog. The text of
the note shows that the note has been electronically signed.

ses/ I

Sigmed: 07/07/2010 18:0%9
Visic: Jul 07, 2010818:08 CHART REVIEW- Dx: CHET Chart Review

Figure 4-21: Sample electronic signature noted on text of TIU note

Edit Note: Use this function to edit/view the note. Click the Edit Note button or
select File | Edit Note) to display the text of the note.

|Thn patisnt iz wery allergic to rag waaed.

Figure 4-22: Example of text of the note

After you edit the text of the note, you can use the Save Note button again.

If you have already signed the TIU note, you cannot change the text; you can only
view the text.

Close: Use this button to close the Add TIU Note (for patient) dialog. Click the
Close button (or select File | Close) to close the dialog.

You return to the Add a Note dialog, with the Preview button next to the Add Note
field.
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~oix]
Fle Help

Clinic™: |CHART REV/REC MOD =~

Category: CHART REVIEW

Provider

Narrative: e t Heview

AddNote:

ok | come |

Figure 4-23: Sample Add a Note dialog with Preview button

Click the Preview button to display the text of the note.

B tetterPreview =loix|
Ele
N A LD " e )
Fnd Font Copy Print Preview... Pyint...

TITLE: PC NOTE ADULT
DATE OF NOTE: JUN 30, 2010812:18:24 ENTRY DATE: JUN 30, 2010812:18:24
AUTHOR: N— EXP COSIGNER:
URGENCY: STATUS: UNSIGNED
SUBJECT: CHET Testing 2345

You may not VIEV cthis UNSIGNED PC NOTE ADULT.
Visit: Jun 30, 2010812:18 CHART REVIEW- Dx: CHET Chart Review

Figure 4-24: Sample Letter Preview dialog

Section 4.6 provides information about using the controls on the dialog.

Close the dialog to return to the Add a Note dialog (with the Preview button on it).
After the Add a Note dialog is complete, click OK (otherwise, click Cancel).

After clicking OK, the application displays the Enter Electronic Signature dialog.

[® Enter Electronic Signature

Figure 4-25: Enter Electronic Signature dialog

Enter your electronic signature in the Free Text field. After completing the dialog,
click OK (otherwise, click Cancel).
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e If you enter an invalid electronic signature and click OK, the application displays
the Invalid Attempt information message that states: Invalid electronic signature.
Try again? Click Retry to return to the Enter Electronic Signature dialog. Click
Cancel and the application displays the message: Unable to save with a signed
note. Click OK to return to the Add a note dialog.

e If you enter a valid electronic signature click OK, the application displays the
information message: This data will be saved to the RPMS server. Do you
want to continue? Click Yes to save and to continue. Click No to not save and
leave the dialog.

Printing the TIU Note

When you click OK (on the Enter Electronic Signature dialog), the application
displays the Print TIU Notes information message.

‘__?/ Do youw wish bo print the newly created TIU notes at thes bime?

Figure 4-26: Print TIU Notes information message

Click Yes to print the TUI note. The application displays the Print Preview dialog.
You can print the TIU note from this dialog. Section 4.12 provides information about
the Print Preview dialog.

Click No to not print the TUI note. The application displays the Print TIU Notes
information message. This gives you a second time to print the TUI note.

Print TIU Notes X

9 WARNING:

“-'f') 1F you do not prink the newly created TIU notes at this time,
especially when batch processing, you will only be able to
reprint these nobes From the individual patient records.

Do you wish to prink the TIU notes at this bme?

v |

Figure 4-27: Print TIU Notes information message

Click Yes to print the TIU note at this time when batch processing. Otherwise, you
will only be able to reprint this note from the individual patient record.

If you click Yes, the application displays the Print Preview dialog. You can print the
TIU from this dialog. Section 4.12 provides information about the Print Preview.
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4.6

Dialog Functionality

In several places throughout iCare, you will view dialogs. For example, if you
double-click on any row in the Recent Visits group box on the Cover Sheet of the
Patient Record window, you will view a dialog.

E IHS iCare - THETA,ALPHA - Visit Detail

=101 %]

Version 2.9

e

Patient Name:

VISIT/ADMIT DATESTINE:
DATE VISIT CREATED:

Chart #:

Date of Birth:

Sex: M

Visic IEN: 326895
--------------- \I}ISIT fILE EEEEEEEEEEEEEE®

OCT 24, 1991Q12:13
OCT 24, 1991

TYPE: IHS
PATIENT NAME: |
LOC. OF ENCOUNTER: DEHNO INDIAN HOSPITAL :]

Figure 4-28: Sample Visit Detail dialog
You can take the following actions on this dialog:
e Navigate through the information by using the scroll bar.

#
e Click the Find (Q) button (or select File | Find) to access a search tool to find
data in the current window. This button works like the Search button.

Ad
e Click the Font (Iﬂl) button (or select File | Font) to display the Font dialog.

Fone 2| x|
Eont: For style:
[Couir e [Fogua
Regular
Itz
()} Edwardian Scipt ITC 1 [Bold
() Elephant Biold ltalic
) Engravers MT
() Eeaz BoldITC
() Evas Demi ITC =l
(- Effects | [ Sample
[ Stikeout
r U haBbYyZIz
Script
['w'estcrn 3

Figure 4-29: Font dialog
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4.7

Here you can change the font name, style, and size of the text in the dialog (applies to
all the text). In addition, you can add effects like Strikeout and Underline — these
perform like those effects indicated in MS Word.

Change the Script option if you need to the see the text displayed in another language
and that language pack is installed on the machine you are using. If the language pack
is not installed on your machine, the display does not change by selecting another
script.

Click OK to apply your changes to the text in the current dialog. These changes are
only effective for the current view of the dialog. (Otherwise, click Cancel.)

]
e Click the Copy (=) button (or select Copy option on the context menu or the
File menu) to copy the selected text to the Windows clipboard.

e Click the Print Preview (e :ml) button to view the Print Preview dialog. You
can print the contents of the dialog from this dialog. Section 4.12 provides
information about the Print Preview dialog.

=)
e Click the Print (le#]) button to display a print dialog where you specify the
printer to output the contents of the dialog, the page range, and number of copies.

The File menu contains the print actions (like the Print Preview and Print buttons),
the Page Setup function, the find and copy functions, as well as a Close function
(dismisses the dialog).

Edit Providers

When you edit the list of specialty providers for the patient, the application displays
the Edit Providers dialog (for the current patient).
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4.71

¥ tdt Proveders - -DEMO)

B Iodk Heb
ASV/E

Provader Category™

Specualy Provider Lt

4

Save & Close

|. Prowder Category l Provades Name

Provsder Name:

=101 x|

lrml[j
ook Crarger |

N E 4D

| Last Modified Date Last Modfied By

> | DESIGNATED PRIMARY PROVIDER
""" CANCER
| CASE MANAGER
| CHEMICAL DEPENDENCY
[ | DIABETES
| HIV CASE MANAGER
| HIV PROVIDER
| HOME CARE
| MENTAL HEALTH
| OB CARE
| PUBUIC HEALTH NURSE
| RENAL DISEASE
| SOCIAL SERVICES
| TEAM
| WOMEN'S HEALTH CASE MANAGER

<

Jul 26, 2007

Figure 4-30: Sample Edit Providers dialog

The Edit Providers window is divided into two areas:

e Add/Edit area has fields to add or edit a provider record.

e Specialty Provider List area lists the patient’s providers.

Section 4.2 provides information about the buttons on the right side of the Specialty

Provider List area.

Add/Edit New Provider

Move the cursor to the row of the Provider Category (in the Specialty Provider
List grid) where you want to add or edit the provider.

The Provider Category field (in the Add/Edit area) will show the provider category
that you select, for example, Cancer. This field is view-only.

You can add the provider for the category and click the ellipsis button to search for
the provider name (or initial) on the Table Lookup window.
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4.7.2

4.7.3

4.7.4

Select the provider name and click Select; this name populates the Provider Name
field (in the Add/Edit group box). Then click Apply Changes to move the data to the
Specialty Provider List group box.

Remove Provider Name

You can remove the provider for the category by first selecting the category (in the
Specialty Provider List grid). Then, click the ellipsis button by the Provider Name
field (in the Add/Edit area) to access the Table Lookup window. Click Clear and
the focus returns to the Edit Providers dialog. Then click Apply Changes to remove
the provider name from the Specialty Provider List group box.

If you have changes and do not click the Apply Changes button and try to navigate to
another provider category, the application displays the Commit changes?
information message that states: You have started to enter data in the data fields.
Do you want to commit these changes now?

e Click Yes to commit the changes and the focus returns to the Edit Providers
dialog.

e Click No to not commit the changes and the focus returns to the Edit Providers
dialog. This action removes the changes.

e Click Cancel and the focus returns to Edit Providers dialog. This action retains
the changes.

Save & Close Button

4
Click the Save & Close (l#=&%== ) button (or select File | Save & Close) to display

the Confirm save to RPMS information message. Click Yes to save all changed data
to RPMS (otherwise, click No). The Edit Providers window closes.

If you save the data, it will be reflected in the Provider group box on the Cover
Sheet tab of the Patient Record window.

File Menu on Edit Providers

The File menu options are as follows:

Save & Change: This action is the same as clicking the Save & Close button and
displays the RPMS information message. Click Yes to save the data to RPMS
(otherwise, click No). If you click Yes, the data populates the Providers group box
on the Cover Sheet of the patient record window.

Close: Use this option to close the Edit Providers dialog.
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4.7.5 Tools Menu on Edit Providers
The options on the Tools menu are Search, Export to Excel, Print, and Copy Rows
to Clipboard. These options perform like the buttons on the right side of the window.
Section 4.2 provides information about these buttons.
4.7.6 Help Menu on Edit Providers
The options on the Help menu are as follows:
iCare Help: Use this option to access the online help information about the Edit
Providers dialog. This action is the same as pressing F1.
About iCare: Use this option view the iCare GUI version information.
4.8 iCare Taxonomy Editor Function
The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that
person to read/edit iCare taxonomies.
Access the iCare Taxonomy View/Edit dialog by either selecting Tools | Taxonomy
Maintenance | View/Edit Taxonomy Entries (on the main iCare Tools menu) or by
double-clicking the Factor cell in the Active Diagnostic Tags group box on the
Snapshot tab of the patient record window.
ol iCare Taxonomy View/Edit z = = | O] |-
NOTE: Site populated taxonomies can only be edited by users with appropriale access.
Load Taxonomy ‘ | Hide Category ‘ | Clear Filter(s) o®
# aoros
= ADHD DRUGS ~
| Apply #HEISE
| Coding System Code Description
[ ViewReport of All Taxonomies | [ o || cancal |
Figure 4-31: Sample iCare Taxonomy View/Edit dialog
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Note: If you do not hold the security key, you can only view the
information on the dialog. The following information
displays: You do not currently have access rights to edit
taxonomies. In order to edit taxonomy entries, you will
need to have the iCare Taxonomy Editor security key
(BQIZTXED) added to your RPMS user account.

When you first access this View/Edit dialog, all parts of the tree structure will be
collapsed. Expand one of the tree parts to find the taxonomy you want to edit.

In general, select the taxonomy from the list in the left group box that you want to
view. This step causes the Add and Remove buttons to display in the right group box
of the dialog.

Please note that not all taxonomies can be edited. iCare will display a message on the
View/Edit dialog for these taxonomies. Site-populated taxonomies can only be edited
by users who have appropriate access.

The difference between the Apply and OK buttons is as follows:

The Apply button is used when adding more than one taxonomy value to the iCare
Taxonomy View/Edit dialog.

4.8.1  Add Taxonomy Values
Click the Add button to create values for a selected item in the left group box. The
application displays the Select Taxonomy Item dialog.
x|
[ Scancke I Find..
| Communiy Name | Counly | State | State County Commund... | Communiy Code
Cancel
Figure 4-32: Select Taxonomy Item dialog
Use the Search field to search for a taxonomy item. Highlight the item you want to
add and click Select. The application checks to see if it already exists.
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e Ifitalready exists, you will receive a warning message. Click OK to dismiss the
message; after clicking OK, you return to the iCare Taxonomy View/Edit
dialog.

e If'the item does not exist, it appends the selected item to the bottom of the list.

After you finish adding taxonomy values, click Apply to save your changes. If you do
not click Apply and try to move to another taxonomy or another part of the iCare
application, the Save Taxonomy changes? information message displays, asking if
you want to apply the changes now. Click Yes to apply the changes (otherwise, click
No).

You can repeat adding items to various taxonomies. When you are finished using the
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel).

4.8.2 Remove Taxonomy Values
If you want to remove one or more items from the list, highlight them and click
Remove. The Confirm taxonomy item remove message displays. Click Yes to
remove the items (otherwise, click No). You remain on the iCare Taxonomy
View/Edit dialog.

4.8.3 View Report of All Taxonomies Button
Click the View Report of All Taxonomies button to display the Taxonomy Report
dialog.
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=] RPMS iCare - Taxonomy Report

i oS - S

File

@ o G |
Find Font Copy Print Preview..

=
Print...

Report Run: Apr 16,
Where Run:
Generated by:

**% iCare Taxonomy Report *%¥

2013 DEMC HOSPITAL

i »

2015 10:34 BEM

Taxonemy Categery: COMMUNITIES

Name: ACC CHEME VALLEY 2008
Desc:

Coding System Code

Name: ACC PARKER MARCH 2009
Desc:

Coding System Code

Created:

Modified:
Description
CHEMEHUEVI VALLEY
NELSON

Mar 10, 2009

Created:
Modified:
Description
BIG RIVER
BELYTHE
BOUSE
ERRP
EHRENBERG
LRAKE HAVSU C
PARKER
PRARKER DAM
POSTON
QUARTZSITE
SALOME
VICKSBURG
VIDAL
WENDEN

Maxr 10, 2009

Figure 4-33: Taxonomy Report window

This dialog provides information about various Taxonomy Categories (listed in

alphabetical order).

See Section 4.6 for more information about using the controls on the dialog.
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4.9 Edit Reproductive Factors
¥ Edit Reproductive Factors - DEMOKATHIE { ) =101 x|
e tep
Add/Edk
LostMenstrual Period (NN =~ -~ Current Pregnancy Stotu | |
Lactation Stabus: | =
Contiaceptive Mothods:
) Add(F2) K Delete (Del)
Contiaception Method Date Contraception Method | Date Contiaception Method | Reason Discontinued Coerment
Definitive EDO: [ =] Documenting Provider el _|
EDD (LMP}: = =] Documenting Provider _|
EDD (Uhrasound} = = Documenting Provider e _]
EDD (Chnicol Parameters} |7 = Documenting Provide: =l
EDD (Method Unknown} [ B Documenting Provider : _]
ol [ Full Term Binths: [
Premature Batha: [ Abostions . S pont aneous [
Abostions, Induced [ E ctopec Pregnances [
Living Childsern [ Multiple Buths I
Age at Fust Menses: [ Age ot Fust Intercous se [
Age at Menopause | DES Daughtes Statux [ :I
oK Corcel |
Figure 4-34: Edit Reproductive Factors dialog
After completing the dialog, click OK to save the data. These values populate the
fields on the Reproductive Factors group box on the Snapshot tab of the patient
record window.
Otherwise, click Cancel. The application displays the Save to RPMS? dialog: Do
you want to save to RPMS now? Click Yes to save to RPMS. Click No to not save
any data to RPMS. Click Cancel to return to the Edit Reproductive Factors dialog.
49.1 Top Panel
duddE it
Last Menstiual Period I_ j Curtent Pregnancy 5 tabs: | :I
Lactation Status | E|

Figure 4-35: Top panel of Edit Reproductive Factors dialog
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Last Menstrual Period: Populate with the date of the patient’s last menstrual period
(required field).

Lactation Status: Select an option from the list that specifies the patient’s lactation
status.

Current Pregnancy Status: Select an option from the list that specifies the patient’s
current pregnancy status.

49.2 Second Panel
Comraceplive Methods:
(Y Add(FZ) X Delete (Del)
Contraception Method Diate Cortracephon Method EDMCMleHnﬂ-D-d | Reason Discontinued I Comment
Figure 4-36: The second panel of Edit Reproductive Factors dialog
Select one or more rows in the second panel to delete and click Delete. The Delete
Rows information message displays asking if you want to delete the selected rows.
Click Yes to delete or No to not delete.
Click Add to add addition information about the patient’s contraceptive methods.
The Contraception Method and Date Contraception fields in the new row have
lists to populate these fields.
The Reason Discontinued is a Free Text field where you type the reason for
discontinued contraceptive method.
The Comment is a Free Text field where you type any comments about the
contraceptive methods.
4.9.3  Third Panel
Definitive EDD: [ = Documenting Provider - _|
EDD [LMP): [ = Documenting Provider 4|
EDD (Ulrasound} [ =] Documenting Provider )|
EDD [Clinical Parameters) | | Documenting Provides ) _I
EDD (Method Unknown} | = Documenting Provider ) |
Figure 4-37: The third panel of Edit Reproductive Factors dialog
The third panel provides information about the estimated date of delivery (EDD).
These fields become active if the Current Pregnancy Status field is set to Yes.
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If you populate any of the EDD fields, the Documenting Provider area becomes
active. To populate the Documenting Provider, click the ellipsis button to access the
Table Lookup dialog where you can search for the provider’s name. Highlight the
name to use and then click Select. The selected provider name will replace the
{none} text next to the ellipsis button.

Click Clear (on the Table Lookup dialog) to clear the name of the documenting
provider on the third panel.

Click Cancel to exit the Table Lookup dialog.

494  Bottom Panel
Tﬁuﬂ!;ﬂmll;bﬂ:f of [ Full Term Births: |
Premature Births: | Abortions, Spontaneous: |
Abortions, Induced I E ctopic Pregnancies: [
Living Childrer ] Multiple Biithe: [
Age at First Menses: | Age al First Intercourse: |
Age at Menopause: | DES Daughter Status: | =]
Figure 4-38: Bottom panel of Edit Reproductive Factors dialog
Total Number of Pregnancies: Populate with the value that shows the number of
times this patient has been pregnant.
Full Term Births: Populate with the value that shows the number of full-term births
for the patient.
Premature Births: Populate with the value that shows the number of premature
births for the patient.
Abortions, Spontaneous: Populate with the value shows the number of spontaneous
abortions for the patient.
Abortions, induced: Populate with the value that shows the number of induced
abortions for the patient.
Ectopic Pregnancies: Populate with the value that shows the number of gestations
elsewhere than in the uterus (such as in a fallopian tube or in the peritoneal cavity).
Living Children: Populate with the value that shows number of living children of the
patient.
Multiple Births: Populate with the value that shows the number of multiple births for
the patient.
Age at First Menses: Populate with the age for the first menstrual day.
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Age at First Intercourse: Populate with the age of the first sexual intercourse.

DES Daughter: DES Daughters are defined as women born between 1938 and 1971
who were exposed to diethylstilbestrol (DES) before birth (in the womb). Populate
this field by selecting an option from the list.

4.9.41 Menus on Dialog
The File menu contains the Close option, which closes the dialog.
The Help menu contains the following options:
iCare Help: Use this option to access the online help for the dialog. This is the same
as pressing the F1 key.
About iCare: Use this option to review the iCare version and other information.
410 CMET Worksheet
Use the Open CMET Worksheet button to access the CMET Worksheet for a
selected event on the sub-tab of the CMET window.
Use this worksheet to process the Care Management Events that you have chosen to
track. Enter data related to Findings, Follow-up, and Patient Notification. The Due
By Site parameters default dates set by the CMET Package Manager can also be
edited in this screen.
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(M T Workuheet =101 %]

fle e

Use twe workshe sl 00 process the Care Mansgement Events Maryou have choten to wack Enter data related 1o Findogs Falow-up and Pasent

Mosicason The Sae parametars Due By delaut dates ret by e CMET Package Manager can alto be edved wr i tcreen

Patient Demographics

| HAN - Sex FEMALE Age: 11vRS Dob: N

1 - Event

£ went NEEDLE BIOPSY Evert

Evont D abe MAY 14,2010 Tiscked By _

Categoy BREAST TrackedDaber  MAY 182010110514

Precedeg [ vert NONE Slade OFEN «l EP-_“‘

CMET Auit History:  Viewr Close Reaton | |

1-12 - Findings

Fndinags Due By : Aoyl Follow up Hecommendnd? I 'i

) Add(F2) K Delets (Del Erree

Diate Findng | Irtespretaton Commernt . Followe Up Needed? | Last Edted | Lag

4 J 2
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F ollow up Decivon Due By ] 'I Notdc atwon D us By I 'l

) X ) X

K| 2 4 i

I Cancal I

Figure 4-39: Sample CMET Worksheet
When the worksheet is complete, click OK (otherwise, click Cancel).

When you click OK, there are two cases.

e (Case 1: If all the steps are not complete; the application updates the data on the
Tracked Events sub-tab.

e Case 2: If all of the steps are complete, the application will display the Close
Event information message that states: The event is eligible for closing as all
four steps are completed. Do you want to close the event now? Click Yes to
close the event. Click No to not close the event.

If you choose to close the event (by selecting Yes on the Close Event message), the
application displays the RPMS iCare Reason for Closing dialog. Here you select a
reason for closing the event and provide a comment (required) about the closing.
Click OK to save the reason for closing (otherwise, click Cancel).

If you click OK on the Reason for Closing dialog, the application displays the Save
to RPMS? dialog: You have data changes pending. Do you want to save to RPMS
now? Click Yes to save the changes to RPMS. Click No to not save the changes.
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When you click Cancel, there are two cases:

e (Case 1: If you did not make any changes on the worksheet, the application closes
it.

e Case 2: If you made changes on the worksheet, the application displays the Save
to RPMS? dialog: You have data changes pending. Do you want to save to
RPMS now? Click Yes to save the changes to RPMS. Click No to not save the
changes. Click Cancel to return to the CMET Worksheet.

4.10.1 Patient Demographics Group Box
The Patient Demographics group box displays the patient’s name, HRN, Sex, Age,
and DOB.
4.10.2 1 - Event Group Box
The data in the 1 — Event group box provides information about the event and allows
you to change the State of the event as well as provide comments about the Event
and/or State. In addition, you can view the event’s audit history.
1- Event
Event MASTECTOMY . BILATERAL (\W/EI MOD .50) E‘;ﬁ'lmment |
Event Date: MAR 15, 2014 Tracked By: _
Category: BREAST Tracked Date: JUN 10, 2014 20:16:08 -
PrecedingEvent  NONE State: CLOSED = | .
CMET Audit History:  View Close Reason: Event Complete - -
Figure 4-40: Sample Event group box
State: This field defines the event State.
If you populate the State field with Closed, the Close Reason field becomes active.
Select an option from the list that describes why you are closing the event.
When an Event has a State of Closed, the other group boxes (Findings, Follow-up,
Patient Notifications) will be inactive.
Event Comment: Use this Free Text field to add comments about the Event.
State Comment: Use this Free Text field to add comments about the State.
CMET Audit History: If you click the View label, the application will display the
CMET Audit History dialog.
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4.10.3

=] CMET Audit History = | B

File Edit Tools

9 a4 B S

TR Field TR Entry ¥R New Value Ta *

Hun 1002074 0819 P Motifications - Entered By 1 [ L
‘;lun 10, 2014 08:15 FM Netifications - Entry Date 1 JUN 10, 2014 20:15:14 1
Jun 10, 2014 08:15 PM Netifications - Methad 1 IN PERSON
Jun 10, 2014 08:15 PM Last Medified Date/Time JUN 10, 2014 20:15:14
Jun 10, 2014 08:19 PM Follow-ups - Date Due 1 JUL 10, 2014 00:00
Jun 10, 2014 08:13 PM Follow-ups - Entered By 1 ]
Jun 10, 2014 08:19 PM Follow-ups - Date Entered 1 JUN 10, 2014 20:15:13
Jun 10, 2014 08:15 PM Follow-ups - Event 1 BREAST RECONSTRUCTION W/IMPLANTS
1 Yes

Jun 10, 2074 08:13 PM

Findings - Follow-Up Needed?

< [T} 3

Figure 4-41: Sample CMET Audit History dialog

Because multiple users work on the event, the audit history provides of a history of
those activities.

Section 4.11 provides information about using the controls and menus on this dialog.

State: This field determines the state of the event, either Open or Closed. If Closed is
used, the Close Reason field becomes active and all the other group boxes (2 -
Findings, 3 - Follow-ups, 4 - Patient Notifications) become inactive.

Close Reason: This field is active when State is Closed. Select an option from the list
that indicates the reason for closing the event.

2 - Findings Group Box
Use the 2 — Findings group box to enter Findings data about the event.
=12 - Findings

Finddings Dus By: 5200 - gt Falhow-up Hecommendnd? l -

J #ddiFz) W Celetaibeli  Error

Diste | Firing | Indespretation Commert | Folowlip Meeded? || Laut Edted Lea

| | |
Figure 4-42: Sample Findings group box

You can minimize this group box by clicking the collapse button in the upper left
corner. This allows more room for viewing the other group boxes (Follow-ups and
Patient Notifications).

The Findings Due By, Result, and Follow-up Recommended? fields are populated
when you use the Add button on the grid and save the record.

Findings Due By: This field displays the date the findings of this event were entered
into CMET. If this date passes without an entry, a “tickler” (Feather icon) is
generated.

Patient Record User Manual iCare Features Used by Patient Record
March 2021

116



iCare Population Management GUI (BQl) Version 2.9

Result: This field displays the date of the result. If this field contains an underlined
date, click on the date to display the detail of the result. For example, Figure 4-43
shows an example of the Radiology Case Number Detail dialog.

B Rodolooy Cmcrumberdetadl DI
Eie

N A D " =
Find Font Copy Print Preylew... Brint...

75 yr. old female Case: 031510-67814:30 A
Req Phys: Pat Loc: CWWC-BROTHERTON

(Req'g Loc)
Att Phys: UNFNOWN Img Loc: MAMNO
Pri Phys: UNFNOWN Service: Unknown
(Case 67 CONPLETE) SCREENING MAMMOGRAN (MAN Decailed) CPT:77057

Clinical History:
ANNUAL SCREENING MANNO

ReEnnre. : Sraru=: VERTFTED :]

Figure 4-43: Radiology Case Number Detail dialog

Follow-up Recommended? This field indicates if a follow-up is recommended (yes
or No).

4.10.3.1 Add Button

Use the Add function to create a new Findings record. Click the Add button (or press
F2) to access the Findings dialog.

¥ Fandings

x|
fdd
Date™ [ = Fineing®: [ =]
Intenpeetaton Comment:
Follow-Up Heeded?: E ﬂ
[1]4 Cancal

Figure 4-44: Findings dialog
The field names followed by an asterisk (*) are required.
Date: Click the list and select a date for the findings.

Finding: This is the finding associated with the event. Select an option from the list
to populate this field.
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4.10.3.2

4.10.3.3

Interpretation: The application populates this field, based on your selection in the
Finding field.

Comment: Type the text of the comments about the Finding, if appropriate, in this
Free Text field.

Follow-up Needed: Select an option from the list: Yes or No.
Click OK to save your data on the Findings dialog (otherwise, click Cancel).

After saving the data, the application populates the grid with the record and populates
the Last Edited (current logged-in user) and Last Edited By (current date) columns.

If you select Yes for the Follow-up Needed field (on the Findings dialog) and save,
the Follow-up Recommended? field on the grid will populate with Yes, and the
application will automatically display the Follow-Ups dialog (where you can enter
follow-up data).

Delete Button

The Delete function applies to events that had Findings entered but not saved.

If you select an event that is not eligible for the Delete function, the application
displays the message: Unable to delete a previously saved entry. Please mark as
‘Entered in Error’ instead. Click OK to dismiss the message.

Select one or more eligible Findings records you want to delete and click the Delete
button (or press Delete). The application displays the Delete Row information
message, confirming the deletion. Click Yes to delete the selected records.
(Otherwise, click No.)

Error Button

Use the Error function when Findings records have been saved and you cannot delete
them but want to mark them as Entered in Error.

If you select a record that is not eligible for the Error function, the application
displays the message: Unable to mark as ‘Entered in Error’ because the entry has
not been saved in RPMS. Please delete the entry instead. Click OK to dismiss the
message.

Select one or more eligible Findings records and click Error. After using this
function, the application places a strikethrough mark on the text of the record.
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410.4

4.10.4.1

] A3d(FZ) % Delste (D]  Enbered in o

Dape | Fereing Irdespratation Cosmareart Il'-:-f-c-r-rLIp Meeded? | Leat Edited

Figure 4-45: Sample Entered in Error marking

After you save and return to the Tracked Events tab, the Result column for the event
will be blank for the event.

3 - Follow-ups Group Box
Use the 3 — Follow-ups group box to add follow-up data about the event.

=|3 - Follow-ups
FollowupDeciionDueBy [ <]
j x
i

L A
Figure 4-46: Follow-ups group box

The Follow-ups group box becomes active when the Follow-up Recommended field
(in the Findings group box) is set to Yes.

You can minimize this group box by clicking the collapse button in the upper left
corner. This action allows more room for viewing the other group box (Patient
Notifications).

Follow-up Decision Due By: Select a date from the list that indicates when the
follow-up decision should be made. Populating the field creates a tickler (feather
icon) for the event. In certain cases, this date is populated by the Tickler Timeframe
set in the site parameters. You can populate this field with the date you want to take
action on the event.

Add Button

Use the Add button to create a new Follow-up record. Click the Add button (or press
F2) to access the Follow-Ups dialog.
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4.10.4.2

410.4.3

i Follow-Ups E x|

Irecre| hd

0K Cancel

Figure 4-47: Sample Follow-Ups dialog
The required fields are marked with an asterisk (*) after the name.
Event: Select an option from the list that describes the Event for the follow-up.

Date Due: Use the list to display a calendar from which to select the due date for the
follow-up event.

Comment: Use this Free Text field to add comments about the follow-up.

Click OK to save the data on the dialog and the follow-up record will display in the 3
- Follow-ups group box on the CMET Worksheet. (Otherwise, click Cancel.)

Delete Button

The Delete function applies to events with Follow-ups entered but not saved.

Select one or more eligible Follow-up records to delete and click the Delete button
(or press Delete). The application displays the Delete Row information message
confirming the deletion. Click Yes to delete the selected records. (Otherwise, click
No.)

Error Button

Use the Error function when Follow-up records have been saved and you cannot
delete them but want to mark them as Entered in Error.

If you select a record that is not eligible for the Error button, the application displays
the message: Unable to mark as ‘Entered in Error’ because the entry has not
been saved in RPMS. Please delete the entry instead. Click OK to dismiss the
message.

Select one or more eligible Follow-up records and click the Error button. After using
this function, the application places a strikethrough mark on the text of the record.
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4.10.5

4.10.5.1

=|3 - Follow-ups
Follow-up Dacision DBy, [00152000 =]

) AddiFZ) K DelstedDef)  Ewer

Evert | Brate Dus Comment

Figure 4-48: Sample of Follow-up record marked as entered in error

4 - Patient Notifications Group Box

Use the 4 — Patient Notifications group box to add patient notification data about the
event.

=] 4- Patient Notifications
Notification Due By | =]

F

k| 2
Figure 4-49: Patient Notifications group box

The Patient Notification, the final step, makes the patient aware of both the results
and the follow-up recommendations. Multiple types of Patient Notifications can be
entered for each Event.

The Patient Notifications group box becomes active when the Follow-up
Recommended? field (in the Findings group box) is set to Yes.

You can minimize this group box by clicking the collapse button in the upper left
corner. This action allows more room for viewing the Follow-ups group box.

Notification Due By: Enter the date to have your patient notified about the results
and recommendations of the follow-up related to this event. If this date passes
without an entry, a tickler (feather) icon will be generated. In certain cases, this date
is populated by the Tickler Timeframe set in the site parameters.

Add Button

If you do not have default clinics defined in user preferences, the application displays
the following message: You must select default clinics in user preferences before
being able to enter notes. Click OK to dismiss the message. Select Tools | User
Preferences to access the RPMS iCare — User Preferences dialog. Go to the
Patient View tab to enter the clinic codes.

Use the Add button to create a new Patient Notification record. Click the Add button
(or press F2) to access the Notifications dialog.
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4.10.5.2

4.10.5.3

Wrouiicaions x
A
Data™: TR - Mathod™ | |
Comment:
(114 Cancel

Figure 4-50: Sample initial Notifications dialog
Required fields are marked with an asterisk (*) following the name.

Date: The default date is today’s date. Change it by clicking the list to access a
calendar from which to select another date.

Method: Select an option from the list that identifies the type of notification.

Create: This button becomes active if you select Certified Letter or Letter in the
Method field. You must have an electronic signature on file before you can use this
function.

If you have an electronic signature on file, click the Create button to access the Add
TIU Note dialog. Section 4.5 provides information about this dialog.

Comment: Use this Free Text field to add any comments about the notification.

After completing this dialog, click OK to save the data (otherwise, click Cancel).
After saving, the notification record will display in the 4 - Patient Notifications
group box on the CMET Worksheet.

Delete Button

The Delete function applies to events that had Patient Notifications entered but not
saved.

Select one or more eligible Patient Notification records to delete and click the Delete
button (or press Delete). The application displays the Delete Row information
message confirming the deletion. Click Yes to delete the selected records. (Otherwise,
click No.)

Error Button

Use the Error function when Patient Notification records have been saved and you
cannot delete them but want to mark them as Entered in Error.
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4.10.5.4

4.10.5.5

If you select a record that is not eligible for the Error function, the application
displays the message: Unable to mark as ‘Entered in Error’ because the entry has
not been saved in RPMS. Please delete the entry instead. Click OK to dismiss the
message.

Select one or more eligible Patient Notification records and click the Error button.
After using this function, the application places a strikethrough mark on the text of
the record.

=14 - Fatient Nofifications
Hotification Dus By | 05102070 =

] AadiFZ) W Delete (Del) Erod Fravigw

Dok [ ot [

Figure 4-51: Sample Patient Notification record marked as entered in error

Preview

Use the Preview function to preview the letter associated with the selected Patient
Notification record. This function only applies to records that are Letters or Certified
Letters.

Select the record you want to preview and click the Preview button. The application
displays the Letter Preview dialog.

TITLE: PC NOTE ADULT
DATE OF NOTE: JUN 30, 2010012:18:24 ENTRY DATE: JUN 30, 2010812:18:24
AUTHOR : I EXPF COSIGHER:
URGENTY: STATUS: UNSIGNED
SUBJECT: CHET Testing 2345

You may not VIEW chi= UNSIGHNEDR PC NOTE ADULT.
Vimit: Jun 30, 2010812:18 CHART REVIEW- Dx: CHET Chart Review

Figure 4-52: Sample Letter Preview dialog

Section 4.6 provides information about using the controls on the dialog,

Print Button

Use the Print button to output a letter in a selected record. After clicking Print, the
application displays the Print dialog where you specify the printer, page range,
number of copies, etc.; this dialog works like the one in MS Office.
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4.11

Background Jobs Dialog
Click the Background Jobs (3) button (or select File | Background Jobs) to

display the Background Jobs dialog.

6=l RPMS iCare - Background Jobs o (D e S

File Edit Took

Background jobs are schagulad by your Site Managar. [fis recommendad thaf thay be run both nightiy and )

weskly. Confact pour Sita Manager if you have any quesfions. ) ﬂ # S Ea
Job Type Start End MNext scheduled i
MONTHLY  IPC Update Apr 03, 2015 06:56 PM Apr 03, 2015 10:02 PM May 03, 2015 06:00 PM

MU Clinical Quality
MU Performance

Diagnostic Tags
Flags
MNatl Measures

Panel Autopopulate

Apr03, 2015 06:30 PM
Apr02, 2015 06:53 PM

Apr29, 201507:01 AM
Apr 29, 2015 06:36 AM
Apr 29, 2015 07:01 AM
Apr 29, 2015 07:50 AM

Apr03, 2015 06:30 PM
Apr02, 2015 07:05 PM

Apr29, 201507:01 AM
Apr 29, 2015 06:48 AM
Apr 29, 2015 07:16 AM
Apr 29, 2015 10:15 AM

May 01, 2015 06:00 PM
May 01, 2015 06:00 PM

Apr 29, 2015 06:00 PM
Apr 29, 2015 06:00 PM
Apr 25, 2015 06:00 PM
Apr 29, 2015 06:00 PM

Reminders Apr 29, 2015 07:20 AM Apr 29, 201507:21 AM Apr29, 2015 06:00 PM
WEEKLY Best Practice Prompts Apr 26, 2015 02:00 PM Apr 26, 201507:10 PM May 03, 2015 03:00 PM
Care Mgmt Update Apr 25, 2015 02:00 PM Apr 26, 201503:32 AM May 02, 2015 03:00 PM

Diagnostic Tags

Apr 25, 2015 02:00 AM

Apr 25, 2015 05:53 AM

May 02, 2015 02:00 AM

" Best Practice Prompts Apr29. 20150721 AM  Apr 29, 2015 0721 AM “Apr 29, 2015 06:00 PM

" Care Mgmt Update Apr28 201507:25AM  Apr29, 2015 07:25 AM Apr 29, 2015 05:00 PM
CMET Data Mining Apr28 20150725 AM  Apr 28, 2015 07:50 AM Bpr28 2015 06.00PM |F
Comm Alerts Lpr 28, 2015 0648 AM Apr 2, 2015 05:50 AM Bpr 28, 2015 06:00 PM

Figure 4-53: Sample Background Jobs dialog
You must dismiss the dialog to use other functions in iCare.
Section 4.2 provides information about the buttons on the right side of the toolbar.

The File menu has the following options:

Page Setup: This option allows you to set the Margin, Paper, Layout characteristics
(e.g., landscape or portrait orientation), and which Printer to use.

Print Preview: This option displays the Print Preview dialog. Section 4.12 provides
information about this dialog.

Print: This option outputs the selected rows in the grid. The application displays the
Print Preview dialog where you can view the output. Select File | Print (on the
dialog) to output the content. The application provides a Confidential Patient
Information header for all printed panel views.

If you do not select any rows, the application displays a warning message: You have
not selected any rows to print. Do you want to proceed and print all rows in this
view or cancel this print? Click Yes to print all the rows. Click No to cancel the
print function.

Close: This option closes the Background Jobs window.

The Edit menu has one option: Select All (use to select all the records).
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The Tools menu has options that have the same functions as those of the buttons on
the right side of the toolbar.

412 Print Preview

The Print Preview dialog contains several features about reviewing and printing the
current document.

Pr-ltF'r'ﬂl.-w . . . .-]ﬂ]ﬁl
Fie Wi Tooks
i g L o ‘m =1 = (N ] =
3¢ mx[Ala 000 e = ® | @~ oo
A FH®@

b e Can e man

e B e

......

e R

et B

Figure 4-54: Sample Print Preview dialog

The Print Preview dialog contains two panels, where the left panel displays the
pages in the document and the right panel displays a larger version of the page
selected in the left panel.

Table 4-1 provides information about the buttons on the Print Preview window.

Table 4-1: Print Preview buttons and descriptions

Button | Description
= Use to output the contents of the document.
Also available by selecting the Print option on the File menu.
Use to move the red rectangular box on the selected page in the left panel. As you move
om the Hand Tool, this changes the display in the right panel. This is used to view information
S in a particular part of a page.
Also available by selecting the Hand Tool option on the Tools menu.
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Button | Description

Use to get a screen capture of a specified rectangular area. This screen capture copies the
- area to the Windows clipboard. Then you can paste the copy in a particular field, for
example, or another application like MS Word.

Also available by selecting the Snapshot Tools option on the Tools menu.

Use to specify the zoom magnification. Click the button and then move to the area where
v you want to apply to zoom. Right-click on the area and select the zoom magnification option
=% from the context menu.

Also available by selecting the Dynamic Zoom Tool option on the Tools menu.

Use to zoom out by clicking the button in an area in the right panel (the image becomes
&y smaller).
Also available by selecting the Zoom Out option on the View menu.

Use to zoom in by clicking the button in an area in the right panel (the image becomes
@ larger).

Also available by selecting the Zoom In option on the View menu.

Use to cause the image in the right panel to display to its maximum page width (usually
enlarges the image).

Also available by selecting the Page Width option on the View menu.

Use to cause the image in the right panel to display the image with no page margins
showing.

Also available by selecting the Margin Width option on the View menu.

Use to display the image and its page margins in the right panel.
Also available by selecting the Whole Page option on the View menu.

Use to automatically cause the image in the right panel to zoom out (you do not click in the

= panel).

Also available by selecting the Zoom Out on the View menu.

Use to automatically cause the image in the right panel to zoom in (you do not click in the
@ panel).

Also available by selecting the Zoom In option on the View menu.

Use to display all the pages in the right panel.
Also available by selecting the Continuous option on the View menu.

B

Use to specify the page layout.
i Also available by selecting the Page Setup option on the File menu.
Navigate through the pages in the document by using the arrow buttons on the second
line in the toolbar.
1 . h 5 J
& £
Figure 4-55: Buttons to aid navigation through the document pages
The same options are available by selecting View | Go To (and on the context menu
for the right panel).
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Use the Zoom dropdown field ( o0 % T ) (or select View | Zoom) to
specify the zoom magnification for the right panel by selecting from the list.

Use the Close button (or select File | Exit) to close the Print Preview dialog.

Select File | Page Setup to access the Page Setup dialog.

Page setup 2| x|

i~ Prapes
Sige: =
Source: [Autoenaticaly Select =]
Oinentation i~ Marginz [inches)

€ Potait Lett  [075 Right [0.75
* Landscape Top: 075 Bottor: [0.75

[ ok | cocel | Prive. |

Figure 4-56: Sample Page Setup dialog

Use the Page group box to specify the paper size and source.
Use the Orientation group box to specify the orientation of the output.
Use the Margins group box to specify the various margins widths in inches.

Click Printer to access the Printer dialog and choose the printer to which to output
the contents of the document.

After the Page Setup dialog is complete, click OK to save the page setup options.
(Otherwise, click Cancel.)
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4.13

Graphing Measurement Data

You can create a graph of selected measurement data on the patient record window by
=

il

Graph It!

clicking the Graph It! (

button. The application displays the Charting

window, showing a graph of the measurement type. The Graph It button also
displays on the Nat’l Measures view window, but those features will not be included
in the following documentation.

The application creates a line chart of the data. This type of graph shows trends over

time.
e The x-axis is the time axis.

(this is the default setting).

The y-axis shows the data range that includes the maximum and minimum values

2| Graph It - DEMO AMENDMENT TWO
E - = by

(=[=] = ]

Filz

[=] Chart Options
Measurement Type

»

Respirations
Temperature
Weight

|| [ Selected Rows
| Time Interval

|Ever

¥ Set Grid to Zero
[¥ Lines Visible?
V¥ Values

¥ Grid Lines

™ Enable Zooming/Scrolling
X-axis Date Range
|Months

¥ Title

lcon
 PYp— 1

m

=

=

CONFIDENTIAL PATIENT INFORMATION - [04/28/2015 01:56 PM] - [BS]
Blood Pressure for: DEMO,AMENDMENT TWO

210,00
200

180
16800

18§ 5400

8%

15200

140800
—
120
ey
1002 ;‘235(7 1040
solee—"

5/29/2012
6420/2012
Fizafz2012
Bfza/2012
afzaf2012
10/29f2012
11/20/2012
12/20/2012
1f29/2013
27

E] Chart Data

Event’Visit Date/Time ¥ W Blood Pressure 7R

W 04/30/2012 10:48 AM
03/07/2012 06:45 PM

153112

i EI 5

Figure 4-57: Sample Charting window

4.13.1 Chart Data Group Box

The Chart Options group box contains the data for the graph.
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E Chart Dsta

Event/k [ate/Tese ¥ 70| Blood Poetign 'i"ﬂ-!

¥ | CFL2A/0EE (a0 A 125067
| 01072008 1225 PM 125081
" O 4T O P 12573
| OO0 1010 M 11578
| OIS e O O A 1
.' 00 RS (79 5 M 13165

B E 40

Figure 4-58: Sample Chart Data group box

The data is determined by what you select in the Measurement Type field.

4.13.2 Chart Options Group Box

What you select in the Chart Options group box determines what the graph looks
like. For example, you can determine the scale units for the x-axis in the X-axis Date
Range field.

Figure 4-59: Sample Chart Options group box

Measuremant Type

Rezpirations ]
T efripershure

[ Selected Fows
Time Interval

|2 pears =]
[~ Set Gid o 2emo

[+ Lines Visbls?

¥ Walues

[+ Grid Lines

™ Enable Zooming/Scroling
Hraxis Date Range

|Tear3 j
¥ Title

leon

ore =]
™ Show Legend

o =l

Measurement Type: This shows what is being charted. You can change this by

highlighting another measurement type.

Chart Type: This option only displays on the National Measures chart. This
determines the type of chart (Column Chart is the default). You can change this by

selecting an option from the list.
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Selected Rows: select this check box to graph the selected row(s) in the Chart Data
grid. If you do not use this check box, the application uses all the measurement
values.

Time Interval: This determines the time interval for the data on the chart. The
default is what you selected (in the Last field) on the PCC tab of the patient record
window. You can change this interval by selecting an option from the list.

Set Grid to Zero: Select this check box to cause the y-axis values to start at zero and
go to the maximum data value. When you do not select this check box, the
application uses the minimum and maximum values for the y-axis.

Lines Visible?: Select this check box to display the lines that connect the data points.
Values: Select this check box to display the values at each data point.
Grid Lines: Select this check box to display the grid lines on the chart.

Enable Zooming/Scrolling: Select this check box to display zooming/scrolling of the
axis lines.

X-axis Data Range: This determines the time units of measure on the x-axis of the
graph. The options are Not Set, Days, Weeks, Months, and Years.

Icon: This determines the icon for each data point. The options are circle, diamond,
none, plus, square, triangle, upside down triangle, and X. The default is None.

Show Legend: Select this check box to show the legend for the graph. The field that
follows determines the location of the legend.

4.13.3 File Menu for Charting Window
The following are the File menu options for the Charting window.
File
Chart  »
Table »
Close
Figure 4-60: File menu options for the Charting window
Use the Close option to close the charting window.
4.13.3.1 Chart Option
The Chart option of the File menu has the following selections:
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Page Setup: This selection allows

you to set Margin, Paper, and Layout

characteristics (like landscape or portrait orientation) for printing. You can select a

different printer.

Print Preview: This selection disp

lays the Print Preview dialog that displays how

the output of the chart will look. Section 4.12 provides information about this dialog.

Print: This selection displays the Print dialog where you select the printer to output
the chart. This is the same as pressing Ctrl-P.

Save Chart for Office: This option lets you save the chart in a particular graphics
format, for example JPEG. The application displays the Save Chart for Office

dialog.

Save Chart for Difice

i

Save in |_"| My Documents

r «BckmE

=) DataCom docs
) for carohm
91 HS AR BPP vl O draft (2)_files
)M docs
) Inifo about my laptop
My pusic
Zhmy Pictures
< My RoboHelp Frajects
)My Shapes
| nevaletter
I PDF Files For Frame
i Performance eval_2010

C)ersion 2.1,0.27
C)vrersion 2.1.0.28
Cersion 2_0_2_10
—)vha habdbbak
) WebEx

K| CRWACD - 7.jpg

EI ) training cert
M--lhju 3 Unziog
- ) Version 2.1,0.25
.

y
My Network [T, | = Save I
Places

Saveashpet  |JPG JPEG ["ipeg) Zl Cancel |

Figure 4-61: Save Chart for Office dialog for graphics format

File Name: Specify the name of th

e file for the chart in graphics format.

Save as type: Select the type of graphics format for the chart. The default is JPEG.

After completing the two fields, click Save to save the chart in graphics format

(otherwise, click Cancel).

Save Chart for PDF: This selection lets you save the chart in PDF format. The
application displays the Save Chart for Office dialog.
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4.13.3.2

2%
Save |_‘j My Documents El + @ ¥ B

) DataCom docs C2yVersion 2.1.0.27
b | for carohm ) Version 2.1.0.28
CIGET | H S AR BPP_v1 O draft (2)_Fles Version 2_0_2_10
Documents [ SR = vha habdbbok

c ) Info about my laptop I_)WebEx
A My pussic T Fos-11a_ITACYL 2.pdf

Desklop ﬂm-'. Pictures
& My RoboHelp Frojects

. My Shapes

| nevdletter
Bt |20POF files for Frame
| Performance eval_2010
| braining cert
) Unzipped
) Version 2.1,0.25

Saveasiype:  |FDF [pdi) = Cancel L

Figure 4-62: Save Chart for Office dialog for PDF format

File Name: Specify the name of the file for the chart in graphics format.
Save as type: Use the default PDF.

After completing the two fields, click Save to save the chart in PDF format
(otherwise, click Cancel).

Table Option

The Table option of the File menu has the following selections:
Search: This selection searches for data in the Chart Data group box.

Excel Export: This selection to export the selected rows in the Chart Data group
box to Excel.

Print: This selection displays the Print Preview dialog of the currently selected rows
in the Chart Data group box. Section 4.12 provides information about the Print
Preview dialog.

Copy Rows to Clipboard: This selection copies the currently selected rows in the
Chart Data group box to the Windows clipboard. You can paste the contents of the
Windows clipboard to any Windows application.
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4.14  Table Lookup

The ellipsis button next to the field means you can search for a particular record in the
Table Lookup dialog by clicking the button. In addition, you can clear the
information in the field (on the form).

4.14.1 Searching for Record

Table Lookup x|
e [ Find... Show
l ﬂ

Figure 4-63: Table Lookup dialog
This dialog provides two types of searches: for all items or for a particular item.

We will use an example to demonstrate each type and assume you will search for a
CPT Code.

41411 Using the Show All Button

If you do not enter anything in the Search field and click Show All, the application
will display all CPT codes, as follows. (The retrieval might take a little time.)
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Search |

i
Find... Show
All

28888
BEERS

00124

888
hER

00144

88
& &

o014y
00148

L LR LT

Select |

Figure 4-64: Sample retrieval of all CPT codes

4.14.1.2 Using the Find Button

To search for a particular CPT code, type a few characters in the Search field and
click Find. The retrieved records will display in the bottom area (if any).

x
Search: 245 Find._.
| | o
[CPT_CO0E | SHORT NAME e
24500 TREAT HUMERLS FRACTLURE
24506 TREAT HUMERUS FRACTURE
| 24508 TREAT HUMERLS FRACTURE
| 24510 REFA4IR HUMERUS FRACTURE
| 24515 TREAT HUMERUS FRACTURE L
| 24518 TREAT HUMERLS FRACTURE
| 24530 TREAT HUMERLS FRACTURE
) TREAT HUMERUS FRACTURE
e TREAT HUMERLS FRACTURE
w 2453 TREAT HUMERUS FRACTURE
| 2453 TREAT HUMERUS FRACTURE
| 24540 TREAT HUMERLS FRACTURE
| 24542 TREAT HUMERUS FRACTURE
| 24585 TREAT HUMERUS FRACTURE
e TREAT HUMERLS FRACTURE =
seect | s | cacel |

Figure 4-65: Sample retrieval of a particular CPT code

4.14.1.3 Completing the Search

In either case, select a record and click Select. This will close the dialog and populate
the field (on the form) with the selected record. (To exit the Table Lookup dialog,
click the Cancel button.)
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4.14.2 Clearing Data in Field with Ellipsis Button

To clear the data in a field with the ellipsis button (on a form), click the ellipsis button
to display the Table Lookup dialog. Click Clear (on Table Lookup). This will close
the Table Lookup dialog and clear the data in the field on the form. (To exit the
Table Lookup dialog, click Cancel.)

4.15 Erroneously Tracked Events

Once an event has been Tracked, it cannot be changed to Not Tracked. The following
process is used when you erroneously Tracked an event.

1. Go to the Tracked tab, in any view (Main, Panel, Patient Record) and open a
CMET worksheet for the event you erroneously tracked. Click the Add button in
the Findings area to access the Findings dialog.

liandegs x|
i

Date®: 60272010 - Finding": [ERROR/DISREGARD =
Inderpeetalon M Commenl:

[1]8 Cancel

Figure 4-66: Sample Findings dialog populated

Choose the ERROR/DISREGARD option in the Findings field. Select No in the

Follow-Up Needed? field. We suggest using today’s date for the Date field. Click
OK to save and to close the dialog.

2. Go to the Patient Notifications area of the CMET Worksheet and click the Add
button. The application displays the Notifications dialog.
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[liroiiications £
Hudd
Dabe®™: [cermzizone =] Method™ [Howe =]
Ci i Brdeied m sl o
oK Cancel

Figure 4-67: Sample Notifications dialog populated

Use the NONE option for the Method field. We recommend adding a comment in
the Comment field and to using today’s date for the Date field. Click OK to save and
close the dialog.

3. The application will display the Close Event information message.

b ] This event is eligible for closing as al Four steps are completed.
-t Do you wank bo chose this event now?

w |

Figure 4-68: Close Event information message
Click Yes on the message. This closes the message.

4. The application will display the RPMS iCare — Reason for Closing dialog.

[ prPMS iCare - Reason for Closing P = [=]
Pleaze piovide reason o closing event
Reason: IDIhE! ﬂ
Comment: [gj10r -]
" Required
=
0K I Cancel |

Figure 4-69: RPMS iCare — Reason for Closing dialog

Select the Other option for the Reason field. Enter a comment in the Comment field.
Click OK to save and to close the dialog.
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5. The application will display the Confirm save to RPMS information message.

Confirm save to RPMS x|

9 This data will be saved to the RPMS server,
&/

Do you whank bo continue?

Figure 4-70: Confirm save to RPMS information message
Click Yes on the message to save the data to RPMS and close the message.

This process causes the event to have a State of CLOSED.
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Appendix A: Rules of Behavior

The Resource and Patient Management (RPMS) system is a United States
Department of Health and Human Services (HHS), Indian Health Service (IHS)
information system that is FOR OFFICIAL USE ONLY. The RPMS system is
subject to monitoring; therefore, no expectation of privacy shall be assumed.
Individuals found performing unauthorized activities are subject to disciplinary action
including criminal prosecution.

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the
Rules of Behavior (RoB) and must acknowledge that they have received and read
them prior to being granted access to a RPMS system, in accordance IHS policy.

e For a listing of general ROB for all users, see the most recent edition of /HS

General User Security Handbook (SOP 06-11a).

e For a listing of system administrators/managers rules, see the most recent edition
of the IHS Technical and Managerial Handbook (SOP 06-11b).

Both documents are available at this IHS Web site:
https://home.ihs.gov/security/index.cfm

The RoB listed in the following sections are specific to RPMS.

A.1 All RPMS Users
In addition to these rules, each application may include additional RoBs that may be
defined within the documentation of that application (e.g., Dental, Pharmacy).
A1.1  Access

RPMS users shall

¢ Only use data for which you have been granted authorization.

¢ Only give information to personnel who have access authority and have a need to
know.

e Always verify a caller’s identification and job purpose with your supervisor or the
entity provided as employer before providing any type of information system
access, sensitive information, or nonpublic agency information.

e Be aware that personal use of information resources is authorized on a limited
basis within the provisions Indian Health Manual Part 8, “Information Resources
Management,” Chapter 6, “Limited Personal Use of Information Technology
Resources.”
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RPMS users shall not

Retrieve information for someone who does not have authority to access the
information.

Access, research, or change any user account, file, directory, table, or record not
required to perform their official duties.

Store sensitive files on a PC hard drive, or portable devices or media, if access to
the PC or files cannot be physically or technically limited.

Exceed their authorized access limits in RPMS by changing information or
searching databases beyond the responsibilities of their jobs or by divulging
information to anyone not authorized to know that information.

A.1.2  Information Accessibility

RPMS shall restrict access to information based on the type and identity of the user.
However, regardless of the type of user, access shall be restricted to the minimum
level necessary to perform the job.

RPMS users shall

Access only those documents they created and those other documents to which
they have a valid need-to-know and to which they have specifically granted
access through an RPMS application based on their menus (job roles), keys, and
FileMan access codes. Some users may be afforded additional privileges based on
the functions they perform, such as system administrator or application
administrator.

Acquire a written preauthorization in accordance with IHS policies and
procedures prior to interconnection to or transferring data from RPMS.

A.1.3  Accountability
RPMS users shall

Behave in an ethical, technically proficient, informed, and trustworthy manner.

Log out of the system whenever they leave the vicinity of their personal
computers (PCs).

Be alert to threats and vulnerabilities in the security of the system.

Report all security incidents to their local Information System Security Officer
(ISSO)

Differentiate tasks and functions to ensure that no one person has sole access to or
control over important resources.

Protect all sensitive data entrusted to them as part of their government
employment.
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e Abide by all Department and Agency policies and procedures and guidelines
related to ethics, conduct, behavior, and information technology (IT) information
processes.

A.1.4  Confidentiality

RPMS users shall

e Be aware of the sensitivity of electronic and hard copy information and protect it
accordingly.

e Store hard copy reports/storage media containing confidential information in a
locked room or cabinet.

e Erase sensitive data on storage media prior to reusing or disposing of the media.

e Protect all RPMS terminals from public viewing at all times.

e Abide by all Health Insurance Portability and Accountability Act (HIPAA)
regulations to ensure patient confidentiality.

RPMS users shall not

¢ Allow confidential information to remain on the PC screen when someone who is
not authorized to that data is in the vicinity.

e Store sensitive files on a portable device or media without encrypting.

A.1.5 Integrity

RPMS users shall

e Protect their systems against viruses and similar malicious programs.

e Observe all software license agreements.

e Follow industry standard procedures for maintaining and managing RPMS
hardware, operating system software, application software, and/or database
software and database tables.

e Comply with all copyright regulations and license agreements associated with
RPMS software.

RPMS users shall not

e Violate federal copyright laws.

e Install or use unauthorized software within the system libraries or folders.

e Use freeware, shareware, or public domain software on/with the system without
their manager’s written permission and without scanning it for viruses first.
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A.1.6  System Logon
RPMS users shall

Have a unique User Identification/Account name and password.

Be granted access based on authenticating the account name and password
entered.

Be locked out of an account after five successive failed login attempts within a
specified time period (e.g., one hour).

A.1.7 Passwords
RPMS users shall

Change passwords a minimum of every 90 days.
Create passwords with a minimum of eight characters.

If the system allows, use a combination of alpha-numeric characters for
passwords, with at least one uppercase letter, one lower case letter, and one
number. It is recommended, if possible, that a special character also be used in the
password.

Change vendor-supplied passwords immediately.

Protect passwords by committing them to memory or store them in a safe place
(do not store passwords in login scripts or batch files).

Change passwords immediately if password has been seen, guessed, or otherwise
compromised, and report the compromise or suspected compromise to their ISSO.

Keep user identifications (IDs) and passwords confidential.

RPMS users shall not

Use common words found in any dictionary as a password.

Use obvious readable passwords or passwords that incorporate personal data
elements (e.g., user’s name, date of birth, address, telephone number, or social
security number; names of children or spouses; favorite band, sports team, or
automobile; or other personal attributes).

Share passwords/IDs with anyone or accept the use of another’s password/ID,
even if offered.

Reuse passwords. A new password must contain no more than five characters per
eight characters from the previous password.

Post passwords.

Keep a password list in an obvious place, such as under keyboards, in desk
drawers, or in any other location where it might be disclosed.
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e Give a password out over the phone.

A.1.8 Backups
RPMS users shall
¢ Plan for contingencies such as physical disasters, loss of processing, and
disclosure of information by preparing alternate work strategies and system
recovery mechanisms.
e Make backups of systems and files on a regular, defined basis.
e If possible, store backups away from the system in a secure environment.
A.1.9 Reporting
RPMS users shall
e Contact and inform their ISSO that they have identified an IT security incident
and begin the reporting process by providing an IT Incident Reporting Form
regarding this incident.
e Report security incidents as detailed in the /HS Incident Handling Guide (SOP
05-03).
RPMS users shall not
e Assume that someone else has already reported an incident. The risk of an
incident going unreported far outweighs the possibility that an incident gets
reported more than once.
A.1.10 Session Timeouts
RPMS system implements system-based timeouts that back users out of a prompt
after no more than 5 minutes of inactivity.
RPMS users shall
e Utilize a screen saver with password protection set to suspend operations at no
greater than 10 minutes of inactivity. This will prevent inappropriate access and
viewing of any material displayed on the screen after some period of inactivity.
A.1.11 Hardware
RPMS users shall
e Avoid placing system equipment near obvious environmental hazards (e.g., water
pipes).
e Keep an inventory of all system equipment.
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e Keep records of maintenance/repairs performed on system equipment.
RPMS users shall not

e [Eat or drink near system equipment.

A.1.12 Awareness
RPMS users shall
e Participate in organization-wide security training as required.
e Read and adhere to security information pertaining to system hardware and
software.
e Take the annual information security awareness.
e Read all applicable RPMS manuals for the applications used in their jobs.
A.1.13 Remote Access
Each subscriber organization establishes its own policies for determining which
employees may work at home or in other remote workplace locations. Any remote
work arrangement should include policies that
e Are in writing.
e Provide authentication of the remote user through an ID and password or other
acceptable technical means.
e Outline the work requirements and the security safeguards and procedures the
employee is expected to follow.
¢ Ensure adequate storage of files, removal, and nonrecovery of temporary files
created in processing sensitive data, virus protection, and intrusion detection, and
provide physical security for government equipment and sensitive data.
e Establish mechanisms to back up data created and/or stored at alternate work
locations.
Remote RPMS users shall
e Remotely access RPMS through a virtual private network (VPN) whenever
possible. Use of direct dial in access must be justified and approved in writing and
its use secured in accordance with industry best practices or government
procedures.
Remote RPMS users shall not
e Disable any encryption established for network, internet, and Web browser
communications.
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A.2 RPMS Developers
RPMS developers shall

Always be mindful of protecting the confidentiality, availability, and integrity of
RPMS when writing or revising code.

Always follow the IHS RPMS Programming Standards and Conventions (SAC)
when developing for RPMS.

Only access information or code within the namespaces for which they have been
assigned as part of their duties.

Remember that all RPMS code is the property of the U.S. Government, not the
developer.

Not access live production systems without obtaining appropriate written access
and shall only retain that access for the shortest period possible to accomplish the
task that requires the access.

Observe separation of duties policies and procedures to the fullest extent possible.

Document or comment all changes to any RPMS software at the time the change
or update is made. Documentation shall include the programmer’s initials, date of
change, and reason for the change.

Use checksums or other integrity mechanism when releasing their certified
applications to assure the integrity of the routines within their RPMS applications.

Follow industry best standards for systems they are assigned to develop or
maintain and abide by all Department and Agency policies and procedures.

Document and implement security processes whenever available.

RPMS developers shall not

Write any code that adversely impacts RPMS, such as backdoor access, “Easter
eggs,” time bombs, or any other malicious code or make inappropriate comments
within the code, manuals, or help frames.

Grant any user or system administrator access to RPMS unless proper
documentation is provided.

Release any sensitive agency or patient information.

A.3 Privileged Users

Personnel who have significant access to processes and data in RPMS, such as,
system security administrators, systems administrators, and database administrators,
have added responsibilities to ensure the secure operation of RPMS.
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Privileged RPMS users shall

Verify that any user requesting access to any RPMS system has completed the
appropriate access request forms.

Ensure that government personnel and contractor personnel understand and
comply with license requirements. End users, supervisors, and functional
managers are ultimately responsible for this compliance.

Advise the system owner on matters concerning information technology security.

Assist the system owner in developing security plans, risk assessments, and
supporting documentation for the certification and accreditation process.

Ensure that any changes to RPMS that affect contingency and disaster recovery
plans are conveyed to the person responsible for maintaining continuity of
operations plans.

Ensure that adequate physical and administrative safeguards are operational
within their areas of responsibility and that access to information and data is
restricted to authorized personnel on a need-to-know basis.

Verify that users have received appropriate security training before allowing
access to RPMS.

Implement applicable security access procedures and mechanisms, incorporate
appropriate levels of system auditing, and review audit logs.

Document and investigate known or suspected security incidents or violations and
report them to the ISSO, Chief Information Security Officer (CISO), and systems
owner.

Protect the supervisor, superuser, or system administrator passwords.

Avoid instances where the same individual has responsibility for several functions
(i.e., transaction entry and transaction approval).

Watch for unscheduled, unusual, and unauthorized programs.
Help train system users on the appropriate use and security of the system.

Establish protective controls to ensure the accountability, integrity,
confidentiality, and availability of the system.

Replace passwords when a compromise is suspected. Delete user accounts as
quickly as possible from the time that the user is no longer authorized system.
Passwords forgotten by their owner should be replaced, not reissued.

Terminate user accounts when a user transfers or has been terminated. If the user
has authority to grant authorizations to others, review these other authorizations.
Retrieve any devices used to gain access to the system or equipment. Cancel
logon IDs and passwords and delete or reassign related active and backup files.
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Use a suspend program to prevent an unauthorized user from logging on with the
current user's ID if the system is left on and unattended.

Verify the identity of the user when resetting passwords. This can be done either
in person or having the user answer a question that can be compared to one in the
administrator’s database.

Shall follow industry best standards for systems they are assigned to and abide by
all Department and Agency policies and procedures.

Privileged RPMS users shall not

Access any files, records, systems, etc., that are not explicitly needed to perform
their duties.

Grant any user or system administrator access to RPMS unless proper
documentation is provided.

Release any sensitive agency or patient information.
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Glossary

Context Menu
The menu of options that displays when you right-click on an entity.

Designated Primary Care Provider

In RPMS, the provider name that is assigned as the primary care physician for
a patient or group of patients at a specific facility. This action is not a required
function.

Free Text Field
A field where the user can type text, just like typing a note to someone.

Providers

Any staff member in an I/T/U facility who provides direct healthcare to
patients, e.g., general practice or specialty physicians, registered nurses, social
workers, physician assistants, etc.

Within RPMS, the term “provider” has different specific meanings. See
definitions for DPCP, Primary Provider, and Visit Providers.

Reminders

Health Maintenance Reminders review patient data and alert the provider to

procedures that might be overdue for the patient. Reminders can be based on
age and gender and include typical clinical prevention measures, such as pap
smears.

“Tagging”
A process to review the patient’s data and categorize (“tag”) the patient with
one or more clinical diagnoses, such as Known CVD or Diabetes. Tags will be
used to provide more accurate reminders that are prioritized more
appropriately for a patient’s multiple conditions.

Taxonomy

In RPMS, a grouping of functionally related data elements, such as ICD
codes, that are created and maintained within the RPMS Taxonomy Setup
application. Taxonomies will be used as definitions for diagnoses, procedures,
lab tests, medications, and other clinical data types.

If you need a change or addition to an existing taxonomy, please see your
CRS coordinator.
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Tooltip/Hover Help

A common GUI element used to provide additional information to users. To
display a Tooltip, hover the mouse pointer, without clicking, over a column
heading or field.

Visit Provider

In RPMS, the provider(s) who cared for a patient on a specific visit. Each
patient visit must have at least a primary provider entered. Visits can also have
one or more secondary providers. The primary visit provider might or might
not be the same provider as the patient’s DPCP, and can change on each visit,
depending on the visit type or the clinic staffing.
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Acronym List

Acronym Term Meaning

ARV Antiretroviral

AIDS Acquired Immune Deficiency

ALV Abnormal Lab Values

BH Behavioral Health

BMI Body Mass Index

BP Best Practice

CDC Centers for Disease Control and Prevention
CISO Chief Information Security Officer

CMET Care Management Event Tracking

CPT Current Procedural Terminology

CRS Clinical Reporting System

CvD Cardiovascular Disease

DES Diethylstilbestrol

DM Diabetes Mellitus

Dob Date of Birth

DPCP Designated Primary Care Provider

DSPM Designated Specialty Provider Management
DX Diagnostics

EDD Estimated Date of Delivery

EHR Electronic Health Record

ER Emergency Room

GPRA Government Performance and Results Act
GUI Graphical User Interface

HHS Health and Human Services

HIV Human Immunodeficiency Virus

HIPAA Health Insurance Portability and Accountability Act
HMS HIV Management System

HRN Human Resources Network

HS Health Summary

HX History

I/T/U Indian Health Service, or Tribal or Urban Indian health programs
ICD International Classification of Diseases

IHS Indian Health Service

ISSO Information System Security Officer

IT Information Technology

IMM Immunization

JPEG Joint Photographic Experts Group (image format)
NND Nationally Notifiable Infections Diseases
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Acronym Term Meaning
oIT Office of Information Technology
OTH Other
PC Personal Computer
PCC Patient Care Component
PDF Portable Document Format
POV Purpose of Visit
RCIS Referral Care Information System
RoB Rules of Behavior
RPMS Resource and Patient Management System
SAC Standards and Conventions
SOP Standard Operating Procedure
STI Sexually Transmitted Infection
SRF Suicide Reporting Forms
TIU Text Integration Utility
URL Uniform Resource Locator
VPN Virtual Private Network
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Contact Information

If you have any questions or comments regarding this distribution, please contact the
IHS IT Service Desk.

Phone: (888) 830-7280 (toll free)
Web: https://www.ihs.gov/itsupport/

Email: itsupport@ihs.gov
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